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Preface

Welcome to Installing Rational Suite. This document provides you 
with the information you need to perform a typical installation of 
Rational Suite. Additional information about the products in 
Rational Suite is available in the documentation for each of the 
products in the Suite, including installation options and product 
customizations.

Rational Suite delivers a comprehensive set of integrated tools 
that embody software engineering best practices and span the 
entire software development lifecycle. Rational Suite's 
unparalleled level of integration improves communication both 
within teams and across team boundaries, reducing development 
time and improving software quality. 

Audience
This guide is intended for anyone who is installing Rational Suite. 
It assumes a basic knowledge of Microsoft Windows and its 
conventions.

Other Resources
� The Rational Suite Release Notes are available in HTML. 
� Online Help is available for Rational Suite. 

From a Suite tool, select an option from the Help menu.
� All manuals are available online, in either HTML or PDF 

format. The online manuals are on the Rational Solutions for 
Windows Online Documentation CD. 

� PDF versions of the hard copy manuals for Rational Rose 
RealTime Edition are installed in %ROSERT_HOME%\help when 
you install Rational Suite DevelopmentStudio — RealTime 
Edition.

� For more information on training opportunities, see the Rational 
University Web site: http://www.rational.com/university.
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Rational Suite Documentation Roadmap



Preface 11

Contacting Rational Technical Publications
To send feedback about documentation for Rational products, 
please send e-mail to our technical publications department at 
techpubs@rational.com.

Contacting Rational Technical Support
If you have questions about installing, using, or maintaining this 
product, contact Rational Technical Support as follows:

Rational Technical Support Information 

Location Contact Information Notes

U.S. and 
Canada

800-433-5444
781-676-2450
support@rational.com

When sending e-mail:
– Specify the product name in 
the subject line, for example, 
“Rational Suite”. 
– For existing issues, include 
your case ID in the subject line.

Europe +31 (0) 20 4546 200
support@europe.rational.com

Asia Pacific +61-2-9419-0111
support@apac.rational.com

World Wide 
Web 

http://www.rational.com Click the Technical Support link. 
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Before You Begin

The Rational Software Setup program lets you perform standard 
and custom installations of Rational software products. 

This document provides you with:

� An overview of the installation procedures for Rational Software 
products, included in this chapter.

� Information needed to perform a typical installation of Rational 
Suite. Additional information about the products in Rational 
Suite is available in the documentation for each of the products 
in the Suite, including installation options and product 
customization.

� Support information, including references to additional sources 
of information for Rational software and licensing. See 
“Contacting Rational Technical Support” on page 11.

This chapter tells you what you need to know before installing:

� Rational Suite (see “Installing Rational Software Products” on 
page 14)

� Rational Testing products (see “Before You Install Rational 
Suite Testing Products” on page 20)

� Rational RequisitePro (see “Before You Start the RequisitePro 
Installation” on page 27)

� Rational ClearQuest (see “Before You Begin Installing 
ClearQuest” on page 31)
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Installing Rational Software Products
This section provides a summary of the steps for installing 
Rational Software products.

See the following for information about prerequisites and 
additional installation procedures:

� “Before You Install Rational Suite Testing Products” on page 20
� “Before You Start the RequisitePro Installation” on page 27
� “Before You Begin Installing ClearQuest” on page 31
� “Before You Start the Rational Rose RealTime Installation” on 

page 50

Installation Quick Start

Table 1, Installation Quick Start Guide, summarizes the steps for 
installing Rational software and license keys: 

Table 1: Installation Quick Start Guide

Step For More Information

If you are using floating licenses: 
Install and configure the FLEXlm 
License Server software on a license 
server. 
The FLEXlm License Server software is 
on the Rational Solutions for Windows 
CD.

See the chapter "FLEXlm License 
Server Installation" in Administering 
Licenses for Rational Software.

Install Rational Suite from the Rational 
Solutions for Windows CD or from the 
Rational RealTime Solutions for 
Windows CD. 
Make certain that you are installing the 
product you have purchased.
You can either enter a temporary 
license key or point to a license server 
during installation. You will have to use 
the Rational License Key 
Admininstrator to install a permanent 
license.

For custom installation options and 
configuration procedures, see the 
installation manual for the product you 
are installing.
For information related to a temporary 
license, see your temporary license key 
certificate.
For information about licensing, see the 
Rational License Key Administrator 
online help.
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Request permanent license keys from 
Rational using the License Key 
Administrator.
Make certain that you are requesting 
keys for the product you have 
purchased and installed.

See the chapters "Rational Software 
Client Licensing" and "Rational 
Software Server Licensing" in 
Administering Licenses for Rational 
Software. Also see the Rational License 
Key Administrator online help.

If you are using node-locked 
licenses: Install the new permanent 
license key on your client system.
If you are using floating licenses: 
Install the new permanent license key 
on your license server system.

See the Rational License Key 
Administrator online Help.

If you are using floating licenses: 
Set up your client systems to use the 
licenses from the license server system.

See the Rational License Key 
Administrator online Help.

Use the Start menu to select and start 
the program. 

See the program’s online Help.

After you install the software, you must 
install a permanent license key to use 
the software, unless a temporary 
license key was entered or a license 
server was pointed to during 
installation.

See the Rational License Key 
Administrator online Help.
Temporary license key information is 
included with your Rational Suite 
software media kit. The temporary 
license expiration date is noted on your 
temporary license key certificate. 

Table 1: Installation Quick Start Guide (Continued)

Step For More Information
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Installation Types

The Rational Software Setup program provides you with several 
installation types, letting you install the configuration most 
appropriate for your system. Table 2, Installation Types, describes 
the installation types:

Table 2: Installation Types

Type Description

Typical Installs the most commonly used features for a product. 
Use this option for standard installations.

Custom/Full Allows you to add or remove product or product features. 
Defaults to all features in a Typical installation.
Use this option to install Web Server Components on 
a Web Server for RequisiteWeb, ClearQuestWeb, and 
for all the Suites in which these products appear.

Compact/Laptop Installs a subset of the standard configuration. May omit 
optional files, including online documentation or online 
Help. Use this option on systems with limited disk space.

Minimal Installs the files needed to run the program from a CD or 
network location. Use this option to run the program from 
a centrally managed location.
Note: You must have write permission to run products 
from a minimal install area.
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Configuring Rational Suite as an Administrator

An administrator must set up and configure the following 
Rational Suite features:

� The databases used with ClearQuest. For information about 
installing and configuring databases for use with ClearQuest, 
see Administering Rational ClearQuest. 

� The repositories associated with Rational Suite; see Configuring 
Rational Suite.

� Automated testing programs included in Rational Suite 
TestStudio and Rational Suite Enterprise; see Using the 
Rational Administrator.

For More Information
See Administering Licenses for Rational Software for the software 
licensing description, procedures, and licensing administration 
information. The online Help for Rational License Key 
Administrator contains detailed information about common user 
licensing activities.
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Products in Each Rational Suite
Rational Suite is an integrated set of software development tools, 
combined with the Rational Unified Process. Rational Suite is 
available in several editions, each tailored to the needs of a 
specific organization or user.

Table 3, Rational Suite Products, lists the products in each 
Rational Suite edition:

Table 3: Rational Suite Products

Rational Tool Analyst 
Studio

Development 
Studio 
(Windows/Unix)

Development 
Studio - 
RealTime 
Edition

Test 
Studio

Performance 
Studio Enterprise

Rational 
Unified 
Process

X X X X X X

RequisitePro X X X X X X

ClearQuest X X X X X X

SoDA X X X X X X

Rose Modeler 
Edition

Enterprise 
Edition

RealTime 
Edition

Enterprise 
Edition

Enterprise 
Edition

Robot X X X

TestFactory X X X

PureCoverage X X X X X

Purify X X X X X

Quantify X X X X X

LoadTest X

Performance 
Architect

X



Before You Begin 19

The installation procedures are identical for Typical installations 
of each Rational Suite edition. Each Suite edition provides custom 
installation options, letting you select or delete products or 
features. You can use the Rational Software Setup Wizard to 
install the following, additional tools:

� Rational Test Enablers, which allow you to perform object 
testing with Rational Robot, are included as an installation 
option. Rational Test Enablers can be installed on any system. 
See “Installing the Rational Test Enablers” on page 88. 

� Rational TestAccelerator, which is used with Rational 
TestFactory to speed up the testing process, is included as an 
installation option. Rational Robot is installed automatically 
when you install TestAccelerator; Robot is needed to run the 
scripts. See “Installing Rational TestAccelerator” on page 90.

� Rational Suite PerformanceStudio Agents, which allow you to 
add workload to a server and distribute your functional tests 
among different computers. See “Installing PerformanceStudio 
Agents” on page 79.

� GLOBEtrotter FLEXlm License Server and Sybase SQL 
Anywhere with the Rational Software Setup program.
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Before You Install Rational Suite Testing Products
This section contains information about tasks to do before you 
install Rational Suite testing products such as Rational Suite 
Enterprise, Rational Suite PerformanceStudio, and Rational Suite 
TestStudio.

Before you install Rational Suite testing products, be sure to do 
the following:

For all Rational Suite testing products:

� Decide which type of database you need for your Rational 
repository or your ClearQuest database. For information about 
choosing databases, see “Choosing a Rational Test Database 
Type” on page 23.

For Rational Suite PerformanceStudio: 

� If you have a Beta version of PerformanceStudio or TestStudio 
on your computer, completely remove it before installing 
Rational Suite PerformanceStudio.

� If you have SQA Suite 6.x or a previous release of 
PerformanceStudio on your computer, see “Upgrading from SQA 
Suite 6.x” on page 65. 

� Determine the role each computer will play in testing—whether 
it will be a Master or an Agent computer. For information, see 
“Using PerformanceStudio Master and Agent Computers” on 
page 26.

� To play back a PerformanceStudio script that tests Oracle, 
Sybase, or SQL Server databases on a Master or Agent, you 
must install the appropriate database client software before you 
install PerformanceStudio software. For information, see 
“Installing Rational Suite PerformanceStudio Client Software” 
on page 24.

� Determine the kind of network you will be using, either 
Ethernet or Token Ring. You will need to know this when you 
install the PerformanceStudio network driver. For information, 
see “Installing the RSPS Network Driver” on page 77.
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Hardware and Software Requirements

The following table supplements the information in the section 
Rational Suite Requirements. It lists the additional hardware and 
software requirements for Rational Suite testing products. 

Table 4: Rational Suite Testing Requirements
Product  Requirement
Rational TestAccelerator 104 MB disk space 

(If you specify a disk other than C:\ for installation of 
TestAccelerator, TestAccelerator uses 4 MB on the C:\ 
drive and 100 MB on an alternate drive.)

Crystal Reports 6.0 Professional 
Edition

80 MB free disk space (minimum installation)

PerformanceStudio Master software PC-compatible computer with a Pentium microprocessor
(166 MHz or better recommended)
64 MB memory, plus 1–3 MB per virtual user being run 
on the Master computer. (Some workloads may require 
more memory.) 
We recommend configuring virtual memory to be three 
times the physical memory.
550 MB free disk space for installation
100+ MB free disk space recommended for product 
operation after installation. We recommend more disk 
space for large multi-user runs.
The Master computer can be a Windows NT4.0 (Service 
Pack 4 or 5) or Windows 2000 server, or it can be an 
Windows NT or Windows 2000 workstation (for seven or 
fewer GUI users).
TCP/IP
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PerformanceStudio GUI Agent 
software

PC-compatible computer with a Pentium microprocessor
(166 MHz or better recommended) 
32 MB memory
40 MB free disk space for installation
Microsoft Windows NT 4.0 (Service Pack 4 or 5), 
Windows 2000, Windows 95 (Service Pack 1 or OSR 2), 
or Windows 98 
TCP/IP

PerformanceStudio Virtual User 
Agent software – Windows Systems

PC-compatible computer with a Pentium microprocessor
(166 MHz or better recommended)
64 MB memory, plus 1–3 MB per virtual user
(Some workloads may require more memory.) 
We recommend configuring virtual memory to be 
three times the physical memory.
100 MB free disk space for installation
50+ MB free disk space recommended for product 
operation after installation for virtual user runs
We recommend more disk space for large multi-user 
runs.
Microsoft Windows NT 4.0 (Service Pack 4 or 5) or 
Windows 2000
TCP/IP

PerformanceStudio Virtual User 
Agent software – UNIX Systems

32 MB memory, plus .5–2 MB per virtual user
(Some workloads may require more memory.)
100 MB free disk space for installation
50+ MB free disk space recommended for product 
operation after installation
We recommend more disk space for large multi-user 
runs.
One of the following operating systems:
AIX 4.x
HP-UX 10.x or 11.x
Sequent 4.x
Solaris 2.x
Red Hat 6.x release of Linux

SQL Anywhere Server Your network server must be an Intel-based PC.
Windows NT 4.0 Server, Windows NT 4.0 Workstation
Pentium processor
64 MB memory
100 MB disk space
TCP/IP protocol
Note: Novell NetWare software is no longer supported 
for network servers.

Table 4:  (Continued)Rational Suite Testing Requirements
Product  Requirement
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Choosing a Rational Test Database Type

Before you install Rational Suite testing products, you need to 
decide which type of database you need for your Rational 
repository.

A Rational Test database stores functional and performance 
testing information such as verification point data, queries, 
reports and report layouts, scripts, and information about users, 
computers, and groups. When you create a new repository, you can 
create two types of databases: Microsoft Access databases or 
Sybase SQL Anywhere Database Server databases. For a 
summary of which type of database software to install, see 
“Determining a Database Type” on page 24.

Microsoft Access – Microsoft Access is the default database type 
for Rational Test databases and installs automatically when you 
install your Rational software. We recommend using Microsoft 
Access for a database with seven or fewer concurrent users. This 
type of database is virtually maintenance-free. For example, you 
can back up the database simply by backing up the Rational 
repository directory. However, with more than seven users, data 
access is slower than for a comparably sized Sybase SQL 
Anywhere Database Server database. If you are accessing the 
database over a wide-area network, we recommend using Sybase 
SQL Anywhere for your database. 

Sybase SQL Anywhere Database Server – We recommend 
using this type of database for a database with eight or more 
concurrent users. Data access for a SQL Anywhere Database 
Server database is faster than for a comparably sized Microsoft 
Access database. However, SQL Anywhere database server 
software requires more maintenance than a Microsoft Access 
database. Sybase SQL Anywhere Database Server comes with 
your Rational software, but does not install automatically. For 
information about installing this software, see “Installing SQL 
Anywhere Server Database Software” on page 85. 
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Determining a Database Type

The following table summarizes which type of database software 
to use for a Rational Test database. 

Installing Rational Suite PerformanceStudio Client 
Software

To play back a script that tests Oracle, Sybase, or SQL Server 
databases on a Master or Agent, you must install the appropriate 
database client software.

Note: You must install the database client software before you install 
Rational Suite PerformanceStudio.

To use PerformanceStudio with the TUXEDO or SAP protocols, 
you must install the appropriate client software.

Oracle Client Software

To play back a script that tests an Oracle database on a Master or 
Agent, you must install Oracle client software. 

Table 5: Determining the Database Type
If your Rational Test database Then 
Has seven or fewer concurrent users 
and is not accessed over a 
wide-area network

Use a Microsoft Access database. This is the default 
database and installs automatically when you install your 
Rational software.

Has eight or more concurrent users 
or is accessed over a wide-area 
network

Install the Sybase SQL Anywhere Database Server 
software that comes with your Rational software. For more 
information about installing Sybase SQL Anywhere 
Database Server software, see “Installing SQL Anywhere 
Server Database Software” on page 85.
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Sybase Client Software

To generate scripts that test a Sybase database, you must install 
the Sybase 11.1 NT client software on the Master computer. 

To play back scripts that test a Sybase database, you must install 
the appropriate software on each Agent computer: 

SQL Server Client Software

To generate scripts that test a SQL Server database, you must 
install the SQL Server 6.5 NT client software on the Master 
computer. 

To play back SQL Server scripts on an Agent, you must install the 
appropriate software on each Agent computer as follows: 

TUXEDO Protocol Software

To generate scripts using the TUXEDO protocol, you must install 
the TUXEDO 6 client software on the Master computer. 

SAP Protocol Software

To generate scripts using the SAP protocol, you must install the 
SAP client software, typically referred to as SAPGUI.

Table 6: Software for Agents
For Install
UNIX Agents Sybase 11.1 UNIX client software
NT Agents Sybase 11.1 NT client software

Table 7: SQL Server Scripts on an Agent
For Install
UNIX Agents Sybase 11.1 UNIX client software (limited compatibility)
NT Agents SQL Server 6.5 NT client software
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Using PerformanceStudio Master and Agent Computers

Before you install Rational Suite PerformanceStudio, you need to 
determine the role each computer will play in testing—whether it 
will be a Master or an Agent computer. You use a Master 
computer to:

� Record sessions and scripts.
� Create schedules.
� Run and monitor schedules.
� Analyze test results.
� Play back functional tests.
You use an Agent computer to:

� Support additional users in a schedule run.
� Play back functional tests. You can run your functional tests in 

parallel across several computers to save time. This is called 
distributed functional testing.

The installation of PerformanceStudio Agents is optional. For 
information on installing PerformanceStudio Agents, see 
“Installing PerformanceStudio Agents” on page 79.



Before You Begin 27

Before You Start the RequisitePro Installation
The following sections provide you with steps you must take and 
information you must prepare prior to installing RequisitePro.

Installation Requirements

Table 8, RequisitePro Requirements, describes the system and 
software requirements for installing RequisitePro.

Table 8: RequisitePro Requirements

Item Requirement

Operating Systems Microsoft Windows NT 4.0, Service Pack 4, 5, or 6, or 
Windows 95 Retail Version with Service Release 2 and 
updates, or Windows 98 with Service Release 1,
or Microsoft Windows 2000.

Enterprise Database 
Requirements 
(optional)

Microsoft SQL Server 7.0;
Oracle7 or Oracle8 server and client software -- 
(specifically, Oracle version 7.3.4 or greater).

Processor 200 MHz or greater; 300 MHz or higher is 
recommended.

Memory 64 MB or greater; 128 MB is recommended; for 
projects with more than 50,000 requirements, 256 MB 
is recommended.

Disk Space 96 MB.

Monitor 800 X 600 X 256-color video resolution, or greater.

Mouse/pointing device Microsoft Mouse or compatible pointing device.

Word Processor Microsoft Word 97 or 2000, if requirements documents 
are used.

Requirement Metrics 
Reporting

Microsoft Excel 97 or 2000.

LAN Support Windows NT.
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Caution Installation of Rational Suite on dual-boot systems is not 
supported.

Note Be sure you have a current backup of your Registry and system 
directories prior to running the Rational Software Installation 
procedure.

Upgrades from previous versions of products contained in 
Rational Suite are performed during and after the installation. 
Review the sections in this manual that describe Rational 
Software products you have already installed.

After you install the software, you must then install a permanent 
license key to use this software, unless a temporary license key 
was entered or a license server was pointed to during installation. 
The Rational License Key Administrator online help provides 
detailed instructions for installing startup and permanent license 
keys. See Administering Licenses for Rational Software for more 
information about licenses, including the procedure for obtaining 
an updated license key.

The installation program requires specific versions of Microsoft 
files. The installation program will install them or you may choose 
to install them yourself from other sources.

Installing RequisitePro with Rational Software Setup 

The Rational Software Installation procedure uses 
c:\Program Files\Rational as the default installation path. You 
may specify another drive during the installation procedure.

Privileges To use the Rational Software Setup program on a 
Windows NT system, you must have Windows NT 
administrator privileges on the local system. You must 
have Windows NT administrator privileges on the local 
system to run the License Administrator as well.

Automated License 
Key Requests

Internet connection required for automated license 
requests.

Table 8: RequisitePro Requirements
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If your C:\ drive lacks sufficient free disk space, you may either 
specify another drive or make space available on the default drive. 
Some files will be installed on your C:\ drive; the Software Setup 
wizard will report the amount of space required on all drives for 
your installation.

Note If you have installed another Rational Suite product, you cannot 
select an alternate location for your RequisitePro installation.

See “Installing Rational Suite” on page 51 for directions on how to 
install Rational Suite products.

Configuring E-mail for Discussions

Use the Rational E-mail Reader application to configure e-mail for 
all discussion participants with a valid e-mail address in their 
RequisitePro user information. The Rational E-mail Reader 
application is included with your Rational Software installation at 
the following default location:

c:\Program Files\Rational\common\mailreader.exe

This separate application offers full e-mail integration with 
RequisitePro by associating an e-mail handler with each 
RequisitePro project. Initial discussion items and replies are 
automatically stored in the RequisitePro database and sent to 
discussion participants via e-mail. Participants can reply to the 
discussion items using their e-mail, as well as from within 
RequisitePro. 

Caution The E-mail Setup option on the RequisitePro Tools menu only 
configures notification e-mail for users who initiate a discussion or 
reply to a discussion from within the RequisitePro Discussion 
dialog box. To allow users to reply to discussions via e-mail, and to 
enable discussion e-mail for RequisiteWeb users, configure an 
e-mail handler for each project using the Rational E-mail Reader.
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Discussion E-mail Configuration Requirements  
� You must configure a unique e-mail address for each 

RequisitePro project
� For RequisiteWeb: You must run the Rational E-mail Reader 

on a different server than the IIS server where RequisiteWeb is 
installed.

� For RequisiteWeb: In order to enable e-mail for RequisiteWeb 
discussions, you must configure discussion e-mail using the 
SMTP protocol option rather than MAPI protocol option in the 
Rational E-mail Reader.

� In order to complete the Rational E-mail Reader setup for SMTP 
protocol, you need the following information from your e-mail 
administrator:
- SMTP Server name
- POP3 Server name
- E-mail address; one for each RequisitePro project
- POP3 server login and password for the e-mail address

Note Refer to the online help in the Rational E-mail Reader for more 
information. 
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Before You Begin Installing ClearQuest
You, the ClearQuest administrator, set up the databases to use 
with ClearQuest, install ClearQuest, and provide the required 
setup information to each client user. You (or your client users) 
can then install ClearQuest on the client machines. 

Before you install ClearQuest, read the following:

� Rational ClearQuest Release Notes (\\Program
Files\Rational\ClearQuest\readme.htm): An HTML file that 
contains the most current system requirements information 
(including platform version support).

� Introducing Rational ClearQuest: An overview of ClearQuest 
components and how to use them.

� Administering Rational ClearQuest: A guide on how to 
customize ClearQuest to meet your needs.

Note If you are using Rational ClearQuest/TeamTest Edition, see the 
Getting Started with Rational ClearQuest TeamTest Guide. This 
guide is available as a Portable Document Format (PDF) file in the 
\\ClearQuest\books directory.

Understanding the ClearQuest Install Process
You, the ClearQuest administrator, install ClearQuest by 
performing the following steps:

1 Set up your database product. As the ClearQuest administrator, 
you are responsible for setting up the databases your users will 
use with ClearQuest. See the appropriate section:
� “Setting up Microsoft Access” on page 32.
� “Setting up SQL Anywhere” on page 33.
� “Setting up Microsoft SQL Server Version 6.5” on page 37.
� “Setting up Microsoft SQL Server 7” on page 42
� “Setting up the Oracle Server” on page 45. 

2 Install ClearQuest on the administrator’s workstation and create 
the ClearQuest databases. See “Installing ClearQuest for the 
Administrator” on page 161.
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3 Set up your license server. See Administering Licenses for 
Rational Software and the License Key Administrator online help.

4 Optionally, customize your installation. See the Administering 
Rational ClearQuest guide for details on customizing ClearQuest.

5 Install ClearQuest on the client machines and provide users with 
the information they need to connect to ClearQuest. See 
“Installing ClearQuest for End-users” on page 165. 

6 If you are installing ClearQuest Web, see “Setting up ClearQuest 
Web” on page 173.

7 If you are integrating with a configuration management system, 
such as ClearCase or Visual SourceSafe, set up the integration. 
See “Setting up Configuration Management Integrations” on 
page 168.

Setting up Microsoft Access
If you are using ClearQuest with Microsoft Access, 

1 Create one shared directory on the machine for the directory that 
will contain your Microsoft Access databases. 

2 Make a note of the UNC path of the share directory. The path 
should be of the form: 

\\<machine_name>\<share_name>\<database_directory>\

For example: 

\\developmentserver\project34share\clearquestdbs\

The first time you run the ClearQuest, you are asked to create a 
schema repository. You will specify this pathname and provide a 
filename for the schema repository. ClearQuest then creates and 
initializes the appropriate Access databases in this directory.

Now that you have set up the Access databases, proceed to 
“Installing ClearQuest for the Administrator” on page 161. 

Note ClearQuest Web does not support Microsoft Access databases.
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Setting up SQL Anywhere
To create an SQL Anywhere database server, complete the 
following tasks:

� Install the Sybase SQL Anywhere Server software. (Note: SQL 
Anywhere is available on the ClearQuest CD and can be 
installed using the Rational Software Setup wizard).

� Choose or create a user account to run the SQL Anywhere 
database server and set user privileges for that account. 
See Defining User Privileges below.

� Create an SQL Anywhere database server. See “Creating an 
SQL Anywhere Database Server” on page 34.

Defining User Privileges

To define privileges for a user account running an SQL Anywhere 
database server: 

1 Make sure you have installed the Sybase SQL Anywhere Server 
software.

2 Do one of the following:
� If your Windows NT computer is running Windows NT 

Workstation software, click Start > Programs > Administrative 
Tools (Common) > User Manager.

� If your Windows NT computer is running Windows NT Server 
software:
� Click Start > Programs > Administrative Tools (Common) > 

User Manager for Domains. 
� Click User > Select Domain and type the local machine name 

in the Domain box, and then click OK.

Note If the user does not already exist, create the user (User > New 
User).

3 Click Policies > User Rights to open the User Rights Policy dialog 
box. 

4 Select Show Advanced User Rights.

5 In the Right list box of the User Rights Policy dialog box, select 
Access this computer from network. 



34 Installing Rational Suite

6 Click Add.

7 For List Names From, select the domain of the account running 
the SQL Anywhere database server.

8 Click Show Users. 

9 In the Names list, select the account running the SQL Anywhere 
database server.

10 Click Add, and then click OK.

11 In the Right list box of the User Rights Policy dialog box, select 
Log on as a service.

12 Repeat Steps 6 through 10.

13 In the Right list box of the User Rights Policy dialog box, select 
Log on locally.

14 Repeat Steps 6 through 10.

15 Click OK. 

16 Click User > Exit. 

Creating an SQL Anywhere Database Server

An SQL Anywhere database server is a process that runs on the 
database server machine. Its function is to coordinate all activity 
against your SQL Anywhere databases. You create one SQL 
Anywhere server to provide access to all of your database files. 

Follow these steps to use the Rational Administrator to create a 
new server:

1 From the Start menu, click Sybase SQL Anywhere Database 
Server > Rational Administrator.

2 Click File > New SQL Anywhere Database Server.

3 Type a unique alphanumeric string of up to 30 characters that 
identifies this database server on the network, and then click 
Next. 

Important Do not use spaces or special characters in the server name 
(underscores are acceptable).
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4 Type the amount of space to use for caching data for the SQL 
Anywhere database server, and then click Next.  Allow 2048 KB 
for each Rational repository on the server.

5 Select one or more protocols to communicate with the SQL 
Anywhere database server, and then click Next.

Note To reduce connection time, select only those protocols that are 
actually used on your network.

6 Select the Startup options, as described in the following steps.

a Select one of the following Windows NT Service Startup options. 
These options start the SQL Anywhere database server when 
you power on your system: 
� Click Automatic to automatically start the SQL Anywhere 

database server when you start your system.
� Click Manual if you do not want the SQL Anywhere database 

server to automatically start when you start your system. If 
you select this option you will have to manually start the 
database server after each time you reboot the server 
machine.

b Select or clear Start service immediately. This option starts the 
SQL Anywhere database server immediately after you create it. 
If the box is cleared, you will need to start the server manually 
after creating it. 

7 In the Account section, do the following.

a Click Other Account to allow users to access a shared 
ClearQuest database or shared repository. This option gives 
users the most flexibility for accessing a database or repository.

Note Do not use System Account (LocalSystem) to run the service 
under a local account. Doing so prevents you from remotely 
configuring a ClearQuest database using UNC.
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b Type a domain and user account name for the Other Account. 
This is the account you created and configured under “Defining 
User Privileges” on page 33. The name is case-sensitive. 
Enter the user account information as follows:
� If you created a local machine account in step 2, enter the 

domain and account name as: 

.\userid

� If you created a domain account, enter the domain and 
account name as:

domain\userid

c Type the password for the Other Account. The password is 
case-sensitive.

8 Click Next.

The Rational Administrator displays a summary of your choices.

9 Click Finish.

10 After installing the SQL Anywhere software, create one shared 
directory on the machine for the directory that contains your SQL 
Anywhere databases. (To increase performance, keep your 
databases on the same machine as the database server.) 

11 Make a note of the UNC path of the share directory. The path 
should be of the form: 

\\<machine_name>\<share_name>\<database_directory>

For example: 

\\developmentserver\project34share\clearquestdbs

Now that you have set up your SQL Anywhere databases, proceed 
to “Installing ClearQuest for the Administrator” on page 161. 
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Setting up Microsoft SQL Server Version 6.5
Install SQL Server 6.5 with SQL Server Service Pack 5a, if you 
have not already installed it.

Note When you install SQL Server, select one of the following sort-order 
options: 
� Dictionary order, case-sensitive
� Dictionary order, case-insensitive 
If you change sort orders after installing SQL Server, you must 
rebuild the SQL databases and reload the data. 

Registering your SQL Server Machine for SQL Server 6.5

Start SQL Server Enterprise Manager. If the SQL Server machine 
is not already registered, register it now.

1 Click Server > Register Server. 

2 Type the server name. 

Note Make a note of the server name because you will need it during 
the ClearQuest installation. 

3 Click Use Standard Security. 

4 For Login ID, type SA, which is the System Administrator.

5 For Password, type your SA password. 

6 Click Register. 

The server should now appear in the list of servers. 

7 Set up the SQL Server databases as described in the next section.
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Setting up SQL Server 6.5 Databases

You must set up one empty SQL Server 6.5 database for the 
ClearQuest schema repository, and one empty SQL Server 6.5 
database for each ClearQuest Client user database (such as the 
optional SAMPL database). For each SQL Server 6.5 database, 
complete the following tasks:

� Create an empty database
� Create login accounts for the database
� Set up a backup procedure for the database
To add more databases to ClearQuest, repeat the preceding tasks 
for each new database. 

Note These instructions assume that you have a simple SQL Server 
configuration. If you have large databases or many users, consider 
setting up separate log devices or spreading data across multiple 
devices. For details, see your SQL Server documentation. 

Creating Empty Databases

Use the SQL Server Enterprise Manager to create an empty SQL 
Server 6.5 database for the ClearQuest schema repository and for 
each ClearQuest client user database (such as the SAMPL 
database). For each SQL Server 6.5 database, do the following.

1 Create the data device. 

a Select your SQL Server machine. If your machine does not 
appear in the list of servers, you need to register it. See 
“Registering your SQL Server Machine for SQL Server 6.5” on 
page 37.

b Click Manage > Database Devices.

c Click the New Device icon.
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d Type a name for the device, select a location, and type a size.
For the schema repository, allocate at least 50 MB. The device 
must be large enough to hold all the schema versions. You can 
adjust this size later, if necessary.

For the user database, allocate at least 15 MB for every 1,000 
records you expect to generate. The exact amount of space 
required depends on the complexity of your schema.

e Click Create Now.
The new device should now appear in the list of devices.

f Close the Manage Database Devices window. 

2 Create the database.

a Click Manage > Databases.

b Click the New Database icon.

c Type a name for the database.

d For Data Device, select the device you just created. 

e Leave Log Devices as none.

f Click Create Now.
The new database should now appear in the list of databases.

3 Configure the database: 

a In the Manage Database window, double-click the database you 
just created. The Edit Database dialog box appears. 

b Click the Options tab. 

c Click Select Into/Bulk Copy and Truncate Log on Checkpoint.

d Click OK.

e Close the Manage Databases window.
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Creating Login Accounts for Each Database

Use the SQL Server 6.5 Enterprise Manager to create login 
accounts for ClearQuest. ClearQuest uses these accounts to log 
into the SQL Server database program on behalf of ClearQuest 
users. These login accounts are separate from ClearQuest user 
logins and are hidden after the installation.

Note When you create the ClearQuest schema repository, the 
ClearQuest Maintenance tool prompts you for the three logins 
listed below. If you do not want to create three separate login 
accounts, you can use the DBO login ID for all three. Be aware, 
though, that the read-only account is public to all users. 

Create the following login accounts for each database using SQL 
Server authentication:

� A database owner (DBO) login account
� A general purpose login account
� For the schema repository only, create a read-only account

Note Because ClearQuest requires a SQL Server login for each 
database and does not support Windows NT Authentication, you 
will need to set up SQL Server to operate in Mixed Mode 
(Windows NT Authentication and SQL Server Authentication). 
This property can be set via Enterprise Manager, right-click on 
the server and select Properties menu, Security tab.

Follow these steps to create the login accounts:

1 Click Manage > Logins. 

2 Type a unique login name and password.

Note Remember the names and passwords of each login account; you 
will need them during the ClearQuest installation. 

3 In the Permit column, click the database for which you are 
creating the login. A check mark should appear in the Permit 
column. 

4 If you are creating the database owner login, click the Alias 
column and select DBO. 

5 Click Add and confirm the password.
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6 Repeat steps 2 through 5 for the other accounts.

7 Close the Manage Logins window.

Setting up Database Backup Procedures 

The backup procedure described here provides a daily backup for 
the ClearQuest databases by overwriting the backup device each 
day. It assumes that your site also periodically backs up the 
backup device to recoverable media. 

Use the SQL Server Enterprise Manager to set up backup 
schedules for the schema repository and for the databases.

1 Click Tools > Database Backup/Restore.

2 On the Database Backup/Restore dialog box, click the Backup tab. 

3 From the Database Backup list, select the database you want to 
back up. 

4 From the Backup Devices list, select New. 

5 Type a name and select a location. We recommend that you put 
the backup device on a different disk than the database devices, 
and that this daily backup be backed up to tape by your site’s 
normal backup procedures. 

6 Select Disk Backup Device. 

7 Select Create.

8 Click Schedule. 

9 In the Backup Volume Labels dialog box, leave Volume level 
blank. 

10 In the Schedule Backup dialog box, select Recurring.

11 Click Change. 

12 For Daily Frequency, select 12 a.m. or another time of your choice.

13 Click OK to close the open dialog boxes.

14 Click Close to close the Database Backup/Restore dialog box. 

Now that you have set up your SQL Server databases, proceed to 
“Installing ClearQuest for the Administrator” on page 161. 



42 Installing Rational Suite

Setting up Microsoft SQL Server 7
You need to set up one empty SQL Server 7 database for the 
ClearQuest schema repository, and one empty SQL Server 7 
database for each ClearQuest Client user database (such as the 
optional SAMPL database). For each SQL Server 7 database, 
complete the following tasks.

� (Verify) server registration
� Create an empty database
� Set up a backup procedure for the database
� Create a SQL Server 7 login with the db_owner role to use for 

the ClearQuest database logins (the same login is used by 
ClearQuest for all connections). 

Note Do not use the SA (system administrator) login. During an upgrade 
or move process, ClearQuest requires empty databases. However, 
if the SA login is used, ClearQuest is able to see the System Tables, 
assumes the database is not empty, and does not allow the 
upgrade/move process to continue.

If you want to add more user databases to ClearQuest, repeat the 
preceding tasks for each new database. 

Registering your SQL Server Machine for SQL Server 7

1 In the SQL Server Enterprise Manager, select your Windows NT 
server in the SQL Server Group. 

If your server is not shown, register it now by going to Step 2. If 
your server is already registered, go to “Creating a New SQL 
Server 7 Database” on page 43. 

2 Right-click on the SQL Server Group and select New SQL Server 
Registration. The Register SQL Server Wizard displays.

3 Select a server name, and click Next. 

Note Make a note of the server name because you will need it during 
the ClearQuest installation. 

4 For Authentication Mode, select SQL Server, then click Next. 
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5 For Login ID, type SA,and for Password, type your SA password. 
Then click Next. (The SA user has the privilege to create logins 
and databases.)

6 Add this server to an existing group, or create a new group. Then 
click Next.

7 Click Finish. The server will appear in the list of servers. 

Creating a New SQL Server 7 Database

1 From the Getting Started Taskpad, select Administer SQL 
Server > Create a database.

2 In the wizard, specify a file system location for the database and 
the log. You can accept the defaults for the growth rate of the 
database and the log.

If you want to give the databases larger initial values, allocate 
at least 50 MB for the schema repository and at least 15 MB for 
every 1,000 records expected for your user databases.

3 After you create a database, you are prompted to create a 
Database Maintenance Plan. The Database Maintenance Plan 
Wizard allows you to set up a database backup routine. It is 
strongly recommended that you set up automated nightly backups 
for all your ClearQuest databases.

4 Set database properties for the new database:

a Select the new database from the server’s databases folder.

b Right-click on the database and select Properties.

c On the Options tab, select these Settings:
� Select into / bulk copy
� Truncate log on checkpoint

d Click OK.
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Creating SQL Server Logins

Create a db_owner login for each ClearQuest database (schema 
repository and each user database) by selecting the db_owner role 
for each of the logins you create.

Note Do not use the SA (system administrator) as the owner login of a 
ClearQuest database. During an upgrade or move process, 
ClearQuest requires empty databases. However, if the SA login is 
used, ClearQuest is able to see the System Tables, assumes the 
database is not empty, and does not allow the upgrade/move 
process to continue.

1 Expand the Security folder, then right-click Logins, and click New 
Login. The SQL Server Login Properties - New Login dialog box 
displays.

2 On the General tab, select SQL Server authentication mode 
because ClearQuest does not support Windows authentication.

Note Because ClearQuest requires a SQL Server login for each 
database and does not support Windows NT Authentication, you 
will need to set up SQL Server to operate in Mixed Mode 
(Windows NT Authentication and SQL Server Authentication). 
This property can be set via Enterprise Manager, right-click on 
the server and select Properties menu, Security tab.

3 Enter a name and password.

4 On the Server Roles tab, do not grant any server roles. 

5 Grant db_owner privileges to the login in the new database.

a On the Database Access tab, select from the Permit list the new 
database to grant the login permission.

b Under Permit in database role, check db_owner and public. Do 
not grant this user any other privileges.

6 Set up daily backups for the database if you did not do so under 
Step 2. You can do this by selecting either Administer SQL Server 
> Backup a database or > Create a maintenance plan.
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Migrating from SQL Server 6.5

Use the ClearQuest Maintenance Tool to migrate your schema 
repository to a SQL Server 7 database. Then use ClearQuest 
Designer to move previous SQL Server 6.5 user databases to SQL 
Server 7. You do this by using the Properties dialog box to change 
the properties of the user database.

Warning When migrating from SQL Server 6.5 to SQL Server 7, do not use 
the SQL Server 7 Upgrade Wizard to upgrade your schema 
repository and user databases. You need to use the ClearQuest 
Maintenance Tool and ClearQuest Designer. 

Ensuring SQL Server 7 Client Connectivity

SQL Server 7 client machines require SQL Server ODBC driver 
number 3.7x. To update the ODBC driver for a client machine:

1 Go to that machine, insert the SQL Server 7 CD-ROM, and run 

D:\x86\other\mdac_type.exe

where D: is the letter of your CD-ROM drive.

2 Choose the Custom install option when prompted.

3 Select ODBC Driver for Microsoft SQL Server (and unselect other 
options such as Microsoft JetEngine).

Now that you have set up your SQL Server databases, proceed to 
“Installing ClearQuest for the Administrator” on page 161. 

Setting up the Oracle Server
If you are using an Oracle database, install the Oracle client 
software before installing ClearQuest. 

If you are using ClearQuest with Oracle databases, install and 
create the databases according to Oracle’s documentation. Follow 
these guidelines when you set up your Oracle databases:

� Create a specific Oracle database instance, or identify an 
existing Oracle instance, to use for ClearQuest data.
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� Create two or more separate Oracle database users (each with 
its login):
� the ClearQuest schema repository user login
� one user login for each ClearQuest user database

� Grant each user login the Connect and Resource roles only.
Note If you plan to use the Oracle Context Option, you should also 

grant the CTXAPP role. See “Enhancing Search Capabilities” on 
page 49.
� We recommend that you associate each Oracle database user 

with a unique default tablespace that is separate from all other 
users.

Note The Oracle database users can share the temporary 
tablespace(s), but the temporary tablespace(s) for these users 
must be separate from the Oracle system tablespace. 

Configuring an Oracle 7 Client Installation for ClearQuest

The ClearQuest administrator and all ClearQuest end-users must 
install Oracle Client Software on their local machines before they 
can install and use ClearQuest. Oracle 7 client software contains 
networking drivers ClearQuest needs to interact with Oracle 
databases. To install Oracle Client Software, follow the Oracle 
Networking Products documentation.

Before using ClearQuest, all users must use the SQL*Net Easy 
Configuration program to configure their computers to access 
Oracle databases. 

 Important If your Oracle for Windows menu does not list SQL*Net Easy 
Configuration, you do not have the correct network configuration 
drivers installed. If your menu lists Net8 Easy Configuration, for 
information on installing the correct drivers, see “Configuring an 
Oracle 8 Client Installation for ClearQuest” on page 48. When you 
have the correct configuration drivers installed, return here and 
proceed with the following steps.
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1 From the Start menu, click Oracle for Windows NT > SQL*Net 
Easy Configuration and complete these steps: 

2 Select View Configuration Information to see if your Oracle 
database administrator configured a Database Alias for you. If 
not, go to the next step.

3 Add a new database alias by selecting Add Database Alias. Click 
OK.

4 Type a SQL*Net Database Alias (database name your Oracle 
database administrator set up previously). Make a note of the 
Database Alias because you will need it during the ClearQuest 
database setup. Click OK.

Note All ClearQuest users must use the same Database Alias.

5 Select TCP/IP as the network protocol to use to communicate with 
the database. Click OK.

6 Type the Host Name (the name of database server machine) and 
the Database Instance (the system ID or SID). Get this 
information from your Oracle database administrator.

Note All ClearQuest users must use the same Database Alias, Database 
Instance (system ID or SID), TCP/IP protocol, and Host Name 
(Oracle server machine).

7 When you click OK, the SQL*Net Easy Configuration program 
asks you to confirm your choices. Click Yes to confirm the current 
configuration information.

8 After configuring your database, the installer displays the initial 
opening screen so that you can configure additional aliases. 
To quit the program, click Cancel. 
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Configuring an Oracle 8 Client Installation for ClearQuest

ClearQuest requires the Oracle 7 networking drivers. These 
drivers are not automatically installed with an Oracle 8 client 
installation. If you are using an Oracle 8 client installation, you 
must manually install the correct drivers from your Oracle CD 
before creating database aliases.

To configure an Oracle network client for ClearQuest, do the 
following.

1 Install the Oracle 8 Client Software by following the Oracle 
Networking Products documentation.

2 Run the Oracle Installer: 
Start > Programs > Oracle for Windows > Oracle Installer

3 Select the files to install:

a In the Installer window click From.

b Browse the Oracle CD and select the following file:

\Win32\Install\nt.prd

c Expand All Products > Oracle Networking Products > Oracle 
Protocol Adapters.

d Select the following components for installation:
� Oracle TCP/IP Protocol Adapter 2.3.4.0.0
� SQL*Net Client 2.3.4.0.2
� Oracle 7 Util 7.3.4.0.0
� Required Support Files 7.3.4.1.1.

4 After installing, reboot your system.

5 Use the SQL*Net Easy Configuration program to create database 
aliases as described in “Configuring an Oracle 7 Client 
Installation for ClearQuest” on page 46.
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Enhancing Search Capabilities

With a standard Oracle installation, you cannot perform a string 
search on multi-line text fields. For example, in ClearQuest you 
cannot search for text in a multi-line Notes field.

Oracle does provide an option called the ConText Option (Oracle 
7) or ConText Cartridge (Oracle 8) that enables string searches in 
multi-line text fields. When installed, multi-line text fields become 
available for queries in ClearQuest.

To enable ConText with ClearQuest, do the following.

1 Install the ConText Option/Context Cartridge according to the 
Oracle documentation.

2 Start at least two ConText servers. Be sure to use the QDM 
(Query, DDL, DML) personality options.

3 Grant the CTXAPP role to the Oracle user logins you created 
when you set up the ClearQuest databases.

Now that you have set up your Oracle databases, proceed to 
“Installing ClearQuest for the Administrator” on page 161.
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Before You Start the Rational Rose RealTime Installation
Before installing Rational Rose RealTime, remove prior releases 
from your system. From the Start menu, select Programs > 
Rational Rose RealTime 6.1 > Uninstall Rational Rose RealTime 
6.1.

All directory items and registry settings are removed from your 
system.

After installing the current version, open a model created in an 
earlier version of Rational Rose RealTime to upgrade it to the 
current version. Convert Rational Rose and ObjecTime Developer 
models by following instructions in the Rational Rose RealTime 
Getting Started Guide.

Installation Requirements

Make certain that you have a current backup of your Registry and 
system directories prior to running the Rational Software 
Installation procedure.

You must install either a startup or permanent license key to use 
this software.

The Rational License Key Administrator online Help provides 
detailed instructions for installation startup and permanent 
license keys. See "Rational Software Client Licensing" in 
Administering Licenses for Rational Software for more 
information about licenses, including the procedures for obtaining 
an updated license key.

You must have administrator privileges to install this software.

System Requirements

Item Requirement

Operating System Microsoft Windows NT 4.0, Service Pack 4, 
5, or 6a; Windows 2000 RC2.

Processor 150 MHz or faster.

Memory 64 MB or greater; 128 MB is recommended.
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Installing Rational Suite

This chapter describes how to use the Rational Software Setup 
wizard to install Rational Suite.

Before You Start the Rational Suite Installation
The following sections describe the steps to take and information 
to prepare before installing Rational Suite.

Create Backups

Make sure that you have a current backup of your Registry and 
system directories before running the Rational Software Setup 
procedure. 

Upgrading from Earlier Versions

Upgrades from previous versions of products contained in 
Rational Suite are performed during and after the installation. 
Review the sections in this manual that describe Rational 
Software products you have already installed.

Specifying Installation Paths

The Rational Software Installation procedure uses 
C:\Program Files\Rational as the default install path. 

If your C:\ drive lacks sufficient free disk space, you may either 
specify another drive during the installation procedure or make 
space available on the default drive. Some files will be installed on 
your C:\ drive; the Software Setup wizard will report the amount 
of space required on all drives for your installation.
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Installation Requirements
Table 9, Rational Suite Requirements, describes the system and 
software requirements for installing Rational Suite:

Table 9: Rational Suite Requirements

Item Requirement

Operating System Microsoft Windows 2000; Windows NT 4.0, 
Service Pack 4, 5, or 6; or Windows 95 
Retail Version with Service Release 2 and 
updates; or Windows 98 with Service 
Release 1.
Note: Rational Suite DevelopmentStudio - 
RealTime Edition does not support 
Windows 95 and 98.

Processor 166 MHz or greater; 300 MHz or higher is 
recommended.

Memory 64 MB or greater; 128 MB is recommended.

Browser Microsoft Internet Explorer 4.x with Service 
Release 1 or greater, or Netscape Navigator 
4.x.
Note: You must install Internet Explorer 
4.x to use Rational Software products. 
However, you are not required to use it for 
your browser.

Disk space:
Enterprise Suite (no tutorial)
Enterprise Suite (with tutorial)
AnalystStudio
DevelopmentStudio
DevelopmentStudio - 

RealTime Edition
PerformanceStudio (no 

tutorial)
PerformanceStudio (with Suite 

tutorial)
Test Studio
DevelopmentStudio on UNIX
Developer Kit
Web Components

825 MB or greater.
875 MB or greater.
650 MB or greater.
775 MB or greater.

400 MB or greater.
550 MB or greater.

600 MB or greater.

675 MB or greater.
100 MB or greater.
175 MB or greater.
350 MB or greater.
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Monitor 800 X 600 X 256-color video resolution, or 
greater.

Mouse/pointing device Microsoft Mouse or compatible pointing 
device.

Privileges To use the Rational Software Setup 
program on a Windows NT system, you 
must have Windows NT administrator 
privileges on the local system. You must 
have Windows NT administrator privileges 
on the local system to run the License 
Administrator as well.

Automated License Key 
Requests

Internet email connection required for 
automated license requests.

Rational Unified Process Web browser – Microsoft Internet Explorer 
4.x with Service Release 1 or greater, or 
Netscape Navigator 4.x.

Rational TestFactory Visual Basic 5.x or 6.0 (optional).

SoDA and RequisitePro Microsoft Word 97 or 2000. (For Office 97, 
Service Pack 3 is required.)

Java testing with Rational Test 
tools

Support for JDK 1.1.5 or higher.

Windows Terminal Server All Rational Suite products except 
RequisitePro can be installed and run on a 
Windows Terminal Server console. Rose 
and SoDA can run on a remote terminal.

Reading Rational 
Documentation PDF Files

Adobe Acrobat Reader 4.x or higher.

Table 9: Rational Suite Requirements (Continued)

Item Requirement
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For Windows 2000 Professional, Microsoft recommends:

� Pentium 200 or better
� 64 MB of RAM minimum
� At least 1 GB hard drive space available

For Windows 2000 Server, Microsoft recommends:

� Pentium II 233 MHz or better
� 128 MB of RAM minimum
� At least 2 GB hard drive space available

Caution Installation of Rational Suite on dual-boot systems is not 
supported.

After you install the software, you must install a permanent 
license key to use the software, unless a temporary license key 
was entered or a license server was pointed to during installation. 
The Rational License Key Administrator online Help provides 
detailed instructions for installing temporary and permanent 
license keys. See “Rational Software Client Licensing“ in 
Administering Licenses for Rational Software for more 
information about licenses, including the procedure for obtaining 
an updated license key.
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Software Use

The Rational Software Setup program lets you install Rational 
Suite for use by a client, administrator, or evaluator. During the 
setup program, you select the installation option based on the way 
you will use Rational Suite on this system. See the table below..

Table 10: Software Use Installation Choices

User Description After Installation

Client Choose this option if you do not 
need to administer Rational 
Suite software. 
Installs software on your 
machine for use in a networked 
team environment. An 
administrator at your site will set 
up a Rational repository on the 
network for your team's use.

After you choose this option 
and complete the installation, 
start any of the Rational Test 
components and enter the 
path of the Rational 
repository in the login dialog 
box.

Administrator Choose this option if users of 
client software depend on you 
to set up and manage the 
team's repositories and 
databases.
In addition to installing client 
software, this option installs 
tools so you can create, move, 
and upgrade Rational 
repositories, Rational 
ClearQuest schema 
repositories, and ClearQuest 
user databases. 

After you choose this option 
and complete the installation, 
use the Rational 
Administrator to create both a 
Rational repository and a 
ClearQuest Master Schema 
database.

Evaluator Choose this option if you want 
to do a minimum amount of 
configuration work before using 
the product. Choosing this 
option does not restrict your use 
of the software. 
Installs software on your 
machine and creates a sample 
Rational repository for use in a 
standalone environment. 

After you choose this option 
and complete the installation, 
start any of the Rational Test 
components and select the 
Sample Repository in the 
login dialog box.
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Installing Shared Components

The Rational Software Setup program needs to install shared 
components. A shared component is software provided by a 
company other than Rational. It is potentially available to other 
applications on your system. 

If the setup program needs to update shared components, the 
setup program displays a list of the required files. The files listed 
must be installed on your system before the installation can 
proceed. 

Setup installs U.S. English versions of the files. It does not 
overwrite newer file versions. 

The checkbox, Replace files with newer versions in English, is 
enabled when you have installed earlier versions of the files that 
are localized to a non-U.S. English language. If you select this 
checkbox, the U.S. English versions of the files will replace your 
versions. If you clear this checkbox, you can save and print the list 
of files that need to be updated. You will need to update them 
yourself.

When to Install Files Yourself

In general, we recommend that you allow the installation 
procedure to install shared files for you. Under some 
circumstances, you may want to install the files yourself:

� You are using a U.S. English system, but installing new files 
may invalidate your current environment. In this case, you need 
to determine how to correct your environment so that you can 
run existing tools and the Rational products you want to install.

� Your site may mandate that you obtain shared files directly 
from the source, for example, from Microsoft, rather than using 
files supplied by a third party. Or your site may prohibit 
end-users from installing shared components.

� Rational supplies U.S. English versions of shared files. You may 
want to install equivalent files that are localized to your 
language.

� There may be a later version of the files available. Rational 
products should work with the supplied version of shared files or 
any later versions.
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Installing Rational Suite with the Rational Software Setup Procedure
This section describes a Typical installation of Rational Suite. 

Caution Interrupting an installation that is in progress may leave your 
system in an indeterminate state. If you try to close the Rational 
Software Setup window while the installation is in progress, you 
are asked to confirm that you want to exit from the incomplete 
installation.

1 Insert either the Rational Solutions for Windows CD or the 
Rational RealTime Solutions for Windows CD into your system’s 
CD drive. 

When you insert the CD, the setup program starts automatically. 

If autorun is disabled on your system, click Start  >  Run. Using 
the drive letter of your CD-ROM drive, enter drive:\SETUP.EXE.

2 The Rational Software Setup wizard will guide you through the 
software installation. On each dialog box, click Next to proceed to 
the next one.

The Rational Software Setup dialog box provides general 
information about the software installation. Click Browse to 
review Rational product information. You must have a Web 
browser installed to view the product gallery.

The Save button lets you copy the contents of the setup wizard 
message window to a file. The Copy button copies the contents of 
the message window in the setup wizard to the Windows 
clipboard. The Copy and Save buttons are enabled on wizard 
dialog boxes that display the license agreement or installation 
messages.

The Help button provides you with additional information 
regarding setup options.
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3 On the Select Installation Option dialog box, choose which type of 
license option you want:  Install licensed Rational products, 
Install the license server, or Install unlicensed tools.

Note To install a Rational Suite PerformanceStudio Agent, see 
“Installing PerformanceStudio Agents” on page 79.

If you choose to install the license server or any unlicensed tools, 
the Select Licensing Source or License Key Certificate dialog 
boxes will not appear.

4 On the Select License Option dialog box, choose either to import a 
license file, to obtain a floating license key from a server, to enter 
a temporary node-locked key, to use an existing license because 
you are upgrading or reinstalling a Rational product, or to install 
the product before you configure the licensing.

If you choose a temporary node-locked license, the Enter 
Temporary Key dialog box appears so that you can enter the 
license key and expiration date found on your license key 
certificate.

Note Rational Suite PerformanceStudio requires floating licenses. For 
Rational Suite PerformanceStudio, choose one of the following:
� Choose Obtain License Key from Server and fill in the name of 

the license server, if you have a License Server already installed 
and configured.

� Choose Install Product before Licensing if you do not have a 
license server installed. The license server installs 
automatically with Rational Suite PerformanceStudio. Then 
start the Rational License Key Administrator to set up your 
floating license. For more information, see the Administering 
Rational Software Licenses manual or Rational License Key 
Administrator Help.

� Choose Upgrade or Reinstall Product if you are upgrading or 
reinstalling Rational Suite PerformanceStudio.

5 The Choose Product to Install dialog box displays the installation 
options for the software installation. If you are not licensed for a 
particular product, it will not appear in the product list. Choose 
the Rational Suite product you want to install.
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6 The License Agreement dialog box displays the Rational Software 
license agreement. Choose to accept or not accept the license 
agreement. 

If you accept the license agreement, the installation continues 
installing Rational Suite on your system. If you do not accept the 
license agreement, the installation does not let you proceed 
further. If you exit from the installation by clicking Cancel, no 
changes are made to your system.

7 The Setup Configuration dialog box describes the setup options for 
this software installation. Select the installation option. The 
options are described in “Installation Types” on page 16.

If you choose the Custom/Full installation option, you will see the 
Choose Features dialog box. This dialog box lets you specify 
exactly which features and subfeatures to install on your system. 
Use the + to expand and select or clear options as desired. There 
are dependencies between some products which may force an 
installation option, even if you have cleared it.

You must choose the Custom/Full installation option to install 
either RequisiteWeb or ClearQuestWeb. See “Installing 
RequisiteWeb on the IIS Server” on page 125 and “Setting up 
ClearQuest Web” on page 173.

Note If you have previously performed a Typical installation of Rational 
Suite with the Rational Software Setup program, the Minimal 
installation type is disabled. Similarly, if you performed a 
Minimal installation, then all other installation types are 
disabled. You must remove Rational Suite to enable all 
installation options.

Confirm that you have sufficient free space for the installation. If 
the amount of free space is less than the amount required, either 
exit from the installation procedure and make more space 
available on the specified disk or specify an alternate Install Path.

To specify another Install Path, type the new path in the Install 
Path field or use the Browse button to select a drive and directory.
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The setup procedure installs Microsoft Core Components and 
some additional files on the same drive as the operating system 
(often the C:\ drive), even if you have specified an alternate drive 
for installation. These files can require up to 20 MB of disk space 
on your hard drive.

Note The installation program requires that all Rational programs be 
installed in the same directory. If any Rational product has been 
previously installed with the Rational Software Setup program, 
the browse option and Install Path field are disabled. You must 
remove and reinstall Rational Suite to specify a new Install Path.

8 The Update Shared Components dialog box appears if the 
Rational Software Setup program needs to update some shared 
files or components on your system. Click Next to have Rational 
Software Setup install these files for you or Cancel to install these 
files yourself. For additional information, see “Installing Shared 
Components” on page 56 or the Rational Software Setup online 
Help.

Note The Rational Software Setup wizard does not recalculate the disk 
space required for your updated selections. 

9 The Software Use dialog box appears if you have selected a 
Rational Suite, ClearQuest, or Robot product for installation. 
Table 10,  Software Use Installation Choices, on page 55 describes 
the available choices.

10 The Upgrade Compatibility dialog box appears if you have 
additional, older Rational products installed on your system. 
Because Rational tools share files and components, this 
installation can cause the older Rational products to stop working. 
You will see no visual clue to indicate that the older products may 
be compromised.

For each of the additional, older products listed, we strongly 
recommend that you take one of the following actions:

� Upgrade it: Complete this installation, and then restart the 
Setup wizard to upgrade the next product. Upgrading a 
product updates all necessary files, registry entries, startup 
menu items, and shared components on your system.
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� Remove it: Complete this installation, and then use the 
Control Panel's Add/Remove Programs tool to remove the next 
product. Removing a product deletes files, registry entries, 
and startup menu items from your system.

A Web site exists to provide more details about interactions 
between specific products. To visit the Web site, please see 
http://www.rational.com/sitewide/support/index.jtmpl. Click 
Patches and Upgrades, and then click Upgrade Compatibility.

11 The Confirmation dialog box displays the product features to be 
installed.

12 The Error Summary dialog box displays errors from the first part 
of the software installation. If the installation is successful, you do 
not see this dialog box.

The Rational Software Setup program writes a log of installation 
activities. The log file is located in 
<Install Path>\Rational\RSSetup\RSsetup.log.

Possible Reboot Required

If files required for the installation are in use during the 
installation procedure, and if the setup procedure needs to install 
shared components on your system, the Rational Software Setup 
program may need to reboot your system to complete the 
installation. After rebooting, proceed as follows:

1 Log on as the same user to complete the installation procedure. If 
you do not log on as the same user, the installation does not 
complete correctly.

The installation process continues on your system.

2 Click Finish to exit from the Rational Software Setup program. 
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Rational Suite PerformanceStudio Installation Tasks

If you are installing Rational Suite PerformanceStudio, after 
installation is complete, you should do the following:

� Install the RSPS Network Driver. For more information, see 
“Installing the RSPS Network Driver” on page 77.

� Optionally, install Agent software. For more information, see 
“Installing PerformanceStudio Agents” on page 79.

Removing Rational Suite
This section describes how to remove Rational Suite from your 
system.

Preparing to Remove Rational Suite

Make sure that no one is using Rational Suite or any associated 
files. You cannot remove files that are in use.

To remove Rational Suite from a Windows NT system, you must 
have Windows NT administrator privileges on the local machine.

To Remove Rational Suite

Use the Windows Add/Remove Programs control panel to select 
and remove Rational Suite. The Rational Software Setup program 
removes Rational Suite from your system. It does not remove 
directories containing files that you have created while using 
Rational Suite products.
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Installing Rational Rose RealTime

This chapter describes how to use the Rational Software Setup 
wizard to install Rational Rose RealTime. 

For the most current information related to Rational Rose 
RealTime features and known issues, refer to the Release Notes 
document that is, by default, at the following location on your 
system after installation: C:\Program Files\Rational\
Rose RealTime\readme.txt.

Installing Rational Rose RealTime with Rational Software Setup
The Rational Software Installation procedure uses C:\Program
Files\Rational as the default installation path. You may specify 
another drive during the installation procedure.

Note If you have installed another Rational Suite product, you cannot 
select an alternative location for your Rational Rose RealTime 
installation.

This section describes a Typical installation of Rational Rose 
RealTime. For a more detailed description of the installation 
procedure see “Installing Rational Suite with the Rational 
Software Setup Procedure” on page 57.

Caution Canceling an installation that is in progress may leave your 
system in an indeterminate state. If you click Cancel while your 
installation is in progress, you are asked to confirm that you want 
to exit from the incomplete installation.

1 Insert the Rational RealTime Solutions for Windows CD into your 
system's CD drive.

If the system is configured with the autorun feature enabled, the 
setup program will run automatically. If autorun is disabled on 
your system, click Start > Run. Using the drive letter of your 
CD-ROM drive, enter [drive]:\setup.exe.
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2 The Rational Software wizard guides you through the software 
installation. Follow the instructions for “Installing Rational Suite 
with the Rational Software Setup Procedure” on page 57. On the 
Choose Products dialog box, select Rational Rose RealTime.

3 The Rational Software Setup program writes a log of the 
installation activities. The log file is located in 
<Install Path>\Rational\RSSetup\RSSetup.log.

Possible Reboot Required

If files that are required for the installation are in use during the 
installation procedure, the Rational Windows Setup program may 
need to reboot your system to complete the installation. After 
rebooting, log on as the same user to complete the installation 
procedure.
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Rational Suite Testing Products: Post - Install

This chapter contains information about tasks to do after you 
install Rational Suite testing products such as Rational Suite 
Enterprise, Rational Suite PerformanceStudio, and Rational Suite 
TestStudio. It includes the following topics:

� Upgrading from Rational Suite 1.5
� Upgrading from SQA Suite 6.x
� Upgrading from Rational Suite 1.0
� Upgrading from preVue-C/S
� Installing Additional Software 

Upgrading from Rational Suite 1.5
You can install this version of any Rational Suite product directly 
over the Rational Suite 1.5 version.

Upgrading from SQA Suite 6.x
The section contains information about upgrading from SQA Suite 
6.x to Rational Suite Enterprise, Rational Suite 
PerformanceStudio, or Rational Suite TestStudio products.
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Summary of Tasks

The following table lists the type of tasks that you use to test an 
application, the component you used for each task in SQA 6.x, and 
the component you now use to do the same task.  

New Terminology

The following table lists the terminology used in SQA Suite 6.x 
and the new terminology used in current Rational Suite testing 
products. 

Table 11: Summary of Tasks

To
For SQA Suite 6.x, you 
used

For current Rational 
Suite testing products, 
you use

Create a repository. SQA Administrator Rational Administrator
Create test requirements. SQA Manager Rational TestManager
Create scripts or 
procedures.

SQA Robot Rational Robot

Check for pass/fail of 
scripts.

SQA Log Viewer Rational LogViewer

Track defects. SQA Manager Rational ClearQuest
Run a report on a defect. SQA Manager Rational ClearQuest
Run a report on test 
coverage.

SQA Manager Rational TestManager

Customize a report format 
used to track defects in 
your application.

SQA Manager Rational ClearQuest 
Note: To customize reports, 
you must install Crystal 
Reports, which comes with 
Rational Suite testing 
products. For more 
information, see Installing 
Crystal Reports on page -93.

Table 12: Terminology in Rational Suite Testing Products
SQA Suite 6.x term Current Rational Suite testing product term
SQA Manager Rational TestManager and Rational ClearQuest
SQA OCX Rational ActiveX Test Control
SQA Test Log Viewer Rational LogViewer
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Upgrading a Rational Repository

You can use data from an existing SQA Suite 6.x or a Rational 
PerformanceStudio 7.0 repository in a new Rational repository. 
When you create a repository in the current release, the Create 
Repository Wizard gives you the option of initializing a repository 
with data from an existing repository.

For information about creating a Rational repository with data 
from an existing repository, see the Using the 
Rational Administrator manual. 

Simplifying the Migration

Use the information in this section to simplify your migration from 
SQA Suite 6.x.

Long File Names

Robot now supports long file names with spaces. Because of this, a 
script (formerly called a test script) no longer has a separate ID 
(which had a maximum of eight characters). The name of the 
script, which can have a maximum of 40 characters, 
is now used as the file name.

Scripting Languages

You no longer need to select a GUI scripting language at 
installation. The SQABasic language is now used for all GUI 
scripts. 

Using Defect Reports
Your Rational Suite testing products comes with special defect 
reports to help you manage your testing efforts. Use Rational 
ClearQuest to run these special reports to track your defects when 

SQA Text Comparator Text Comparator and Grid Comparator
SQAVU language VU language
test case verification point
test procedure script

Table 12:  (Continued)Terminology in Rational Suite Testing 
SQA Suite 6.x term Current Rational Suite testing product term
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testing applications. When you create a Rational repository that 
contains an associated ClearQuest database, you automatically 
get these defect reports and report formats to use with 
ClearQuest. For more information about creating a repository 
with a ClearQuest database, see Creating a Repository in Chapter 
2 of the Using the Rational Administrator manual.

You can customize a defect report or create new reports by 
customizing a report format or by creating a new report format 
using Rational ClearQuest. To customize a report format, you 
must install Crystal Reports 6.0 Professional Edition, which 
comes with your Rational Suite testing product. 

To install Crystal Reports:

� Use the Crystal Reports installation directions that come with 
the Crystal Reports CD-ROM. 

Using SQA 6.x Repository Data in a Rational Repository
You can use data from an existing SQA Suite 6.x repository in a 
Rational repository. When you create a new Rational repository, 
the Create Repository Wizard gives you the option of initializing a 
repository with data from an existing SQA Suite 6.x repository.

For information about creating a Rational repository with SQA 
Suite 6.x data, see Creating a Repository in Chapter 2 of the Using 
the Rational Administrator manual.

When to Convert SQA Suite 6.x Repository Data

We recommend that you convert SQA Suite 6.x repository data to 
Rational repository data after you finish a project. 



Rational Suite Testing Products: Post - Install 69

The following table lists the data that is converted from an SQA 
Suite 6.x repository to a Rational repository:

Conversion Details

When you create a Rational repository with SQA Suite 6.x data, 
the converter does the following:

� Prefixes a script or verification point ID with a period (.) in the 
name 
with “_RENAMED_”.

� Converts a period (.) in a script name or verification point ID to 
an underscore (_).

For example, a script named wn95.tst converts to
_RENAMED_wn95_tst. A verification point ID named alpha.b2 
converts to _RENAMED_alpha_b2.

Table 13: Data Conversion Table
Type of SQA Suite 6.x data Converted?
Custom reports and graphs No
Defects
(For information about defects, see “Details About 
Converting Defects” on page 70.)

Yes 

E-mail rules No
Filters for defects or test procedures No
Groups
(Privileges are not converted.)

Yes

List reports No
LoadTest schedules No
Projects Yes
Requirements Yes
Test cases
(called verification points in a Rational repository)

Yes

Test logs No
Test plans Yes
Test procedures
(called scripts in Rational repository)

Yes

Users
(Privileges are not converted.)

Yes

Virtual user test procedures 
(called virtual user scripts in a Rational repository)

No
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Details About Converting Defects 

Your Rational testing products incorporate the change-request 
management technology of Rational ClearQuest to track defects. 
For your convenience, Rational ClearQuest includes a specially 
designed defect form, the TestStudio defect form, similar to the 
SQA 6.x Manager defect form.

The following table lists each field in an SQA 6.x defect form and 
the comparable field in the TestStudio defect form. For more 
information about using the TestStudio form, see the Using 
Rational Robot manual.

Note: The word List in the Description column of the following 
table indicates that if you customize a list in SQA 6.x, it converts 
to a list in the TestStudio defect form. 

Table 14: Converting Defects
SQA 6.x 
defect field

TestStudio 
defect field Description

ID New ID generated The SQA 6.x ID does not appear on the defect 
form, but you can use the query feature of 
ClearQuest to find it. For more information, see the 
Rational ClearQuest Help.

Description Headline/Descripti
on

Converts the first 125 characters or up to the first 
carriage return and places this text in the Headline 
field. The entire SQA 6.x Description field also 
appears in the Description field of the TestStudio 
defect form.

Priority Priority List
Severity Severity List
Occurrences (Not converted)
Keywords Keywords List
Symptoms Symptoms List
Build Found Notes In SQA 6.x, a Build Found field is a text field. 

In Rational Suite, Builds are objects that contain log 
folders and logs. The text data from the Build 
Found field is stored in Notes. A Build object is not 
created for each SQA 6.x Build Found field. 

Build Fixed Notes In SQA 6.x, a Build Fixed field is a text field. In 
Rational Suite, Builds are objects that contain log 
folders and logs. The text data in the Build Fixed 
field is stored in Notes. A Build object is not created 
for each SQA 6.x Build Fixed field. 
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Proc Script
Case Verification Point
Cycle (Not converted)
Reported By Reported By 

Contact
Reported By 
Company

Reported By 
Company

Hardware Hardware List
Operating 
System

Operating System List

Other Other Environment
Test Station (Not converted) In SQA 6.x, a Test Station field is a text field. 

In Rational Suite, the Computers field replaces the 
Test Station field and is an object. 
A Computer object is not created for each 
SQA 6.x Test Station field. 

Log (Not converted)
Custom 1 Custom 1 List

If you customized the label for this field in 
SQA 6.x, the label is not converted. Use the 
ClearQuest Designer to customize this label.

Custom 2 Custom 2 List
If you customized the label for this field in 
SQA 6.x, the label is not converted. Use the 
ClearQuest Designer to customize this label.

Custom 3 Custom 3 If you customized the label for this field in 
SQA 6.x, the label is not converted. Use the 
ClearQuest Designer to customize this label.

Attachment Attachments You can attach more than one file after you convert 
to a Rational Suite repository.

Requirement Requirement
Status History History
Resolution Resolution List
Resolution 
Description

Resolution Note

Modified 
Software

(Not converted)

Table 14:  (Continued) Converting Defects
SQA 6.x 
defect field

TestStudio 
defect field Description
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Note: The convert.txt file in the converted project directory 
contains the conversion status of each verification point and 
script. Use this file as a diagnostic tool if you have any problems 
with your data after conversion.

Upgrading from Rational Suite 1.0
This release of Rational Suite testing products uses ClearQuest 
2.0. If you used the TeamTest schema available in earlier releases 
of ClearQuest, you need to upgrade the schema before you use a 
current Rational Suite testing product. The new schema, the 
TestStudio schema, replaces the TeamTest schema. 

To upgrade the TeamTest schema: 

1 Click Start > Programs > Rational product name > Rational 
ClearQuest > Rational ClearQuest Designer. 

2 If the Open Schema Wizard appears, make sure that the schema 
you want to upgrade is not checked out, and then click Cancel. If it 
is checked out, check it in or undo the check out.

3 Click Package > Package Wizard.

4 You must complete steps a through e for each of the following 
packages: 

� TeamTest Upgrade 0.1
� Repository Upgrade 0.2
� RequisitePro 1.1
� PQC 1.0
� Email Upgrade 1.0

If any of the packages listed above do not appear in the list, click 
More Packages to add the missing packages to the list, and then 
click OK.

a Select the package, and then click Next.
b Select a TeamTest-based schema to which you want to apply 

the package, and then click Next.
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c Click Defect (or if you renamed the record type, click that 
record type), and then click Finish. This opens a new revision 
of the schema with the package that you applied.

d Click File > Check In. Add your comments, and then click OK.

e Click OK.

5 After you finish applying the last package, do the following:

a Click File > Open Schema and then open the schema you just 
upgraded using the Open Schema Wizard.

b Double-click Record Types.

c Double-click Defects.

d Double-click Forms.

e For each of the two forms, complete steps i. through iii.

i Double-click each form.

ii Select the drop-down list next to the Project label, and 
then right-click Properties.

iii Select RepoProject from the Field Name list, and then 
click OK.

6 Do the following to upgrade your database:
� Click Database > Upgrade Database.
� Click Yes.
� Select the database to upgrade, and then click Next.
� Select the latest version, and click Finish.

7 Click File > Check In. Add your comments, and then click OK.

8 Click OK.



74 Installing Rational Suite

9 Click Package > Package Wizard.

You must complete steps a through g for the Resolution upgrade 
package. 

a Select the Resolution Upgrade 1.0, and then click Next.
If this package does not appear in the list, click More 
Packages to add the missing package to the list, and then 
click OK.

b Select a TeamTest-based schema to which you want to apply 
the package, and then click Next.

c Click Defect (or if you renamed the record type, click that 
record type), and then click Next. The Setup State Types page 
of the Package Wizard appears.

d Under the State Type column, choose Resolved in the row of 
the state you want to set to resolved.

e Click Finish.

f Click File > Check In. Add your comments, and then click OK.

g Click OK.

10 Click File > Exit to close ClearQuest Designer.

Upgrading from preVue-C/S 
If you are upgrading to Rational Suite PerformanceStudio from 
preVue-C/S, the following information may be helpful. 

Importing preVue-C/S Scripts 

To use a preVue-C/S script in Rational Suite PerformanceStudio:

1 Copy the script file into the repository’s script directory for the 
project, typically ...\Project\Default\Script. 

2 Start Rational LoadTest, and then log into the repository.
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3 If you have not created a schedule, do the following:

a Click File > New > Schedule.

b Click Blank Schedule, and then click OK.

c Click Insert User Group, and then click OK.

4 Click Insert > Script.

Since the script is unknown to the repository, you must type its 
name (without the .s suffix) because it does not appear in the 
script query list. Inserting the script into the schedule in this way 
causes LoadTest to also insert the script into the repository, just 
as if you had recorded it using Robot.

You can now use the script in a schedule, just as if you had 
recorded it within Robot. 

Preprocessor Differences

In preVue-C/S, the VU language used your local C preprocessor. 
Therefore, the available preprocessor features depended on the 
preprocessor on your computer. 

Rational Suite PerformanceStudio, however, ships with the GNU 
C preprocessor, so you will see the GNU C preprocessor features.

Reserved Words

In preVue-C/S, the reserved words in the VU language included 
all ASCII, X, and C/S reserved words. The preVue-C/S reserved 
words have migrated to LoadTest.

SME Toolkit

The preVue-C/S SME toolkit is shipped with Rational Suite 
PerformanceStudio. Many of the file I/O and synchronization 
routines in the toolkit are now implemented using standard 
PerformanceStudio features such as datapools and 
synchronization points.

However, for compatibility purposes, you can still use scripts that 
used the SME toolkit. The header files are included in Rational 
Suite PerformanceStudio. Scripts that reference the INCLUDE 
files—for example, #include "SME/data.h"—will get SME 
toolkit functionality. 
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Installing Additional Software
The following table lists the additional components that you can 
install for Rational Suite testing products and where to find 
information about each one.  

Installing Additional Rational Suite PerformanceStudio 
Software

After you install the Rational Suite PerformanceStudio Master, 
you can install additional software according to your testing 
needs, as follows: 

Table 15: Additional Software
To install See
PerformanceStudio network driver “Installing the RSPS Network Driver” on page 77
PerformanceStudio Agents “Installing PerformanceStudio Agents” on 

page 79
Rational Robot for GUI testing (used with 
PerformanceStudio)

“Installing Rational Robot with 
PerformanceStudio” on page 85

Rational Test Enablers “Installing the Rational Test Enablers” on 
page 88

Rational TestAccelerator “Installing Rational TestAccelerator” on page 90
Rational TestManager/Web — Manual Script 
Execution

“Installing Rational TestManager – Manual Script 
Execution” on page 92

Sybase SQL Anywhere Database Server “How to Install the Sybase SQL Anywhere 
Database Server Software” on page 86

Sample applications and applets “Installing the Sample Applications” on page 90
Crystal Reports “Installing Crystal Reports” on page 93

Table 16: Additional Rational Suite PerformanceStudio 
Software

To Install
To record scripts and sessions over a 
network:

The Rational Suite PerformanceStudio (RSPS) 
network driver. For information, see “Installing 
the RSPS Network Driver” on page 77.

Remotely run test scripts on Windows or 
UNIX Agents:

Rational Suite PerformanceStudio Agents. For 
information, see “Installing PerformanceStudio 
Agents” on page 79.

Record GUI scripts on multiple computers: Rational Robot on each computer. For 
information, see “Installing Rational Robot with 
PerformanceStudio” on page 85.
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Installing the RSPS Network Driver

After installing the PerformanceStudio Master software, you must 
install the Rational Suite PerformanceStudio (RSPS) network 
driver to record scripts and sessions over a network. The following 
sections explain how to do this on Windows NT and Windows 
2000.

Installing the Network Driver on Windows NT

To install the RSPS network driver on Windows NT:

1 Turn on the Master computer.

2 Click Start > Settings > Control Panel.

3 Double-click the Network icon.

4 Click the Protocols tab.

5 Click Add.

6 Click Have Disk. The required files were installed on the Rational 
directory during installation.

7 Specify one of the following file paths to install the driver.
� For Windows NT Ethernet networks, type:

C:\Program Files\Rational\Rational Test 7\driver

or installpath\driver

where installpath is the drive and path where you installed 
the PerformanceStudio Master software.

� For Windows NT Token Ring networks, type:

C:\Program Files\Rational\Rational Test 7\drivertk

or installpath\drivertk

where installpath is the drive and path where you installed 
the PerformanceStudio Master software.

Note You can install only one type of driver on your computer at a time, 
either Ethernet or Token Ring. You must remove one type of 
driver before installing a new type of driver. For information 
about removing a network driver, see Removing the Rational 
Suite PerformanceStudio Network Driver on page -84.
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8 Click OK.

9 In the Select OEM Option dialog box, click OK again to verify the 
driver.

10 Click Close.

11 Click Yes to shut down Windows and restart your computer after 
you install the network driver.

Installing the Network Driver on Windows 2000

To install the RSPS network driver on Windows 2000:

1 Turn on the Master computer.

2 Click Start > Settings > Network and Dialup Connections.

3 Right-click Local Area Connection, and then select Properties 
from the context menu.

4 Click Install.

5 Click Protocol, and then click Add.

6 Click Have Disk.

7 Enter the path where the driver is located, or browse for the 
driver. For example, type:

C:\Program Files\Rational\Rational Test 7\driverw2k

or installpath\driverw2k

where installpath is the drive and path where you installed 
the PerformanceStudio Master software.

8 Select either Ethernet or Token Ring network, and then click OK.

9 Click Yes to shut down Windows and restart your computer after 
you install the network driver.
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Installing PerformanceStudio Agents

After you install and license Rational Suite PerformanceStudio on 
a Master computer, you have the option of installing 
PerformanceStudio Agents on other computers. An Agent 
computer can be a Windows or UNIX computer.

You use an Agent computer to:

� Add workload to a server.
The Master computer may lack sufficient resources to host all 
the virtual users you want to include in a test. An Agent allows 
you to distribute virtual users.

� Play back functional tests. You can distribute your functional 
tests among different computers to save time. 
You can specify that an Agent is to run a certain percentage of 
GUI scripts during a run, or you can run multiple identical GUI 
scripts simultaneously to test how a server accessed by the 
client might react under high demand condition.

Note The Master and Agent PerformanceStudio software that you 
install must be the same version; otherwise, the Master and Agent 
computers will not work together.
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Installing a Windows Agent

To install Agent software on a Windows computer:

1 Turn on the computer to start Windows.

2 Log in using an account with Administrator privileges.

3 Insert the Rational Suite PerformanceStudio CD into your CD 
drive. The installation starts automatically.

If the installation does not start automatically, do the following:

a Click Start > Run.

b Type drive:\SETUP.EXE,\SETUP.EXE and click OK,

where drive is the CD drive you are using.

4 In the Rational Software Setup screen, click Next.

5 Click Install Unlicensed Tools, and then click OK.

6 Select Rational Suite PerformanceStudio Agent from the list of 
available products, and then click Next.

7 Follow the on-screen instructions to complete the installation.

The Rational Setup Wizard displays a series of dialog boxes that 
guide you through the installation process and prompt you for 
information.

8 In the last dialog box, click Finish.

You must restart your computer to finish the installation.

9 Log in again using the same user account and Administrator 
privileges that you used to start the installation. 

Starting a Windows Agent

A Windows Agent runs as an application. In Windows NT, the 
PerformanceStudio Agent starts automatically when you restart 
the computer. To play back a GUI script, you must log into the 
Agent with read/write permission for the repository you want to 
work in.

You can run an Agent as an NT service, if the Agent is used only 
for virtual users. 



Rational Suite Testing Products: Post - Install 81

To run an Agent as an NT service for virtual users:

1 Right-click the Start menu. Click Open All Users.

2 Double-click Programs.

3 Double-click Startup.

4 Delete PerformanceStudio Agent.

5 If the Agent is running, you must exit it before going to the next 
step. 

6 Click Start > Run.

7 Type sqa7psvc -install, and then click OK.

8 Start the Agent as an NT service:

a Click Start > Settings > Control Panel.
b Double-click Services.

c Select PerformanceStudio Agent Service from the list of 
services, and then click Start.

9 To start the Agent automatically when you restart your computer:

a Click Startup.

b Click Automatic in the Startup Type box, and then click OK.

Installing a UNIX Agent

To install Agent software on a UNIX Agent computer:

1 Turn on the Agent computer.

2 Log in as root.

3 Type the password.

4 Create the installation directory:

# mkdir -p /usr/rational/test7

5 Insert the Rational Suite PerformanceStudio CD into your CD 
drive.

If the CD does not automount, then use the appropriate UNIX 
mount command to mount the CD. 
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6 Change your directory to the CD directory.

For an Agent on a Solaris operating system:

# mount /dev/dsk/c0t6d0s0 /cdrom

# cd /cdrom/solaris_agent

For an Agent on an HP-UX 11.x operating system:

# pfs_mount ldev/rdsk/c0t2d0 -t rrip /cdrom

# cd /cdrom/hp11_agent

For an Agent on an HP-UX 10.10 or later operating system:

# mount -r -F cdfs -o cdcase /dev/dsk/c0t2d0 /cdrom

# cd /cdrom/hp10_agent

For an Agent on an AIX 4.1 or 4.2 operating system:

# mount -vcdrfs -r /dev/cd0 /cdrom

# cd /cdrom/aix4.1_agent

For an Agent on an AIX 4.3 operating system:

# mount -vcdrfs -r /dev/cd0 /cdrom

# cd /cdrom/aix4.3_agent

For an Agent on a Red Hat 6.x release of Linux:

# mount /dev/cdrom /mnt/cdrom

# cd /mnt/cdrom/linux_agent

For an Agent on a Sequent operating system:

# mount -r -f cdfs /dev/dsk/cd1 /cdrom

# cd /cdrom/sequent_agent

7 Copy the installation files to your hard drive. 

# find . -print|cpio -pdvm /usr/rational/test7

8 Change your directory to the directory that contains the 
installation script.

# cd /usr/rational/test7/bin

9 Run the installation script.

# ./agent_install
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10 Start the UNIX Agent.

a Change to the Bourne shell.

# sh

b Change your directory to the installation directory.

# cd /usr/rational/test7/bin

c Set the TEST7HOME and PATH environment variables:

# TEST7HOME=/usr/rational/test7

# export TEST7HOME

# PATH=$PATH:/usr/rational/test7

# export PATH

d Start the Agent daemon.

# ./SQA7sagt

Restarting a UNIX Agent

To restart the UNIX Agent manually:

1 Change to the Bourne shell.

# sh

2 Change your directory to the installation directory.

# cd /usr/rational/test7/bin

3 Set the TEST7HOME and PATH environment variables:

# TEST7HOME=/usr/rational/test7

# export TEST7HOME

# PATH=$PATH:/usr/rational/test7

# export PATH

4 Start the Agent daemon.

# ./SQA7sagt
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Removing Your Software

The following section explains how to remove the Rational Suite 
PerformanceStudio network drivers on Windows NT and 2000.

Removing the Rational Suite PerformanceStudio Network Driver

If you need to switch from an Ethernet network to a Token Ring 
network, or the reverse, you must remove the driver for the 
unwanted network type before you install the driver for the new 
network type.

To remove a network driver on Windows NT:

1 Click Start > Settings > Control Panel, then double-click the 
Network icon.

2 Click the Services tab.

3 Select the Rational Suite PerformanceStudio network driver from 
the Network Services list.
� If your current driver is from Rational Suite PerformanceStudio 

1.0 or earlier, including PerformanceStudio 7.1.1, 7.1, or 7.0, 
select PerformanceStudio Network Driver.

� If your current driver is from Rational Suite PerformanceStudio 
1.5, select RSPS Network Driver.

4 Click Remove.

5 Click Yes to confirm that you want to remove the driver.

6 When the removal is complete, click Close.

7 Click Yes to reboot the computer.

When the computer restarts, you can install the new network 
driver. 
For information, see “Installing the RSPS Network Driver” on 
page 77.
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To remove the network driver on a Windows 2000 computer:

1 Click Start > Settings > Network and Dialup Connections.

2 Right-click Local Area Connection, and select Properties from the 
context menu.

3 Select PerformanceStudio Network Driver 2000 from the Network 
Services list.

4 Click Uninstall.

5 Click Yes to confirm that you want to remove the driver.

6 When the removal is complete, click Close.

Click Yes to reboot the computer.

Installing Rational Robot with PerformanceStudio

If you install Rational Suite PerformanceStudio, Rational Robot 
installs automatically. However, to record GUI scripts on multiple 
computers, you need to install Robot on each computer. A separate 
node-locked license is required for Robot-only installations. For 
information about installing node-locked licenses, see the 
Administering Rational Software Licenses manual or the Rational 
License Key Administrator Help.

To install Rational Robot:

� Follow the Rational Setup to install Rational Robot. For 
information, see “Installing Rational Suite with the Rational 
Software Setup Procedure” on page 57.

Installing SQL Anywhere Server Database Software

If you created an SQA Suite 6.1 SQL Anywhere Server repository 
and want to use data from that repository in a 1.5 SQL Anywhere 
Server database, you must configure existing 6.1 SQL Anywhere 
clients to access the 1.5 SQL Anywhere Server database. 

Since you cannot run a 1.5 and a 6.1 SQL Anywhere Server on the 
same computer, do the following to gain access to a 6.1 SQL 
Anywhere Server database:
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1 Click Start > Programs > Rational product name > Rational 
Administrator.

2 Double-click SQL Anywhere Database Servers in the left pane of 
the Administrator to display all databases.

3 Right-click the 7.0 SQL Anywhere database that you want to use, 
and then click Properties.

4 Click the Advanced tab.

5 In the Additional database server switches box, type:

pathname\databasefilename -n databasename

where pathname is the path to the 6.1 database file, 
databasefilename is the name of the 6.1 database file,
and databasename is the name of the 6.1 database.

For example:

c:\repo\sqlanydb\sqa61.db -n mydb

6 Click OK.

How to Install the Sybase SQL Anywhere Database Server 
Software

When you install the SQL Anywhere Database Server, it installs 
the Rational Administrator and other Rational Suite testing 
components that you need to manage Rational repositories in a 
networked, client/server environment. The SQL Anywhere 
Database Server provides tools, samples, and related library files 
for your SQL Anywhere Database Server. Installing the SQL 
Anywhere Database Server software does not require a separate 
license. 

(A Rational repository is a group of databases that stores 
application testing information such as scripts and logs.) 

Note: You must install the SQL Anywhere Database Server 
software on a network server running Microsoft Windows NT. 
Installing the SQL Anywhere Database Server software does not 
require a license.
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To begin the installation:

1 Turn on the computer to start Windows.

2 Log in using an account with Administrator privileges.

3 Quit any applications before installing any software product.

4 Insert the CD-ROM into your CD-ROM drive. The installation 
starts automatically.

If the installation does not start automatically, do the following:

a Click Start > Run.

b Type drive:\SETUP.EXE, and then click OK.

5 At the Rational Software Setup screen, click Next.

6 Click Install Unlicensed Tools, and then click OK.

7 Select Sybase SQL Anywhere Database Server 5.5.04 from the 
list of available products, and then click Next. 

8 Read the terms of the license agreement carefully, select one of the 
following, and then click Next.

Yes, I accept the agreement. If you accept the agreement, the 
Setup program continues.

No, I don’t accept the agreement. If you do not accept the 
agreement, the Setup program ends. 

9 Select Typical, and then click Next. 

Note You can only select the Typical type of configuration for the 
Sybase SQL Anywhere Database Server installation.Select 
Administrator to set up a server, and then click Next.

10 View the selections that you have made, and if correct, click Next. 

Note Although the summary page asks you to verify that you have a 
license key for this product, you do not need a license for the SQL 
Anywhere Database Server software.

11 Click Finish when done. 
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What to Do Next

After you install the SQL Anywhere Database Server software, 
you must configure the SQL Anywhere Database Server. For 
information, see Chapter 4 of the Using the 
Rational Administrator manual. 

Installing the Rational Test Enablers

The Rational Test Enablers consist of the following:

� Rational ActiveX Test Control – Install to test the properties 
of the ActiveX controls in your application using Rational Robot. 

Note If you are using a development environment other than 
PowerBuilder, Oracle Forms, Visual Basic, Java, or HTML, and 
you want to test the properties of your ActiveX controls, you 
must manually add the Rational ActiveX Test Control to each 
OLE container in your application. For instructions, see the 
documentation that comes with your development environment.

The ActiveX Test Control provides communication between any 
OLE container and Robot. It is a non-intrusive control and has 
no impact on the behavior or performance of your application. At 
runtime, the Rational ActiveX Test Control is not visible. 

� Rational Test Java Enabler – Required to test Java applets 
running in a browser, or to test stand-alone Java applications. 
This Enabler scans your hard drive for Web browsers and Sun 
JDK installations that Robot supports and enables only those 
environments currently installed on your system. Run the 
enabler each time you install a new Java environment, such as a 
new release of a browser or JDK.

� Rational Test Oracle Forms Enabler – Install to test Oracle 
Forms 4.5 and 5.0 applications. Installs both the Rational Test 
Oracle Forms Enabler and the Rational Test Object Testing 
Library for Oracle Forms.

Note Be sure to install Oracle Forms 4.5 or 5.0 and the Oracle Open 
Client Adapter for ODBC before you install the Rational Test 
Oracle Forms Enabler.
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� Rational Test Visual Basic Enabler – Install to test Visual 
Basic 4.0 applications. Ensures that all forms in your project, 
including MDI forms, contain the Rational ActiveX Test Control. 
This Enabler is an add-in (extension) to Visual Basic 4.0. For 
more information about Visual Basic add-ins, see your Visual 
Basic documentation. 

Note You do not need the Enabler to test Visual Basic 5.0 and later 
applications.

For more information about the Rational Test Enablers, see the 
Using the Rational Robot manual.

To install the Rational Test Enablers: 

1 Turn on the computer and start Windows.

2 Insert the CD-ROM into your CD-ROM drive. The installation 
starts automatically.

If the installation does not start automatically, do the following:

a Click Start > Run.

b Type drive:\SETUP.EXE, and then click OK.

3 At the Rational Software Setup screen, click Next.

4 Click Install Unlicensed Tools, and then click Next.

5 Select Rational Test Enablers, and then click Finish.

The Rational Test Enablers installation starts.

6 Select one of the following, and then click Next.

Rational ActiveX Test Control

Rational Test Oracle Forms Enabler

Rational Test Java Enabler 

Rational Test Visual Basic Enabler

7 Follow the on-screen instructions to complete the installation.
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Installing Rational TestAccelerator

Rational TestAccelerator, a component of Rational TestFactory, 
lets you remotely manage and run test scripts. To manage and run 
test scripts remotely, you must install TestAccelerator on each 
system that you want to do automated distributed testing.

You must use a floating license for each system running 
TestAccelerator. For information about setting up a license server 
for floating licenses, see the chapter Rational Software Server 
Licensing in the Administering Rational Software Licenses 
manual. For information about setting up your client system to 
use a floating license, see the chapter Configuring Your Client 
System to Use a Floating License in the Administering Rational 
Software Licenses manual.

To install TestAccelerator, see “Installing Rational Suite with the 
Rational Software Setup Procedure” on page 57. On the Choose 
Product to Install page, select Rational TestAccelerator.

Installing the Sample Applications

The sample applications that come with Rational Suite testing 
software consist of the following components:

� Sample application – You use the Classics Online sample 
application with the Rational Robot tutorial in the Getting 
Started with Rational Robot manual.

� Small sample applets – You use the sample applets with the 
Try it! cards for quick and easy instructions about recording 
tests on controls created in specific development environments. 
You can install sample applets for Java, HTML, Oracle Forms, 
PowerBuilder, and Visual Basic development environments.

� Sample repository – You use the sample repository with the 
Rational Robot tutorial and Try it! cards. The sample repository 
installs automatically when you install a sample application or 
sample applet. 

Note Before you install and run the Oracle sample application for the 
Try it! with Oracle card, you must install Oracle Forms 4.5 or 5.0 
and the Oracle Open Client Adapter for ODBC.
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To install the sample application, sample applets, and sample 
repository:

1 Install Rational Suite TestStudio, Rational Suite 
PerformanceStudio, or Rational Suite Enterprise. For information 
about installing any of these products, see “Installing Rational 
Suite with the Rational Software Setup Procedure” on page 57.

2 Click Start > Programs > Rational product name > Rational Test > 
Set Up Rational Test Samples.

3 Select the sample application and the sample applets that you 
want to install:

HTML Sample

Java Sample

Visual Basic Sample

PowerBuilder Sample

Oracle Sample

Classics Online

4 Click Next.
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Installing Rational TestManager – Manual Script Execution

Rational TestManager – Manual Script Execution is a Web Server 
component that comes with Rational Suite testing products. 
Rational TestManager lets you create a manual script (a set of 
testing instructions to be run by a human tester) and then run the 
manual script in TestManager or on the Web. To run a manual 
script on the Web, you must install the Rational TestManager - 
Manual Script Execution component.

To install the TestManager - Manual Script Execution component, 
do the following custom installation:

1 Turn on the computer to start Windows.

2 Log in using an account with Administrator privileges.

3 Quit all applications before installing any Rational product.

4 Insert the CD-ROM into your CD-ROM drive. The installation 
starts automatically.

If the CD-ROM does not start automatically, do the following:

a Click Start > Run.

b Type drive:\SETUP.EXE, and then click OK.

5 On the Rational Software Setup screen, click Next.

6 Click Install Rational Product, and then click Next.

7 Select the license you want, and then click Next. For information 
about software licenses, click Help, or see the Administering 
Licenses for Rational Software manual or the Rational License 
Administrator Help. 

8 Select one of the following products from the list of available 
products, and then click Next:

Rational Suite Enterprise

Rational Suite PerformanceStudio

Rational Suite TestStudio



Rational Suite Testing Products: Post - Install 93

9 Read the terms of the license agreement carefully, select one of the 
following, and then click Next.

Yes, I accept the agreement. If you accept the agreement, the 
Setup program continues.

No, I don’t accept the agreement. If you do not accept the 
agreement, the Setup program ends. 

10 On the Setup Configuration page of the Setup Wizard, click 
Custom/Full, and then click Next.

11 Optionally, clear all check boxes on the Choose Features page.

Note If you want to create manual scripts on the Web server, then you 
must install Rational Robot on the Web server.

12 Double-click Web Server Components.

13 Select the Rational TestManager/Web check box to install the 
Rational TestManager - Manual Script Execution component.

14 Follow the on-screen instructions to complete the installation. 

The Rational Setup Wizard displays a series of dialog boxes that 
guide you through the installation process and prompt you for 
information.

15 Click Finish when done.

Your system restarts. 

Installing Crystal Reports

Crystal Reports lets you customize defect reports that come with 
Rational Suite testing products. Crystal Reports also lets you 
create new report formats. This software comes on a separate 
CD-ROM in your Rational software kit.

To install Crystal Reports 6.0 Professional Edition, use the 
Crystal Reports installation directions that come with the 
CD-ROM.
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This chapter provides instructions for configuring Oracle® and 
Microsoft® SQL Server databases for RequisitePro projects. In 
addition, it includes instructions on e-mail setup for RequisitePro 
discussions, and installation and configuration procedures for 
RequisiteWeb.

RequisitePro organizes your software development requirements, 
linking Microsoft Word to a requirements repository that can be 
shared among other Rational products.

For the most current information related to RequisitePro features 
and known issues, refer to the release notes, which  appear at the 
end of the RequisitePro installation. The release notes are 
available from a link in the Let’s Go RequisitePro application, 
which appears when you first launch RequisitePro. They are also 
available after installation on the Start menu in the Rational 
RequisitePro program group. 

Configuring an Enterprise Database for RequisitePro
The following sections describe the configuration of Oracle® and 
Microsoft® SQL Server™ databases for RequisitePro projects. 

The use of client/server databases offers significantly increased 
power and expandability to your organization's implementation of 
Rational RequisitePro. RequisitePro provides the capability to use 
Oracle7 and Oracle8 and Microsoft SQL Server 7.0, as well as 
Microsoft Access databases. Project data currently in Access can 
be easily migrated to Oracle or SQL Server using the RequisitePro 
Database Type Conversion Wizard.

To create and access RequisitePro projects in Oracle or Microsoft 
SQL Server databases, you must configure an Oracle or SQL 
Server schema on your database server, and install RequisitePro 
on your client PC.
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Database Setup

Refer to Oracle or Microsoft documentation for information on 
installing Oracle or Microsoft SQL Server. To configure an Oracle 
or SQL Server database for RequisitePro projects, refer to the 
sections “Configuring Oracle for RequisitePro” on page 11 and 
“Configuring SQL Server for RequisitePro” on page 25. 

Client Installation

Access to RequisitePro projects on Oracle and SQL Server 
databases requires the installation of RequisitePro on the client 
PC. If you are using an Oracle database, you must also install the 
Oracle client software on your PC. 

See the chapter “Rational RequisitePro Installation and Database 
Configuration” on page 1 for RequisitePro system requirements.

Installing Database Configuration Scripts 

If you are responsible for setting up an Oracle or SQL Server 
database for RequisitePro, you should have installed the database 
configuration scripts with the Custom/Full installation option, 
described in “Installing RequisitePro with Rational Software 
Setup” on page 4. 

If you selected the Oracle or SQL Server options, the program 
installed schema creation scripts in one or both of the following 
locations on your local machine: 
c:\Program Files\Rational\RequisitePro\database\oracle

c:\Program Files\Rational\RequisitePro\database\sqlserver

If you did not install the scripts during the installation process, 
you can copy them to your local machine from the 
RequisitePro/database directory on your installation media.
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Configuring Oracle for RequisitePro

Purpose

This section provides information about configuring Rational 
RequisitePro for use with an Oracle database server. It includes:

� database management information for setting up an Oracle 
schema to accommodate Requisite projects, 

� instructions for accessing an Oracle host from the client PC 
using Oracle's SQL*Net or Net8 Easy Configuration tool, and

� a procedure for creating a RequisitePro project in the Oracle 
database.

These instructions are intended for use by Oracle database 
administrators, system administrators, and RequisitePro project 
administrators.

For the most current information related to Oracle database 
configuration, refer to the “Oracle Database Configuration for 
RequisitePro” document that is, by default, at the following 
location on your system after installation: 
c:\Program Files\Rational\RequisitePro\help\OracleSetup.html

Introduction

To create and access RequisitePro projects in the Oracle database, 
follow the instructions in this document for enabling your Oracle 
database compatibility. RequisitePro supports multiple projects 
within a single Oracle schema. Refer to the procedure in this 
document, “Creating a Project in Oracle” on page 21 for 
instructions on adding an Oracle database project within 
RequisitePro. Use the same schema name for each of your 
RequisitePro projects.



98 Installing Rational Suite

Prerequisites

This document assumes that you have Oracle, installed on your 
LAN and the Oracle client software installed on your PC. Refer to 
the Oracle documentation for all questions regarding that product.

The following installation and configuration tasks need to be 
accomplished prior to performing the RequisitePro/Oracle 
integration outlined in this document.

Oracle Database Administration

Notice to database administrator: 
For proper execution of the RequisitePro application, be sure to set 
the initialization parameter, OPEN_CURSORS, to at least 110.

In order to configure access to Oracle for RequisitePro projects, the 
database administrator needs to establish the following:

� Oracle database server name (TCP/IP Host Name)
� Oracle database alias or service name
� Oracle schema name for storing RequisitePro projects (see 

procedure below)
� your user ID for logging on to the Oracle database
� your user password for logging on to the Oracle database

The following sections provide instructions for configuring the last 
three of these items.

Platform Compatibility

RequisitePro database implementation is compatible with all 
Oracle-supported platforms.

Creating an Oracle Schema for RequisitePro

Oracle database administration allows the creation of multiple 
schemas within your Oracle database instance. Use the scripts 
listed below to create a RequisitePro user and schema 
within Oracle for storing your projects. The RequisitePro scripts 
are designed to initially allocate disk space for the various 
database tables and indexes that are used by RequisitePro, based 
on the following approximations: 
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� 25 projects
� 250 documents (10 per project)
� 125 document types (5 per project)
� 125 requirement types (5 per project)
� 1250 user defined attributes (10 per requirement type)
� 125 user groups (5 per project)
� 100 users
� 12,500 requirements (500 per project)
� 12,500 discussions (500 per project)

The scripts simply provide an initial size for the RequisitePro 
schema. They in no way imply any constraints on size or number 
of projects. 

Extents are set to the same size as the initial allocations. They 
define additional table space that Oracle will allocate if the 
original allocation becomes insufficient.

As database administrator, you can customize the scripts to adjust 
the table space allocations for tables and indexes in order to 
accommodate your organization's intended use of RequisitePro. 
See the section “Editing Scripts” on page 15. 

Schema Creation Scripts

The following scripts are used for creating a RequisitePro schema 
within your Oracle database. They can be run automatically by 
executing the main script, CREATE_REQPRO, as described in the 
procedure “Creating a Schema” on page 18, or you can run them 
individually as needed.

CREATE_REQPRO. Establishes a log which can be used to 
review the results of running the script and runs the other scripts, 
listed below.  

TABLESPACE. Creates table spaces for data and indexes. 
Creates disk files to support these table spaces.

CREATE_USER. Creates the default RequisitePro user 
(REQPRO) and password (REQPRO) and connects to the database 
with that user ID.
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TABLES.  Creates tables for the RequisitePro database.

PRIMARY. Creates primary keys for each table in RequisitePro.

INDEXES. Creates indexes for the RequisitePro database.

FOREIGN.  Creates foreign key relationships between tables.

FUNCTIONS. Creates user-defined functions used within 
RequisitePro.

SEQUENCE.  Creates sequences and triggers for 
auto-sequencing the RqToRelationships and RqQueryCriteria 
tables.

PROCEDURES. Creates stored procedures used within 
RequisitePro.

DATA. Inserts data into the RqKeys and RqRequisite tables.

GRANT_ROLE. Creates a user role with access to the 
RequisitePro schema objects.

Copying the RequisitePro Scripts

If you did not install the Oracle database creation scripts as 
described in “Installing RequisitePro with Rational Software 
Setup” on page 4, you can repeat the Custom/Full installation 
procedure or copy the Oracle scripts from the Rational Windows 
Solutions media in the following location:

CD-ROM:\\RequisitePro\database\Oracle\

After installation, the scripts are located, by default, at the 
following location on your local machine: 

c:\Program Files\Rational\RequisitePro\database\oracle

Copy the scripts to a subdirectory on your Oracle database server. 
We suggest that you create a “sql” directory below the home 
directory on the server.

Note If your database server is running on an international operating 
system, be sure that the path to these scripts does not include 
folders with double-byte character names.
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Editing Scripts

All modifications described below are made in the 
CREATE_REQPRO script, unless otherwise indicated. 

Modifying the User Name and Password (Optional)

If you want to create the RequisitePro schema with a different 
entry than the default user name and password values of 
"ReqPro", modify the following entries:

DEFINE USR=reqpro
DEFINE PWD=reqpro

Specifying the Path for the Schema Scripts

Edit the DEFINE PATH entry to indicate the full path where the 
RequisitePro .SQL scripts are located. The suggested path (from 
the "Copying..." procedure, above) is:

DEFINE PATH="$HOME/sql/"

Note If your environment limits your path to a maximum 8-character 
name for directories, be sure to reflect this format in your entry.

Indicating Data and Index Files Directory

Edit the DEFINE ORACLE _DATA entry to indicate the path and 
directory where the data file for the data table space will be 
created:

DEFINE ORACLE_DATA=/ORACLE_DATA/

Edit the DEFINE ORACLE _INDEX entry to indicate the path and 
directory where the data file for the index table space will be 
created:

DEFINE ORACLE_INDEX=/ORACLE_INDEX/
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Specifying a Temporary Tablespace

Edit the DEFINE TEMP entry in the CREATE_REQPRO script to 
assign temporary tablespace for storing temporary objects for the 
user’s operations.

DEFINE TEMP=TEMP

Make sure that the value for this entry is a valid, existing 
tablespace in your Oracle database. Some versions of Oracle use 
“TEMPORARY_DATA” rather than “TEMP.” Your installation of 
Oracle may contain a custom name for the temporary tablespace.

Customizing Disk Space Allocation for Database Objects

The schema creation scripts are designed to allocate disk space for 
the various database tables and indexes that are used by an 
average set of RequisitePro projects, as described in “Creating an 
Oracle Schema for RequisitePro” on page 13. 

If you anticipate a much larger or smaller requirement for your 
organization's use of RequisitePro, you can customize the disk 
space allocation specified in the CREATE_REQPRO script to 
accommodate your projected capacity. 

Edit the following sizing variables: 

SMALL = 10K
MEDIUM = 100K
LARGE = 1000K
REQS = 6000K
REQHIST = 75000K

Note The last two variables, REQS and REQHIST, are used for the 
requirements (RqRequirements) and requirement history 
(RqRequirementHistory) tables, respectively. 

Edit the DEFINE DATA_SIZE and DEFINE INDEX_SIZE entries to 
reflect the change in the total size of the database caused by your 
edits to the sizing variables.

Modifying the Limits of the VARCHAR2 Data Type

RequisitePro uses the VARCHAR2 data type to store searchable 
text for requirement text, revision history reasons, and textual 
attribute values. 
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While Oracle7 supports a maximum of 2000 characters in the 
VARCHAR2 data type, Oracle8 supports up to 4000, allowing you 
to expand the constraints on the size of the searchable text from 
2000 to 4000 characters. 

The RequisitePro Oracle scripts set the limit on this data type to 
2000 characters to accommodate both Oracle7 and Oracle8 
databases. To modify this limit for Oracle8 databases, edit table 
settings in the TABLES and DATA scripts. 

In the TABLES script, all occurrences of 2000 in the following 
columns can be set to the new maximum value of 4000:

In the DATA script, all occurrences of 2000 in the following 
columns can be set to the new maximum value of 4000:

Table Column

RQDOCUMENTHISTORY VERSIONREASON

RQDOCUMENTS VERSIONREASON

RQPROJECTHISTORY  VERSIONREASON

RQPROJECTS  VERSIONREASON

RQQUERYDEFINITIONS QUERYSTRING

RQREQUIREMENTHISTORY VERSIONREASON

RQREQUIREMENTS REQUIREMENTTEXT

RQREQUIREMENTS VERSIONREASON

RQUSERDEFINEDFIELDVALUES FIELDVALUE

Table Column

RQREQUISITE REQUIREMENTTEXTSIZE

RQREQUISITE FIELDVALUESIZE

RQREQUISITE VERSIONREASONSIZE
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Creating a Schema

The Oracle database administrator performs the following 
procedure to create a RequisitePro schema in Oracle:

1 Edit the CREATE_REQPRO script, as described above in the 
section “Editing Scripts” on page 15.

2 On the Oracle database server, log on to SQL*Plus with system 
administrator permissions.

Note If you run SQL*Plus from a remote client, you need to edit the 
RequisitePro CREATE_USER script. Change the entry connect
&3/&4 to the following:
connect &3/&4@<target Oracle database server alias>

3 Run the CREATE_REQPRO script using the command:
@<setup directory>\CREATE_REQPRO

This script runs the schema creation scripts. A message appears 
upon successful completion of the schema creation. If errors occur 
or the completion message does not appear, review the log 
CREATE_REQPRO.LOG.

User ID for Accessing Oracle Database

All RequisitePro projects should access the Oracle database using 
the same user ID, which was created during the schema creation 
process, described above. The initial user name and password 
created by the script are "reqpro" and "reqpro", unless you 
modified the CREATE_REQPRO script, as described in “Editing 
Scripts” on page 15. You can also change the password using your 
Oracle database utilities. 

Each user does not need a separate Oracle account because 
RequisitePro uses its own user and user group tables to control 
access to a project.

Using Multiple Projects within an Oracle Database

RequisitePro supports multiple projects within a single Oracle 
schema. Refer to the procedure “Creating a Project in Oracle” on 
page 21 for instructions on adding an Oracle database project 
within RequisitePro. Use the same schema name for each of your 
RequisitePro projects.
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Connecting Projects Across Databases

Perform the following steps to enable cross-project traceability 
between projects in distributed Oracle databases. Refer to the 
following sections for details.

� Creating a reference to the remote database instance
� Creating a database link to the remote database
� Defining database aliases on each RequisitePro client

Creating a Reference to the Remote Database Instance

In order to run traceability queries between projects in distributed 
Oracle databases, you need to define a reference in each database 
instance that refers to the remote database instances. Edit the 
tnsnames.ora file, located on the Oracle server, to define the 
name, host, port and protocol of the remote service. 

The following example shows the syntax for defining the database 
instance “server02” as a remote database server to “server01” in 
the tnsnames.ora file:

Server02.world =
(DESCRIPTION =

(ADDRESS_LIST =
(ADDRESS =

(COMMUNITY = tcp.world)
(PROTOCOL = TCP)
(Host = server02)
(Port = 1521)))

(CONNECT_DATA = (SID = ORCL)))

In similar fashion, the “server02” database instance needs an 
entry to define the remote “server01” database instance:

Server01.world =
(DESCRIPTION =

(ADDRESS_LIST =
(ADDRESS =

(COMMUNITY = tcp.world)
(PROTOCOL = TCP)
(Host = server01)
(Port = 1521)))

(CONNECT_DATA = (SID = ORCL)))
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Note This feature was tested using TNSNAMES for service name 
resolution. Use of Oracle Names Server or any other name server 
mechanism will require different setup.

Creating a Database Link to the Remote Database

Next, create a database link to each remote database in each 
database instance using an SQL utility. The link should be 
defined under the user account which owns the RequisitePro 
schema. The following example shows the required syntax for 
linking to “server02” from “server01”:

CREATE DATABASE LINK server02.world
CONNECT TO reqpro IDENTIFIED BY reqpro
USING ‘server02.world’;

A similar statement should be executed on the server02 database 
instance in order to define a link to server01.

If the db_name.db_domain does not result in a unique name for 
each database for which a link is required, use the 
@connection_qualifier syntax to create a unique name.

This naming convention will work regardless of the setting of the 
global_names parameter in the initorcl.ora file.

Defining Database Aliases on each RequisitePro Client

Define SQL*Net database aliases or Net8 service names (resulting 
in local tnsnames.ora file entries) on each RequisitePro client 
machine (or shared centrally on a network) for each database 
instance. The database alias or service name on the client MUST 
match the database link you defined in the previous step for 
RequisitePro cross-project traceability to function correctly. 

For more information on configuring client PCs for use with a 
Rational RequisitePro Oracle database, refer to the following 
section.
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Setting Up PCs for Oracle Access

Use the Oracle SQL*Net or Net8 Easy Configuration tool to 
configure access from your client PC to the Oracle database 
server. If you plan to share projects with other users, be sure to 
use a consistent database alias or service name, as determined by 
your database administrator.

Creating a Project in Oracle

Note To convert a project from an existing Microsoft Access database to 
an Oracle database, use the Database Type Conversion Wizard. 
Open the Database Type Conversion Wizard in Windows Explorer. 
The executable, rqdbtypewiz.exe, is located in the 
Rational\RequisitePro\bin\ directory.

Perform the following steps to create a RequisitePro project that 
uses the Oracle database server for storing the RequisitePro 
project database.

Prior to configuring your access to Oracle from RequisitePro, the 
database administrator needs to provide the following 
information:

� Oracle database server name (TCP/IP Host Name)
� Oracle database alias or service name
� Oracle schema name for storing RequisitePro projects (see 

procedure below)
� your user ID for logging on to the Oracle database
� your user password for logging on to the Oracle database

1 In RequisitePro on the Project menu, click New.

2 At the New Project dialog box, select the method Blank project 
database.
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3 Click OK. The Project dialog box appears.
  

4 Perform all actions you would normally perform when creating a 
project; in addition, do the following.

5 In the Project dialog box General tab, select Oracle from the 
Database drop-down list.

6 Click the Properties button. The Database Properties dialog box 
appears.

7 Click the Configure button. The Microsoft ODBC for Oracle Setup 
dialog box appears.
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8 Do not modify the default entries in the Data Source Name and 
Description fields.

9 Type your User Name for logging into the Oracle database, as 
provided by your Oracle database administrator. By default, the 
user name is "reqpro".

10 For the Server field, type the alias or service name you entered 
when configuring your PC for access to the Oracle database.

Note This database alias or service name must be identical when 
configuring all PCs that will access shared RequisitePro projects 
in the Oracle database.

11 Click OK.

12 On the Database Properties dialog box, click the Account Info 
button. The Database Account Info dialog box appears.
  

13 Do not modify the User ID field. This should match the user name 
you entered in the previous dialog box. 

14 Type your user password for logging into the Oracle server. This 
should be supplied to you by your Oracle database administrator.

15 Retype your password in the Verify Password field.

16 In the Schema field, type the name of the Oracle schema that your 
Oracle database administrator has established for storing 
RequisitePro data in Oracle.

17 Click OK to close the dialog box.
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18 Click OK to close the Database Properties dialog.

19 Finish creating your project, then click OK to close the Project 
dialog box.

Archiving an Oracle Project

Refer to the topic "Archiving and backing up enterprise database 
projects" in the RequisitePro online help. This help topic is also 
available in Let’s Go RequisitePro. Click the Project 
Administration Tips icon and select the link to "Archiving and 
backing up enterprise database projects".

Configuring SQL Server for RequisitePro

Purpose

This section provides information about configuring Rational 
RequisitePro for use with Microsoft SQL Server. The section 
includes:

� database management information for setting up a SQL Server 
schema to accommodate RequisitePro projects, and

� a procedure for creating a RequisitePro project in the SQL 
Server database.

This document is intended for use by SQL Server database 
administrators, system administrators, and RequisitePro project 
administrators.

For the most current information related to SQL Server database 
configuration, refer to the “SQL Server Database Configuration 
for RequisitePro” document that is, by default, at the following 
location on your system after installation: 
c:\Program Files\Rational\RequisitePro\help\SQLsetup.html
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Introduction

To create and access RequisitePro projects in the SQL Server 
database, follow the instructions in this section for enabling your 
SQL Server database compatibility. RequisitePro supports 
multiple projects within a single SQL Server schema. Refer to the 
procedure “Creating a Project in SQL Server” on page 29 for 
instructions on adding an SQL Server database project within 
RequisitePro. Use the same schema name for each of your 
RequisitePro projects.

Prerequisites

This document assumes that you have SQL Server, Version 7.0, 
installed on your LAN. Refer to the SQL Server documentation for 
all questions regarding that product.

The following installation and configuration tasks need to be 
accomplished prior to performing the RequisitePro/SQL Server 
integration outlined in this document.

SQL Server Database Administration

Prior to configuring your access to SQL Server from RequisitePro, 
the database administrator needs to establish the following:

� SQL Server machine name (TCP/IP Host Name)
� SQL Server default database for RequisitePro projects, such as 

“RequisitePro”
� a user ID for logging on to the SQL Server database, such as 

“ReqPro”
� a user password for logging on to the SQL Server database, such 

as “reqpro”

The following sections provide instructions for configuring the last 
three of these items.

Platform Compatibility

RequisitePro database implementation is compatible with all 
Microsoft SQL Server-supported platforms.
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Creating a SQL Server Database for RequisitePro 

Use the following instructions to create a SQL Server database 
and schema for RequisitePro projects. The initial database size is 
based on the following approximations for your use of 
RequisitePro: 

� 25 projects
� 250 documents (10 per project)
� 125 document types (5 per project)
� 125 requirement types (5 per project)
� 1250 user-defined attributes (10 per requirement type)
� 125 user groups (5 per project)
� 100 users
� 12,500 requirements (500 per project)
� 12,500 discussions (500 per project)

To create a database in SQL Server 7.0, do the following:

1 Enter a name for the RequisitePro database. The database has an 
.MDF extension. The recommended database name is 
“RequisitePro.”

Note If you use a different database name, you will need to modify the 
database configuration scripts to reflect the actual name.

2 Set the initial size of the database to 150 MB.

3 Set the initial size of the transaction log file (.LDF) to one third 
the size of the database, in this case 50 MB.
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Schema Creation Scripts

The scripts listed below are used for creating a RequisitePro 
schema within your SQL Server database. 

� Login and User. Creates a default RequisitePro login and user. 
For more information refer to the section below, “Default Login 
and User.” 

� Tables and Indexes. Creates the tables and indexes required 
by RequisitePro.

� Triggers. Creates triggers that enforce cascading deletes.
� Initial Data. Inserts data required by RequisitePro when it 

first runs.

Copying the RequisitePro Scripts

If you did not install the SQL Server database creation scripts as 
described in “Installing RequisitePro with Rational Software 
Setup” on page 4, you can repeat the Custom/Full installation 
procedure or copy the SQL Server scripts from the Rational 
Windows Solutions media in the following location: 
CD-ROM:\\RequisitePro\database\SQLserver\

After installation, the scripts are located, by default, at the 
following location on your local machine: 
c:\Program Files\Rational\RequisitePro\database\sqlserver

Copy the scripts to a subdirectory on your SQL Server database 
server. We suggest that you create a “sql” directory below the 
home directory on the server.
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Running Schema Creation Scripts

The scripts listed below are used for creating a RequisitePro 
schema within your SQL Server database. Run the scripts in the 
sequence presented below. Run the scripts individually using the 
SQL Server Query Analyzer. Be sure to select the RequisitePro 
database in the DB drop-down list when running the scripts.

1 login and user.sql   

2 tables and indexes.sql 

3 triggers.sql  

4 initial data.sql

Default Login and User

The schema creation scripts, described above, create default user 
information for accessing and creating projects in SQL Server. The 
user name also establishes the ownership and name of the schema 
(by default, “reqpro”). The default user permissions are required 
for use with RequisitePro.

Note If you modify the login and user.sql script to use a different 
login and user name, you will need to modify subsequent scripts.

The ReqPro user is assigned the following statement permissions 
in SQL Server:

User Login Password

ReqPro ReqPro reqpro

User Statement Permissions

ReqPro Create Default, Create Procedure, Create Rule, Create 
Table, Create View
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As the owner of the RequisitePro database objects, the ReqPro 
user is automatically assigned the following database permissions 
in SQL Server:

Creating a Project in SQL Server

Note To convert a project from an existing Microsoft Access database to 
an Oracle database, use the Database Type Conversion Wizard. 
Open the Database Type Conversion Wizard in Windows Explorer. 
The executable, rqdbtypewiz.exe, is located in the 
Rational\RequisitePro\bin\ directory.

Perform the following steps to create a RequisitePro project that 
uses the SQL Server for the project database.

In order to configure access to SQL Server from RequisitePro, the 
database administrator needs to provide you with the following 
information:

� SQL Server machine name (TCP/IP Host Name)
� SQL Server default database for RequisitePro projects, such as 

“RequisitePro”
� a user ID for logging on to the SQL Server database, such as 

“ReqPro”
� a user password for logging on to the SQL Server database, such 

as “reqpro”

1 Start RequisitePro.

2 On the Project menu, click New.

3 At the New Project dialog box, select the method Blank project 
database.

User Database Permissions

ReqPro Select, Insert, Update, Delete, DRI on all Tables and 
Views
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4 Click OK. The Project dialog box appears.
  

5 Perform all actions you would normally perform when creating a 
project; in addition, do the following.

6 In the Project dialog box General tab, select SQL Server from the 
Database drop-down list.
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7 Click the Properties button. The Database Properties dialog box 
appears.
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Configuring the Database

1 At the Database Properties dialog box, click the Configure button. 
The “Create a New Data Source to SQL Server” dialog box 
appears.
  

2 Do not modify the data source Name or Description fields.

3 In the Server field, type the name of the SQL Server, supplied by 
your database administrator.
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4 Click Next. The second data source screen appears.
  

5 Select the option “With SQL Server authentication using a login 
ID and password entered by the user.”
Note: RequisitePro does not support Windows NT authentication.

6 Be sure the check box “Connect to SQL Server to obtain default 
settings for the additional configuration options” is checked.

7 Type a login ID and password supplied by your database 
administrator, such as “ReqPro” and “reqpro.”

8 Click Next.

9 Click the check box “Change the default database to” and select a 
database name supplied by your database administrator, such as 
“RequisitePro.”

10 Click Next.

11 Click Next to accept the default language, character, and regional 
settings. The use of log files, shown on the following screen, is 
optional.
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Note Do not mark the check box "Change the language of SQL Server 
system messages to..." The use of this check box prevents users 
from opening the project after its initial creation.

12 Click Finish. The ODBC Microsoft SQL Server Setup dialog box 
appears.

13 Click the Test Data Source button. The SQL Server ODBC Data 
Source Test dialog box appears.

14 Click OK. The ODBC Microsoft SQL Server Setup dialog box 
appears.

15 Click OK. You return to the Database Properties dialog box.

Setting Up the Project Account Information

1 At the Database Properties dialog box, click the Account Info 
button. The “Database Account Info” dialog box appears.
  

2 Type the user ID and password, supplied by your database 
administrator for accessing the SQL Server database, such as 
“ReqPro” and “reqpro.”

3 Retype your password in the Verify Password field.

4 In the schema field, type the user name of the owner of the 
RequisitePro database tables, supplied by your database 
administrator, such as “ReqPro.”

5 Click OK to close the dialog box.
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6 Click OK to close the Database Properties dialog.

7 Finish creating your project, then click OK to close the Project 
dialog box.

Archiving a SQL Server Project 

Refer to the topic "Archiving and backing up enterprise database 
projects" in the RequisitePro online help. This help topic is also 
available in Let’s Go RequisitePro. Click the Project 
Administration Tips icon and select the link to "Archiving and 
backing up enterprise database projects".

Installing and Configuring RequisiteWeb

Overview

This section describes the installation and configuration of  
RequisiteWeb.

RequisiteWeb allows clients to read, modify, create, and reparent 
Rational RequisitePro project requirements across the Internet or 
an Intranet. By utilizing browsers – Netscape Navigator or 
Microsoft Internet Explorer – RequisiteWeb provides 
platform-independent, thin-client access to RequisitePro project 
data. 

RequisiteWeb requires the configuration of the Microsoft Internet 
Information Server and the installation of Web components on the 
same Microsoft Windows NT server. In addition, a Web browser 
must be installed on the client system. No Requisite 
application-specific files need to be installed on the client system.

For the most current information on RequisiteWeb, including  
installation, configuration, and known issues, refer to the 
RequisiteWeb Installation and Configuration document that is, by 
default, at the following location on the system where you install 
RequisiteWeb: 
c:\Program Files\Rational\RequisitePro\reqweb\reqwebsetup.html

The RequisiteWeb Installation and Configuration document is 
also available from the online Release Notes in RequisitePro.
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Note You can copy the documentation CD to the Web server if you 
choose.

Server Configuration Overview

The following sections provide system requirements, installation, 
and configuration information for installing RequisiteWeb on your 
NT server. This information is necessary for performing the 
following procedures:

� “RequisiteWeb Server Requirements” on page 123
� “Installing RequisiteWeb on the IIS Server” on page 125
� “Copying RequisiteWeb Components on the IIS Server” on 

page 126
� “Creating a Virtual Web Directory” on page 126
� “Configuring for UNIX Navigator Access” on page 136
� “Creating Required Directories on the IIS Server” on page 136
� “Granting Launch Permissions for Microsoft Word with IIS 5.0” 

on page 142
� “Setting Directory Permissions on the IIS Server” on page 137"
� “Building the Web Project Catalog” on page 147
� “Configuring E-mail Discussions for RequisiteWeb” on page 148
� “Configuring RequisiteWeb for Oracle Database Projects” on 

page 148
� “Starting RequisiteWeb” on page 148

For more detail on the installation procedure, including an 
explanation of installation types, installing shared components, 
and accessing support, refer to the “Additional Installation 
Information” on page 65.
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RequisiteWeb Server Requirements

Note Make certain that you have a current backup of your Registry and 
system directories prior to running the Rational Software 
Installation procedure.

You must install either a RequisitePro startup or permanent 
license key to use this software. The Rational License Key 
Administrator online help provides detailed instructions for 
installing startup and permanent license keys. See “Rational 
Software Client Licensing” on page 73 for more information about 
licenses, including the procedure for obtaining an updated license 
key.

To use the Rational Software Setup program on a Windows NT 
system, you must have windows NT administrator privileges.
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The following table summarizes the requirements for the 
RequisiteWeb server.

RequisiteWeb Security Requirements

After you have installed RequisiteWeb, you may need to alter 
security permissions on your IIS server for reasons unrelated to 
RequisiteWeb. Use caution when modifying permissions on 
RequisiteWeb-related folders. For more information, see “Setting 
Directory Permissions on the IIS Server” on page 49.

Table 17: RequisiteWeb Server Requirements

Item Requirement

Operating System NT Server 4.0, Service Pack 3 or later
NT 4.0 Option Pack which includes:
Microsoft Internet Information Server (IIS) 4.0 and 
Microsoft Transaction Server (MTS) 2.0
or
Microsoft Windows 2000 Server, which includes:
Internet Information Services (IIS) 5.0 

Processor 300 MHz or greater

Memory 128 MB. For projects with more than 10,000 requirements 
or Web sites with more than 10 concurrent users, 256 MB 
or more is recommended.

Disk space RequisiteWeb (includes system DLLs) -- 40 MB
ASPs, Web DLLs, bitmaps -- 2 MB

Other products Word 2000 (recommended version) or Microsoft Word 97; 
in Word 97, you must include the installation option: 
Converters and Filters/Text Converters/HTML Converter

Oracle, version 7.3 or greater, client software (for 
accessing projects in an Oracle database)

Microsoft Internet Explorer 5
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Installing RequisiteWeb on the IIS Server

Note For current RequisiteWeb users, be sure to uninstall any earlier 
version of RequisiteWeb prior to installing RequisiteWeb on your 
server. Refer to “Removing RequisiteWeb” on page 61 for specific 
instructions. Be sure to retain your existing catalog.txt file.

1 Insert the Rational Solutions for Windows CD into your system’s 
CD drive.
The setup program starts automatically. If autorun is disabled on 
your system, click Start  >  Run. Using the drive letter of your 
CD-ROM drive, enter drive:\SETUP.EXE.

2 The Rational Software Setup wizard guides you through the 
software installation. On each screen, click the Next button to 
proceed to the next screen.
The Rational Software Setup program writes a log of the 
installation activities. The log file is located, by default, in 
c:\Program Files\Rational\RSSetup\RSSetup.log

3 At the Choose Product screen, select Rational RequisitePro on the 
drop-down list.

4 At the Setup Configuration screen, click Custom/Full. 

Note If your database server is running on an international operating 
system, be sure that the install path does not include folders with 
double-byte character names.

5 At the Choose Features screen, mark the Web Server 
Components and clear the RequisitePro and Rational 
Synchronizer check boxes. You can expand the Web Server 
Components selection and clear the RequisiteWeb Sample 
Projects to install RequisiteWeb without the Learning Project and 
QuarterByte Bank example projects.
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Possible Reboot Required
If files that are required for the installation are in use during the 
installation procedure, the Rational Windows Setup program may 
need to reboot your system to complete the installation.

After rebooting, log on as the same user to complete the 
installation procedure.

Copying RequisiteWeb Components on the IIS Server

The IIS installation creates a wwwroot directory in the server file 
structure; typically this is located in the C:\Inetpub directory. 

The RequisiteWeb installation creates a ReqWeb directory in the 
RequisitePro installation directory; typically located in: 
C:\Program Files\Rational\RequisitePro. Copy and paste this 
directory into the wwwroot directory using Windows NT Explorer.

This copy procedure follows standard IIS guidelines for Web 
installations and ensures that proper permissions are created for 
RequisiteWeb.

1 Copy the ReqWeb directory located in C:\Program
Files\Rational\RequisitePro. Be sure to include the ReqWeb 
directory and all its contents and subdirectories.

2 Paste the ReqWeb directory and all its contents in the 
C:\Inetpub\wwwroot directory on your IIS installation.

Creating a Virtual Web Directory

RequisiteWeb requires a virtual directory on your Web server in 
order to access the RequisiteWeb catalog and other components. 
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Creating a Virtual Directory on Internet Information Server 4.0

For information of creating a virtual directory on IIS 5.0, see 
“Creating a Virtual Directory on Internet Information Services 
5.0” on page 44.

1 Start the Microsoft Management Console (MMC). 

Note The default Start menu selections for the MMC are 
Programs/Windows NT 4.0 Option Pack/Microsoft Internet 
Information Server/Internet Service Manager.

2 Navigate to the ReqWeb directory under the Default Web Site.

3 Right-click on the ReqWeb directory and click Properties. The 
Properties dialog box appears.

Access

Content

Application
Settings

Permissions

Control Create
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4 At the Directory tab, under Access Permissions, mark the Read 
check box and clear the Write check box. 

5 Clear all the Content Control check boxes. 

6 Under Application Settings, click the Create button to create a 
virtual Web directory. 

Note If the Remove button is displayed instead of the Create button, 
click it. The Create button appears.

7 In the Name field, type ReqWeb. 

8 Clear the check box Run in separate memory space (isolated 
process).

9 Under the Application Settings Permissions, select the Script 
option.
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10 Click the Configuration button. The Application Configuration 
dialog box appears.

11 Click the App Options tab. Be sure that the Enable session state 
check box is marked.

12 Be sure that the ASP script timeout field is set to at least 90. Click 
OK. 

13 In the Properties dialog box, click the Directory Security tab.

14 In the Anonymous Access and Authentication Control frame, 
click the Edit button to access to display Authentication Methods 
dialog box.

Enable
Session

ASP Script
Timeout

State
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15 Mark the Allow Anonymous Access check box and clear the 
Basic Authentication and NT Challenge/Response check boxes. 
Click the Edit button next to the Account Used for Anonymous 
Access label. The Anonymous User Account dialog box appears.

16 At the Username field, note the IUSR user name. It should be in 
the form IUSR_<server name>. You will use this user name in 
subsequent configuration steps.

Allow
Anonymous
Access

Edit
Account Used for
Anonymous
Access

IUSR_myserver



RequisitePro: Post - Install 131

Note If you change the name of the default IIS user name in the 
Anonymous User Account dialog box, be sure to specify that name 
at each occurrence of the “IUSR_<server name>” user in this 
document.

17 Click OK twice to return to the Properties dialog box. Click the 
Documents tab. 

18 Be sure the Enable Default Document check box is selected. If 
Default.asp is not on the Default Document list, click Add and 
type Default.asp and click OK. If Default.asp is not at the top of 
the Default Document list, select it and click the up arrow. Click 
OK.

Enable
Default
Document
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Creating a Virtual Directory on Internet Information Services 5.0

1 Start the Microsoft Management Console (MMC). 

Note The default Start menu selections for the MMC are 
Programs/Administrative Tools/Internet Services Manager.

2 Navigate to the ReqWeb directory under the Default Web Site.

3 Right-click on the ReqWeb directory and click Properties. The 
Properties dialog box appears.

4 At the Directory tab, mark the Read check box and clear all the 
other check boxes. 

5 Under Application Settings, click the Create button to create a 
virtual Web directory. 

Read

Application
Settings

Permissions

Create



RequisitePro: Post - Install 133

Note If the Remove button is displayed instead of the Create button, 
click it. The Create button appears.

6 In the Application Name field, type ReqWeb. 

7 Accept the default Application Protection setting of Medium.

8 Click the Configuration button. The Application Configuration 
dialog box appears.

9 Click the App Options tab. Be sure that the Enable session state 
check box is marked.

10 Be sure that the ASP script timeout field is set to at least 90. Click 
OK. 

11 In the Properties dialog box, click the Directory Security tab.

Enable
Session

ASP Script
Timeout

State
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12 In the Anonymous Access and Authentication Control frame, 
click the Edit button to access to display Authentication Methods 
dialog box.

13 Mark the Anonymous access check box and clear the other check 
boxes. 

14 Click the Edit button next to the Account used for anonymous 
access label. The Anonymous User Account dialog box appears.

Allow
Anonymous
Access

Edit
Account Used for
Anonymous
Access

IUSR_myserver
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15 At the Username field, note the IUSR user name. It should be in 
the form IUSR_<server name>. You will use this user name in 
subsequent configuration steps.

Note If you change the name of the default IIS user name in the 
Anonymous User Account dialog box, be sure to specify that name 
at each occurrence of the “IUSR_<server name>” user in this 
document.

16 Click OK twice to return to the Properties dialog box. Click the 
Documents tab. 

17 Be sure the Enable Default Document check box is selected. If 
Default.asp is not on the Default Document list, click Add and 
type Default.asp and click OK. If Default.asp is not at the top of 
the Default Document list, select it and click the up arrow. Click 
OK.

Enable
Default
Document
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Configuring for UNIX Navigator Access

If any of your RequisiteWeb users will access RequisiteWeb 
through the UNIX version of Netscape Navigator, you must use 
Microsoft Management Console (MMC) to disable the HTTP 
Keep-Alives setting for the RequisiteWeb default Web site.

1 Log on to the RequisiteWeb server.

2 Start the Microsoft Management Console (MMC). 

3 In the left pane of the MMC display, right-click on the Default
Web Site virtual directory and click Properties. The Properties 
dialog box appears. 

4 On IIS 4.0, click the Performance tab;
on IIS 5.0, click the Web Site tab.

5 Clear the check box HTTP Keep-Alives Enabled in the Connection 
Configuration frame.

6 Click OK to close the Properties dialog box.

Creating Required Directories on the IIS Server

In order to support RequisitePro projects and documents, you 
must create the following directories on your IIS server:

� c:\Program Files\Rational\RequisitePro\Projects

� c:\Inetpub\wwwroot\ReqWeb\GenDoc

Projects Directory for Storing Project Files

The Projects directory is the recommended location for your 
RequisitePro project subdirectories and files. Refer to the section 
“Accessing Projects from the RequisiteWeb Server” on page 59 for 
more information.

GenDoc Directory for Displaying Documents

In order to dynamically display RequisitePro documents, 
RequisiteWeb creates temporary directories that contain copies of 
the project documents on the IIS server. By default, the 
anonymous IIS user (IUSR_<server name>) does not have 
permission to create directories in the ReqWeb virtual directory. 



RequisitePro: Post - Install 137

Therefore, you must create the GenDoc directory that will contain 
the temporary directories for the documents. In addition, you 
must grant the IUSR_<server name> user permissions to create, 
change, and delete subdirectories and files within that GenDoc 
directory. Refer to the following section for instructions on setting 
permissions.

Setting Directory Permissions on the IIS Server

Note Because FAT drives do not limit access by the default IIS user, you 
do not need to configure security access. If the Security tab is not 
present on the directory properties dialog box, the drive is 
configured as a FAT drive. In this case, skip these procedures.

Required Read Permissions

On both Windows NT 4.0 and Windows 2000 Server, the following 
directories and their contents must provide Read permission for 
anonymous user IUSR_<server name>:

� C:\Inetpub\www\reqweb (and subdirectories)
� C:\program files\rational\common (for licensing)

For instructions on setting permissions, see one of the following:

� “Setting Permissions on IIS 4.0” on page 50
� “Setting Permissions for IIS 5.0” on page 52

Required Change or Modify Permissions

On both Windows NT 4.0 and Windows 2000 Server with an NTFS 
drive,  the following directories and their contents must provide 
Change or Modify permission for anonymous user IUSR_<server 
name>:

� Inetpub\wwwroot\ReqWeb\GenDoc

� c:\Program Files\Rational\RequisitePro\bin

� c:\Program Files\Rational\RequisitePro\samples

� c:\WINNT\TEMP

� c:\TEMP

� c:\Program Files\Rational\RequisitePro\Projects
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For instructions on setting permissions, see one of the following:

� “Setting Permissions on IIS 4.0” on page 50
� “Setting Permissions for IIS 5.0” on page 52

Setting Permissions on IIS 4.0

The following procedure must be applied to each of the target 
directories. (The target directories are listed above in the sections 
“Required Read Permissions” on page 49 and “Required Change or 
Modify Permissions” on page 49.)

1 On the IIS 4.0 server, in the Windows NT Explorer, navigate to 
the target directory on your IIS installation. 

2 Right-click on the target directory and select Properties. The 
directory Properties dialog box appears.

3 Click the Security tab, then the Permissions button. The 
Directory Permissions dialog box appears. 

4 Mark the Replace permissions on subdirectories check box.

5 Click the Add button. 

bsmith Special Access

Replace
Permissions on
Subdirectories

Add button



RequisitePro: Post - Install 139

The Add Users and Groups dialog box appears.

6 Click the Show Users button. Find and highlight the 
IUSR_<server name> user, then click the Add button. 

7 In the Type of Access field, do one of the following:
� select Read (for directories listed in “Required Read 

Permissions” on page 49)
� select Change (for directories listed in “Required Change or 

Modify Permissions” on page 49). 

8 Click the OK button to close the Add Users and Groups dialog box. 
At the Directory Permissions dialog box, you should see the 
IUSR_<server name> user with Change access rights listed. 

<server name>

<server name>\IUSR_<server name>

IUSR_<server name>

Change

Show Users

Add 

button

IUSR
user 

button 

Type of 
Access:
Change 
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9 Click OK to close the dialog box and complete the NT permissions 
change.  Repeat this procedure for the other target directories.

Setting Permissions for IIS 5.0

The following procedure must be applied to each of the target 
directories.  (The target directories are listed above in the sections 
“Required Read Permissions” on page 49 and “Required Change or 
Modify Permissions” on page 49.)

1 On the IIS 5.0 server, navigate to the target directory.

2 Right-click on the target directory and select Properties. The 
target directory Properties dialog box appears.

3 Click the Security tab, then the Add button. The “Select Users, 
Computers, or Groups” dialog box appears. 

<server name>

<server name>\IUSR_<server name>

IUSR_<server name> <server name>
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4 Select the IUSR_<server name> entry on the Name list. This 
IUSR user name was configured for the anonymous user account 
when you created the reqweb virtual directory. 

5 Click Add. Click OK. You return to the target directory Properties 
dialog box.

6 With the IUSR_<server name> entry still selected in the Name 
list, do one of the following:

� mark the Read permissions check box (for directories listed in 
“Required Read Permissions” on page 49)

� mark the Modify permissions check box (for directories listed 
in “Required Change or Modify Permissions” on page 49). 

IUSR_<server name>

Modify
permissions

Allow
inheritable
permissions...
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Accept the other permissions that are associated with the 
Modify option.

7 Mark the Allow inheritable permissions... check box.

8 Click OK. Repeat this procedure for the other target directories.

Granting Launch Permissions for Microsoft Word with IIS 
5.0

RequisiteWeb requires the installation of Microsoft Word on the 
IIS server. With IIS 5.0, RequisiteWeb uses the Distributed 
Component Object Model (DCOM) to launch Microsoft Word. By 
default on IIS 5.0, the anonymous user IUSR_<server name> does 
not have permission to launch Word. Use the procedure below to 
use the Distributed Component Object Model (DCOM) to set 
permissions for launching Word.

Note Do not add the IUSR_<server name> user to the Administrators 
group. This addition creates a security breach for all Web 
applications on the IIS server.
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1 On the Start menu, click Run, and type dcomcnfg. 
The Distributed COM Configuration dialog box appears.

2 On the Applications tab, select Microsoft Word Document on the 
list of applications. (If the entry Microsoft Word Basic appears in 
your DCOM applications list, you will have to repeat this 
procedure for that entry.)
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3 Click the Properties button. The Microsoft Word Document 
Properties dialog box appears.

4 On the Security tab, select Use custom access permissions. 
Click the adjacent Edit button. 

Use custom
access permissions

Security tab

Edit button
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The Registry Value Permissions dialog box appears.

5 Click Add. 

Add
button 
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The Add Users and Groups dialog box appears.

6 Select the IUSR_<server name> anonymous user for 
RequisiteWeb. Click Add. 

7 At the Type of Access field, select Allow Access. Click OK. 

8 At the Registry Value Permissions dialog box, click OK.

9 At the Microsoft Word Document Properties dialog box, select the 
option Use custom launch permissions. Click the adjacent Edit 
button. 

10 At the Registry Value Permissions dialog box, click Add.

11 Select the IUSR_<server name> anonymous user for 
RequisiteWeb. Click Add. 

<server name>

IUSR_<server name>

<server name>\IUSR_<server name>
Type of
access

IUSR
user 
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12 At the Type of Access field, select Allow Launch. Click OK three 
times to close the DCOM dialog boxes. (Repeat this procedure for 
the Microsoft Word Basic entry, if it appears in your DCOM 
application list.)

Building the Web Project Catalog

Before projects are available for the RequisiteWeb clients, they 
must be cataloged on the RequisiteWeb server. The default catalog 
file contains entries for the two Learning Projects.

1 Using a text editor, open the catalog.txt file in the 
C:\Inetpub\wwwroot\ReqWeb directory.

2 Type the full path and RequisitePro project file name (*.rqs).

Note You must use full UNC paths to RQS files in Oracle and SQL 
Server-based projects that are not located on the IIS server.

3 Enter additional project files on successive lines of the text file.

4 Save and close the file.

Accessing Projects from the RequisiteWeb Server

The Projects directory that you created in the section “Creating 
Required Directories on the IIS Server” on page 48 is the 
recommended directory for your projects because you granted 
Change or Modify permissions to that directory.

If you are using Microsoft Access for your RequisitePro project 
database, the project files must be located on the IIS server in 
order for RequisiteWeb to access the project. RequisiteWeb can 
open SQL Server- and Oracle-based projects which are not 
physically located on the IIS server. However, to open these 
projects, the anonymous user IUSR_<servername> must have 
Change or Modify rights for the directory containing the 
RequisitePro RQS project file on the machine where that file is 
located. 

To grant these rights, add the IUSR_<servername> user to the list 
of users with rights to that directory. Give the user a minimum of 
Change or Modify rights. Alternately, you may add the 
IUSR_<servername> user to a group who already has Change or 
Modify rights (or greater) for that directory.



148 Installing Rational Suite

Configuring E-mail Discussions for RequisiteWeb

To configure e-mail for RequisitePro discussions, refer to 
“Configuring E-mail for Discussions” on page 8 in this guide. You 
use the same Rational E-mail Reader session for both 
RequisitePro and RequisiteWeb; however, note the following 
requirements when configuring the Rational E-mail Reader for 
both RequisitePro and RequisiteWeb: 

� You must run the Rational E-mail Reader on a different server 
than the IIS server.

� In order to enable e-mail for RequisiteWeb discussions, you 
must configure discussion e-mail using the SMTP protocol 
option rather than MAPI protocol option in the Rational E-mail 
Reader.

� The E-mail Setup option on the RequisitePro Tools menu does 
not configure e-mail for RequisiteWeb discussions. Use the 
Rational E-mail Reader, as described on page 8, to configure 
e-mail for RequisiteWeb discussions.

Configuring RequisiteWeb for Oracle Database Projects

In order to access RequisitePro projects that are stored in an 
Oracle database using RequisiteWeb, you must configure Oracle 
client software on the IIS server. Refer to the section “Setting Up 
PCs for Oracle Access” on page 21 in this guide. That section 
refers to installation on a client PC; you must perform that 
procedure on the IIS server. 

Starting RequisiteWeb

To access a RequisitePro project in RequisiteWeb:

1 Open your browser.

2 Set the URL address to the full path of the RequisiteWeb virtual 
directory; for example: http://<server name>/reqweb/

3 Navigate to that address. The RequisiteWeb logon page appears.
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4 Select a RequisitePro project from the Project list. If your project 
does not appear on the list, refer to procedure “Building the Web 
Project Catalog” on page 59. 

5 Type your RequisitePro User name and Password and click Log 
on.

Removing RequisiteWeb

This section describes how to remove RequisiteWeb from your 
system. 

Note RequisiteWeb 4.0 SR1 required the use of Distributed COM 
(DCOM) for managing Microsoft Word documents on the IIS 
server. If you created an “Admin” user for use with DCOM and 
Microsoft Word, you should reset the launching user for Word. 
Run dcomcnfg at the Start/Run command line. Select Microsoft 
Word Basic and click Properties. At the Identity tab, select The 
launching user and click OK. At the Distributed COM dialog box, 
select Microsoft Word Document and repeat this change on the 
Identity tab.

Preparing to Remove RequisiteWeb

Prior to removing RequisiteWeb from your system, make sure that 
no one is using RequisiteWeb or any associated files. You will not 
be able to remove files that are in use.

RequisiteWeb installs a new project catalog containing paths to 
new sample projects. Be sure to make a copy of your existing 
catalog.txt file before removing RequisiteWeb. Add your 
previous catalog.txt entries to the new catalog file that is 
installed with the new version of RequisiteWeb. For more 
information, see “Building the Web Project Catalog” on page 59.

To remove RequisiteWeb from the Windows NT system, you must 
have Windows NT administrator privileges on that machine.
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Stop the IIS Web Site Processes

1 Launch Microsoft Management Console (MMC). 

Note The default Start menu path for the MMC is Programs/Windows 
NT 4.0 Option Pack/Microsoft Internet Information 
Server/Internet Service Manager.

2 Select the Default Web Site.

3 Click the Stop button on the toolbar.

4 Right-click on the ReqWeb virtual directory and select Properties. 
The ReqWeb Properties dialog box appears.

5 Click Remove. 

6 Click OK to close the dialog box.

Unload RequisiteWeb Components from Memory

1 At the Start/Run command line, type cmd. 

2 In the MS-DOS window, type the commands indicated in the 
following steps. Answer OK to any messages. The C:\ prompt 
appears after each command is successfully executed.

3 Type net stop iisadmin /y and press Enter.
The following message appears: “The IIS Admin Service was

stopped successfully.”

4 Type mtxstop and press Enter.
The following message appears: “Mtxstop: Stopping all

application server processes...”

5 Type net start w3svc and press Enter.
The following message appears: “The World Wide Web Publishing 
Service was started successfully.”

6 Close the MS-DOS window.
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To Remove RequisiteWeb

Use the Add/Remove Programs function in the Windows NT 
Control Panel to select and remove RequisitePro. After the 
uninstall process is complete, check to see if the ReqWeb directory 
is still present on the server. If so, delete the ReqWeb directory and 
its subdirectories.  

Client Browser Requirements

To access RequisiteWeb from client machines, you must install 
one of the following Web browsers on the client system. No 
additional client installation is required for use of RequisiteWeb.

� Microsoft Internet Explorer 4 or 5
� Netscape Navigator 4 (Win 95/98/NT)
� Netscape Navigator 4 (UNIX)

Removing RequisitePro
This section describes how to remove RequisitePro from your 
system.

Preparing to Remove RequisitePro

Make sure that no one is using RequisitePro and any associated 
files. You will not be able to remove files that are in use.

To remove RequisitePro from a Windows NT system, you must 
have Windows NT administrator privileges on the local machine.
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To Remove RequisitePro

Use the Add/Remove Programs control panel to select and 
remove RequisitePro. The Rational Software Setup removes 
RequisitePro from your system.

Notes Removing RequisitePro does not remove RequisitePro project data 
from your system.

If you are upgrading to a new version of RequisitePro that uses a 
different installation path and you choose to leave the previous 
directories intact, you should delete the .gid files from your former 
help directories (for example, \Rational\RequisitePro 
4.5\help\reqpro.gid). This prevents the new RequisitePro help 
from looking in the old directories for its contents information.
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ClearQuest: Post - Install

This chapter covers upgrading and configuring ClearQuest, and 
setting up ClearQuest Web.

Upgrading ClearQuest
This section describes how to upgrade your existing ClearQuest 
installation. Before you begin the upgrade, read the release notes 
(\\ClearQuest\readme.html) to become familiar with what has 
changed in this release.

Topics covered in this section include:

� “Understanding the Upgrade Process” on page 153
� “Preparing to Upgrade” on page 154
� “Performing a Test Upgrade” on page 155
� “Performing the Production Upgrade” on page 160
� “Upgrading Clients” on page 160
� “Upgrading ClearQuest Web” on page 161

Note If you are using Rational ClearQuest/TeamTest Edition, see the 
Getting Started with Rational ClearQuest TeamTest Guide This 
guide is available as a Portable Document Format (PDF) file in the 
\\ClearQuest\books directory.

Understanding the Upgrade Process
The following steps summarize the upgrade procedure. The 
sections of this chapter describe the steps in detail.

1 Read the ClearQuest release notes (\\Program
Files\Rational\ClearQuest\readme.htm) to learn what has 
changed in this release. 

2 Read this chapter and be sure you understand the upgrade 
procedure before you begin.
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Warning Back up your current schema repository and user databases.

3 Perform a test upgrade.
� Create new, empty vendor databases for your schema repository 

and user databases.
� Install the new version of ClearQuest.
� Use the ClearQuest Maintenance Tool to upgrade your schema 

repository and user databases.
� Unlock your old databases so users can continue to work with 

those databases during the testing period.

4 Perform the upgrade on your production databases.

5 Notify your users of the new database connection information.

Important If you are using multiple products from the Rational Suite, all 
products must be from the same Suite version (installed from the 
same CD-ROM). If you want to upgrade a product from the Suite, 
uninstall all Rational Suite products and install the desired 
products from the newer Suite CD-ROM.

Preparing to Upgrade
The ClearQuest upgrade process upgrades the application and 
your databases. Because upgrading changes the underlying 
structure of your data and can change your schemas, we highly 
recommend the following:

� Do complete backups of your databases.
Having a backup is the only way to be assured that you can 
recover your schemas and user data if something goes wrong 
during the upgrade process.

� Do a test upgrade. 
By testing the upgrade, you can be sure that your data upgrades 
successfully and your customizations work with the new release. 
Testing also gives you the chance to try new functionality in the 
form of Packages (for more information on packages, see the 
release notes).



ClearQuest: Post - Install 155

You should only upgrade your user databases when you 
completely understand the upgrade process and are sure the 
upgrade works with your customizations.

Note Upgrading might fail if you have custom database tables that 
were not created by ClearQuest. For information about upgrading 
if you have custom database tables, read the release notes 
(\\Program Files\Rational\ClearQuest\readme.htm).

Performing a Test Upgrade
We strongly recommend the following steps for performing a test 
upgrade. You should be sure the process works before upgrading 
your production databases.

Database Locking

To upgrade, install the latest version of ClearQuest, then use the 
ClearQuest Maintenance Tool to upgrade your databases. After 
ClearQuest upgrades your data, it locks your original databases. 
When your original databases are locked, you have two options for 
how to proceed with the upgrade:

� You can complete the entire upgrading testing with the original 
databases locked. 
This means that your users will not be able to use ClearQuest 
until the upgrade testing is completed. How long that takes 
depends on the size and complexity of your database and the 
amount of testing you do. If the upgrade is successful, upgrade 
your client installations, and notify users about how to connect 
to the upgraded databases.

� You can unlock your original databases while you test the 
upgrade.
This means that your users can continue to use your current 
version of ClearQuest and continue to enter records while the 
upgrade testing is performed. The only down time for your users 
occurs while the actual database upgrade and unlock procedures 
are being performed. If the upgrade test is successful, you must 
discard the test databases and perform the process again to 
upgrade the most current data.
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To unlock your original schema repository and user databases, 
see “Unlocking Your Original Databases” on page 158.

Upgrade Steps 

The upgrade steps are the same whether you are performing a test 
upgrade or the final production upgrade. We highly recommend 
performing a test run. The following steps assume you are doing a 
test upgrade first.

To perform an upgrade:

1 Install the latest version of ClearQuest on your test machine using 
the Administrator installation.

Follow the installation steps in “Installing ClearQuest for the 
Administrator” on page 161 to install the new version of 
ClearQuest.

2 Create new, empty vendor databases for your schema repository 
and user databases. You should create the new databases in a new 
test directory or on a test server. For information on creating 
vendor databases see:
� “Setting up Microsoft Access” on page 32
� “Setting up SQL Anywhere” on page 33
� “Setting up Microsoft SQL Server Version 6.5” on page 37
� “Setting up Microsoft SQL Server 7” on page 42
� “Setting up the Oracle Server” on page 45

Warning Create empty databases only. Do not use your vendor database 
tools to move or copy the data. ClearQuest updates the data 
structure and moves it into the new databases as part of the 
upgrade process.

3 Notify users to log off from ClearQuest, and shut down your web 
server.

Users should not access ClearQuest during the upgrade process.

Note Some high-end databases give the administrator a tool for logging 
users off from the database. Check your vendor database to see if 
it has such a tool.
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4 Back up your data.

Use your vendor tools to back up your schema repository and user 
databases. Upgrading changes the underlying structure of your 
data and can change your schemas. We strongly recommend you 
have a backup to revert to it if necessary. 

5 Upgrade your schema repository and user databases.

a Run the ClearQuest Maintenance Tool from the Start menu.

b Select the Upgrade schema repository and/or user database(s) 
and click Next.

c Specify the schema repository to upgrade from (your existing 
production schema repository). Click Next.

d To upgrade databases associated to this schema repository, 
select the Upgrade user databases option (recommended).

e Enter the ClearQuest login name and password for a 
ClearQuest user account with Superuser privileges, then click 
Next.

f Select the user databases to upgrade, then click Next.

g Enter the schema repository to upgrade to (the new, empty 
database you created), then click Next.

h For each of your user databases, enter the user database to 
upgrade to (the new, empty databases you created), then click 
Finish.

ClearQuest upgrades your schema repository and user databases 
and notifies you when the process is complete.

6 Determine whether you want to unlock your original databases 
and allow users to continue working with ClearQuest during 
upgrade testing. If you choose to unlock the database, see 
“Unlocking Your Original Databases” on page 158.
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7 Apply packages. 

If you are upgrading from release 1.1 and had applied e-mail rule 
or integration add-ins, you must apply certain upgrade Packages 
to your schemas. For details, see the release notes and the online 
Help for the Package Wizard in the ClearQuest Designer. After 
the packages are applied, you must upgrade the user databases 
associated with that schema.

8 Test the application.

Enter a few test records and move them though your entire state 
model to be sure the upgrade is working correctly.

Unlocking Your Original Databases 

If you choose to allow users to continue using your original 
databases while you test the upgrade, you must unlock the 
database.

Note After you perform the final upgrade, do not unlock your original 
databases. Keeping the original databases locked prevents your 
users from accessing the wrong databases.

1 Start a command window ("DOS prompt"), and change to the new 
ClearQuest home directory. 
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2 To unlock the schema repository, type the command for your 
vendor database:

> installutil unlockschemarepo dbvendor server db
dbologin dbopassword ""

where:

� dbvendor (vendor database) is either: 
� SQL_SERVER for SQL Server databases 
� MS_ACCESS for Microsoft Access 
� SQL_ANYWHERE for Sybase SQL Anywhere 
� ORACLE for Oracle 

� server is either:
� the hostname of the SQL Server database server 
� the SQL Anywhere database server name
� the Oracle SQL*Net alias
� an empty string (““) for Microsoft Access

� db is the database name containing your original schema 
repository for Oracle and SQL Server, or the full path to the 
database for Microsoft Access and SQL Anywhere

� dbologin is the userid that owns the database (use admin for 
Microsoft Access or SQL Anywhere)

� dbopassword is the password to that userid (use admin for 
Microsoft Access or SQL Anywhere)

3 To unlock user databases, repeat the above steps with the 
following exceptions:
� the installutil subcommand to use is unlockuserdb instead of 
unlockschemarepo

� point to the server database containing the original user 
database, not the schema repository



160 Installing Rational Suite

Performing the Production Upgrade 
After you have performed a test upgrade and are comfortable with 
the process, you are ready to upgrade your production schema 
repository and user databases.

1 Determine if you need to perform the upgrade on your production 
database.

a If you chose to leave your production database locked during 
testing and the test upgrade was successful, you can put your 
upgraded databases into production. 

b If you choose to allow users to continue working with your 
production database during test, you need to repeat the upgrade 
process (see “Upgrade Steps” on page 156), but this time you will 
not unlock your original databases.

Note You will need to create new target databases before repeating the 
upgrade steps for production databases.

2 Inform users of the new connection information to use when 
upgrading their client installations of ClearQuest.

Upgrading Clients
Each client installation should be upgraded by uninstalling the 
current ClearQuest installation, installing the latest version of 
ClearQuest (see “Installing ClearQuest for End-users” on 
page 165), and connecting to the newly upgraded databases. 

Note Uninstalling the current version does not delete your databases or 
license information.

After upgrading, users who had enabled e-mail notification must 
reenable it. To do this:

1 Choose View > E-mail Options. This opens the E-mail Setup 
dialog.

2 Select Enable E-mail Notification.

3 Select either SMTP or MAPI.
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4 If you entered SMTP:
� Enter the SMTP host address of your mail server. 
� Enter your e-mail address. 
� Click Finish.

5 If you entered MAPI:
� Choose a MAPI profile from the list.
� Click Finish.

Upgrading ClearQuest Web
To upgrade ClearQuest Web:

1 If you have not done so already, shut down your web server.

2 Uninstall the current version and install the new version of 
ClearQuest on your Web server. See “Installing ClearQuest for the 
Administrator” on page 161.

3 Repeat all the steps in “Setting up ClearQuest Web” on page 173.

4 Restart your web server.

Installing ClearQuest
This section describes how to install ClearQuest and covers the 
following topics:

� “Installing ClearQuest for the Administrator” on page 161
� “Installing ClearQuest for End-users” on page 165

Installing ClearQuest for the Administrator

Before installing ClearQuest on client machines you must install 
it on the administrator’s machine, set up licensing, and set up 
your schema repository and user databases.

If you are using an Oracle database, install the Oracle client 
software before installing ClearQuest. See “Setting up the Oracle 
Server” on page 45 for more information.
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To install ClearQuest for administrators: 

1 Load the ClearQuest CD-ROM. 

2 If the setup program does not run automatically, navigate to the 
top level directory of the CD-ROM and double-click setup.exe. 

The Rational Software Setup wizard prompts you through the 
ClearQuest installation.

3 If you are evaluating ClearQuest, choose the Evaluator 
installation. Otherwise, choose the Administrator installation.

4 Launch the Licence Administrator to enter your ClearQuest 
licenses. Follow the instructions on your License Certificate and in 
the online Help for the License Key Administrator.

Creating ClearQuest Databases

After you install ClearQuest, you must create the ClearQuest 
databases (schema repository and user databases). Initially you 
can create a sample user database to use while you familiarize 
yourself with the product. You can create your production user 
databases later.

If you chose the Evaluator installation, Microsoft Access 
databases are created for you automatically. If you chose the 
Administrator installation, follow these steps to create ClearQuest 
databases:

1 Launch the ClearQuest Maintenance Tool (Start > Programs > 
Rational ClearQuest > ClearQuest Maintenance Tool). 

Note The first time you launch ClearQuest, the Maintenance Tool runs 
automatically.

2 Select Create a new schema repository and click Next.
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3 Select the vendor database you plan to use, enter the properties 
appropriate for that vendor, then click Next. Save this information 
for clients to use when they connect to the databases. The 
information to enter is as follows:
� MS_ACCESS

� Enter a name for the schema repository. Enter the entire path 
to the file using a UNC style path. For example:

\\DevServer\ProjectShare\CQ_DBS\schema_repo.mdb

You can browse to the directory where you want to create the 
database. Be sure to browse using the Network Neighborhood 
to preserve the UNC style path name.

� SQL_ANYWHERE
� Enter a name for the schema repository. Enter the entire path 

to the file using a UNC style path. For example:

\\DevServer\ProjectShare\CQ_DBS\schema_repo.mdb

You can browse to the directory where you want to create the 
database. Be sure to browse using the Network Neighborhood 
to preserve the UNC style path name.

� Enter the name of the database server.
� Enter the protocols used to communicate with the SQL 

Anywhere server.
� Enter the database host name. The database host machine 

must be visible to the client machines via network share and 
via one or more of the communication protocols. For TCP/IP, 
this can also be the IP address.

� SQL_SERVER
� Enter an SQL Server database name for the database that will 

contain the schema repository. 
� Enter the name of the database server.
� Enter the database owner (DBO or Administrator) login.
� Enter the password for the database owner (DBO or 

Administrator) login.
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� Enter the general purpose or read/write login.
� Enter the password for the general purpose or read/write user 

login.
� Enter the schema repository or read-only user login.
� Enter the password for the schema repository or read-only 

login.
� ORACLE

� Enter the TNS name (SQL*Net Alias pointing to the Oracle 
instance).

� Enter the Oracle login you created for the schema respository.
� Enter the password for the login.

Note All ClearQuest users must use the same SQL*Net Alias (TNS 
name), Database Instance (system ID or SID), TCP/IP protocol, 
and Host Name (Oracle server machine).

4 We recommend that you create a sample database using one of the 
provided schemas. Select a schema, give the sample database a 
name, then click Next.

5 If you created a sample database, you must select a vendor and 
enter the database properties. When you are finished, click Next.

6 You can save these settings as a default profile, or click Finish to 
complete the setup. The profile records the entries you made and 
saves them to a file (the default name is cqprofile.ini). Clients 
can connect to the database by using the profile file instead by 
typing the connection information.

You have completed Step 2 of the steps described in 
“Understanding the ClearQuest Install Process” on page 31. 
Return to that page to determine the next step.
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Installing ClearQuest for End-users
ClearQuest must be installed on each end-user machine. When 
ClearQuest is installed and connected to the database, users can 
enter and modify records.

Note It is also possible to allow users to install ClearQuest from a 
network location, for more information see Installing Rational 
ClearQuest.

To install ClearQuest for end-users: 

1 Load the ClearQuest CD-ROM. 

2 If the setup program does not run automatically, navigate to the 
top level directory of the CD-ROM and double-click setup.exe. 

The Rational Software Setup wizard prompts you through the 
ClearQuest installation.

3 Choose the Client installation. 

If you will be doing schema development, select the Administrator 
installation, which includes additional administrative tools.

4 Launch the Licence Administrator to enter your ClearQuest 
licenses.

Connecting to ClearQuest Databases

After installing ClearQuest as a client user, the first time you run 
ClearQuest, client users need to connect to an existing schema 
repository. You must provide them database properties 
information needed. 

You can create a database profile for client users to use to connect 
to the schema repository, see Step 6 of “Connecting to ClearQuest 
Databases” on page 165.
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The following instructions apply to client users who need to 
connect to a schema repository:

1 Launch the ClearQuest Maintenance Tool (Start > Programs > 
Rational ClearQuest > ClearQuest Maintenance Tool). 

Note The first time you launch ClearQuest, the Maintenance Tool runs 
automatically.

2 Select Connect to Existing schema repository and click Next.

3 Select the vendor database that you plan to use, enter the 
properties appropriate for that vendor, then click Next. 

Enter the information provided by your administrator, or, if your 
ClearQuest administrator created a user profile file (usually called 
cqprofile.ini) that includes the database information you need, 
click Load Profile to navigate to the profile file. 

If you did not create a profile for client users, they must enter the 
following information: 

� MS_ACCESS
� Enter the entire path to the schema repository using a UNC 

style path. For example:

\\DevServer\ProjectShare\CQ_DBS\schema_repo.mdb

You can browse to the directory containing the database. Be 
sure to browse using the Network Neighborhood to preserve 
the UNC style path name.

� SQL_ANYWHERE
� Enter the path to the schema repository using a UNC style 

path. For example:

\\DevServer\ProjectShare\CQ_DBS\schema_repo.mdb

You can browse to the directory containing the database by 
using Network Neighborhood, which preserves the UNC style 
path name.

� Enter the name of the database server.
� Enter the protocols used to communicate with the SQL 

Anywhere server.
� Enter the database host name.
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� SQL_SERVER
� Enter an SQL Server database name for the database 

containing the schema repository. 
� Enter the name of the database server.
� Enter the schema repository or read-only user login.
� Enter the password for the schema repository or read-only 

login.
� ORACLE

� Enter the SQL*Net Alias (alias pointing to the Oracle 
instance).

� Enter the Oracle login created for the schema respository.
� Enter the password for the login.

4 Click Finish to complete the connection.

Enabling E-mail Notification

After installing ClearQuest, users must enable e-mail notification 
if they want to receive automatic e-mail messages from 
ClearQuest. To do this:

1 Launch ClearQuest (Start > Programs > Rational ClearQuest > 
Rational ClearQuest).

2 Choose View > E-mail Options. This opens the E-mail Setup 
dialog.

3 Select Enable E-mail Notification.

4 Select either SMTP or MAPI

5 If you entered SMTP:
� Enter the SMTP host address of your mail server. 
� Enter your e-mail address. 
� Click Finish.

6 If you entered MAPI:
� Choose a MAPI profile from the list.
� Click Finish.
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After You Install ClearQuest
This section describes what to do after you install and configure 
ClearQuest and covers the following topics:

� “Setting up Configuration Management Integrations” on 
page 168

� “Setting up Record Submission via E-mail” on page 172
� “Installing Crystal Reports” on page 172

Setting up Configuration Management Integrations
You can integrate ClearQuest with software configuration 
management tools to create a complete change management 
system. ClearQuest relates change requests directly to changes in 
your evolving code base, allowing you to answer such questions as: 

� Which defects have been fixed in one release but not in another?
� Which defects can be attributed to a specific release?

Integrating with Rational ClearCase

The integration of ClearQuest and ClearCase allows you to 
associate change requests with one or more ClearCase elements. 
To set up the integration:

1 Within ClearCase, use the ClearQuest Integration Configuration 
tool located on the ClearCase Administration menu. The online 
Help describes how to set up and use the integration.

2 Within ClearQuest, apply the ClearCase package to a schema to 
enable the integration. For more information on installing 
packages, see the Administering Rational ClearQuest guide.

Note If you have a previous installation of ClearQuest that used the 
ClearCase add-in, select the Upgrade 1.0 version of the ClearCase 
package. If this is the first time you are installing the integration, 
use the 1.0 version of the package.
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Unified Change Management (UCM)

To use the ClearQuest/ClearCase UCM integration, consult the 
following documentation:

� To set up the ClearCase part of the integration and to learn 
about the UCM process, see the Managing Software Projects 
with ClearCase guide provided with ClearCase.

� To set up the ClearQuest part of the integration, see Appendix 
B, “Enabling ClearQuest for Unified Change Management,” in 
the Administering Rational ClearQuest guide.

Integrating with Microsoft Visual SourceSafe

The ClearQuest/Visual SourceSafe integration adds Visual 
SourceSafe fields to a record type you choose, and the Visual 
SourceSafe tab to the record type form. 

To enable the integration:

1 Install ClearQuest and Visual Studio according to the normal 
procedure for each product.

2 Set up your ClearQuest schema repository and user databases.

3 Use the ClearQuest Designer to add the Visual SourceSafe 
integration package to your schema using the Package Wizard.

a Launch the ClearQuest Designer from the Start menu

b Check out the schema you want to use with the integration.

c Install the Visual SourceSafe package by choosing Package > 
Package Wizard. Click More Packages to locate the 
VisualSourceSafe package, then click OK.
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d Select the Visual SourceSafe package and click Next.
Note If you have a previous installation of ClearQuest that used the 

Visual SourceSafe add-in, select the Upgrade 1.0 version of the 
package. If this is the first time you are installing the integration, 
use the 1.0 version.

e Select the record types to be enabled by the package, then click 
Finish.
For more information on packages, consult the Administering 
Rational ClearQuest guide or the Help for the ClearQuest 
Designer.

4 Check in the schema.

5 Upgrade your user database to the new version of the schema.

Important We recommend that you first upgrade a test database and 
familiarize yourself with the integration features before 
upgrading your production database.

6 In ClearQuest, create a query that your end users can use to find 
the records you want to associate to projects in Visual SourceSafe.

7 On each client that wants to use the integration, launch the 
ClearQuest Visual Source Safe tool (cqvss.exe) located in the 
ClearQuest home directory. You can drag a copy of cqvss.exe to the 
desktop to create a shortcut to it.
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8 Log in and select the Visual SourceSafe database you want to use.

9 From the ClearQuest tools for Visual SourceSafe screen, select 
Setup Tool.

10 In the Visual SourceSafe Integration dialog, select the ClearQuest 
query you want to use and click OK.



172 Installing Rational Suite

The installation of the integration is complete. To begin using the 
integration, see the Help for the ClearQuest Visual SourceSafe 
tool.

Setting up Record Submission via E-mail
To enable your users to submit and modify records via e-mail, you 
configure the Rational E-mail Reader. The E-mail Reader is an 
e-mail processing tool that parses submitter’s e-mail and commits 
new records or changes to the database. The E-mail Reader 
requires a dedicated e-mail account to be assigned for parsing 
records.

Use the Rational E-mail Reader to designate one machine to be 
the Rational Mail Server. We recommend that the Rational Mail 
Server run on the same machine as your ClearQuest database(s) 
to ensure that the service is always available. 

The E-mail Reader (mailreader.exe) is automatically installed in 
the \Rational\ common directory. You can drag a copy of the 
mailreader.exe to the desktop to create a shortcut to it. You can 
then follow the instructions in the online Help (located in 
\Rational\common\mailreader.hlp) on how to set up the E-mail 
Reader. For more information on the E-mail Reader see 
“Administering ClearQuest E-mail” in the Administering Rational 
ClearQuest Guide.

Installing Crystal Reports
If you want to customize the defect reports that ship with 
ClearQuest, you must install Crystal Reports Pro 6.0. This 
software comes on a separate CD in your Rational ClearQuest 
software kit.

To install Crystal Reports, use the Crystal Reports installation 
directions that come with the CD.

Note Users who will not be editing existing or creating new report 
formats, do not need to install Crystal Reports.
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Setting up ClearQuest Web
This section describes how to set up the ClearQuest Web server for 
both Microsoft Internet Information Server version 4 (IIS 4) for 
Windows NT, and Windows 2000 Server, which includes Microsoft 
Internet Information Server version 5 (IIS 5).

This section covers the following topics:

� “Understanding the ClearQuest Web Installation Process” on 
page 173

� “Setting up ClearQuest Web for IIS 4” on page 174
� “Setting Up ClearQuest Web for IIS 5” on page 186
� “Enabling E-mail Notification for Web Clients” on page 202
� “Providing ClearQuest Web Information to Web Clients” on 

page 203

Understanding the ClearQuest Web Installation Process
The following are special considerations for using ClearQuest 
Web:

� ClearQuest Web does not support Microsoft Access databases. 
� Your browser must have cookies enabled when using 

ClearQuest Web.
� Make sure your web server is set to display 256 colors. This is 

necessary for generating charts.

To install and configure ClearQuest Web on your Windows server, 
you must complete the following tasks:

1 If you are using Windows NT, verify that Windows NT 4.0 Option 
Pack, which includes Microsoft Internet Information Server 4.0 
(IIS), is installed on your web server.

2 Install ClearQuest on the Web server. See “Installing ClearQuest 
for the Administrator” on page 161.

Note We recommend, for improved performance, security, and 
reliability, that the Web server machine and the database server 
machine be two different machines, each with its software 
installed onto an NTFS partition. 
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3 Follow the instructions in this chapter to configure Microsoft 
Internet Information Server to serve the ClearQuest Web pages.

4 Configure the web server so that web clients can take advantage 
of ClearQuest’s e-mail notification feature.

5 Provide users with the path to ClearQuest Web.

Note You can copy the documentation CD to the Web server if you 
choose.

Setting up ClearQuest Web for IIS 4
This section is for users using Windows NT (Workstation or 
Server) with IIS 4. If you are using Windows 2000 Server, which 
has IIS 5 as an embedded component, see “Setting Up ClearQuest 
Web for IIS 5” on page 186.

This section contains the following:

� “Setting up an Anonymous User Account for IIS 4” on page 174
� “Creating a Cache Directory for IIS 4” on page 177
� “Configuring IIS 4.0 to Serve ClearQuest Web Pages” on 

page 177

Setting up an Anonymous User Account for IIS 4

Create an anonymous user account for IIS to use when it serves 
the ClearQuest pages. If you are using an SQL Server database, 
the anonymous user account should be known in the domain that 
contains the ClearQuest database, and should have full access to 
that database.

Create the Anonymous User Account

Create the anonymous user account as follows:

1 Log on as a Windows NT administrator.

2 If the web server belongs to a Windows NT domain, ask your 
Windows NT system administrator to create a domain user and 
provide you with the user name and password. (If not, go to Step 
4.)
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3 Run the User Manager (Start > Programs > Administrative Tools 
> User Manager), select Policies > User Rights, select the Show 
Advanced Rights checkbox, and give this user the following 
privileges on the Web server: 
� Access this computer from network 
� Log on locally 
� Log on as a service
Also provide access to any other resources used by your hook 
scripts such as mail accounts or auxiliary databases. Skip to Step 
6.

4 If the web server operates in stand-alone mode (does not belong to 
a Windows NT domain), use the default anonymous account 
created by the IIS installation (IUSR_<machine_name>) for Step 5. 

5 Run the User Manager (Start > Programs > Administrative Tools 
> User Manager), select Policies > User Rights, select the Show 
Advanced Rights checkbox, and give the IUSR_<machine_name 
account the following privileges: 
� Access this computer from network 
� Log on locally 
� Log on as a service
Also provide access to any other resources used by your hook 
scripts such as mail accounts or auxiliary databases.

6 Verify that the anonymous user account has a specific, known 
password (you will need it later). Make sure there are no password 
policies in effect such as “User must change password at next 
login,” because these prevent the anonymous user account from 
functioning properly.
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Set up the Registry Key Access Privileges

Give the anonymous user account full access privileges to the 
HKEY_LOCAL_MACHINE\Software\Rational Software\ClearQuest 
registry key as follows.

1 Select Run  from the Start menu and type REGEDT32 to run the 
REGEDT32 program.

2 In the HKEY_LOCAL_MACHINE MDI window, select 
Software\Rational Software\ClearQuest.

3 On the Registry Editor menu bar, select Security > Permissions.

4 In the Registry Key Permissions dialog box, select the anonymous 
user. For the type of access, select Full Control. Select Replace 
Permission on Existing Subkeys so that the anonymous user can 
update the entire registry tree below ClearQuest.

5 Close the REGEDT32 program.

Set up Read Access Permission

Give the anonymous user account read access permission to the 
directory tree containing the ClearQuest web files (this is the WWW 
directory in the ClearQuest installation area). 

1 Use the Windows Explorer to locate the directory in which you 
installed ClearQuest. Right-click the www directory and select 
Properties from the shortcut menu. 

2 On the Properties dialog box, click the Security tab. Click 
Permissions and select Replace Permissions on Subdirectories. 

Note If you installed ClearQuest onto a FAT partition instead of an 
NTFS partition, you will not see a Security tab and can skip this 
step.

3 On the Directory Permissions dialog box, click Add.

4 Select the anonymous user account.
� If you chose the default local anonymous username in Step 2, 

set List Names From to the name of the local machine, click 
Show Users below the Names list, then select the 
IUSR_machinename account from the Names list.
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�  If you are using a domain account, select that domain in the 
List Names From field, click Show Users, and select the 
domain account from the Names list. 

5 Click Add. 

6 Set Type of Access to Read. 

7 Click OK.

Creating a Cache Directory for IIS 4

Create a cache directory in the ClearQuest Web directory 
hierarchy:

1 At the top of the web directory tree, there should be a directory 
called cache. If a cache directory does not exist, create one under 
the ClearQuest WWW directory. For example:

c:\Program Files\Rational\ClearQuest\WWW\cache

2 Give the anonymous user full access to everything in this directory 
tree.

Configuring IIS 4.0 to Serve ClearQuest Web Pages

This section describes how to configure the IIS 4.0 web server to 
serve ClearQuest Web pages.

� “Create a Virtual Directory for IIS 4” on page 178
� “Edit the Properties of the Virtual Directory for IIS 4” on 

page 181
� “Edit the Properties of the Cache Directory for IIS 4” on 

page 185
� “Edit the Properties of the Images Directory for IIS 4” on 

page 185
� “Restart the Web Server for IIS 4” on page 185

Note If the Internet Service Manager is not available, you must install 
the Windows NT 4.0 Option Pack. When installing the Option 
pack, be sure to explicitly select the Internet Service Manager.
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Create a Virtual Directory for IIS 4

The first step in setting up IIS 4.0 is to create a virtual directory 
for the web. To create this directory, you use the Internet Service 
Manager program (Microsoft Management Console) that comes 
with IIS 4.0.

1 Start the Microsoft Management Console program (Internet 
Service Manager). 

Start > Programs > Windows NT 4.0 Option Pack > Microsoft 
Internet Information Server > Internet Service Manager

2 In the Navigator window, right-click Default Web Site, then click 
New > Virtual Directory from the shortcut menu.

 In the Navigator window,
right-click Default Web

Site.
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3 In the New Virtual Directory Wizard, type an alias name, such as 
CqWeb. Do not use a “/” character in the alias name.

Type an alias name

Click Next
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4 Type or browse to the name of the directory containing the 
ClearQuest Web files. These files are located in the WWW 
subdirectory of the ClearQuest installation directory. For 
example:

C:\Program Files\Rational\ClearQuest\WWW

5 Select the default permissions for the virtual directory:

Type the name of the
directory containing the

ClearQuest Web file

Click Next

Select 
Allow Execute Access 
(includes Script Access)

Click Finish



ClearQuest: Post - Install 181

Edit the Properties of the Virtual Directory for IIS 4

Edit the properties of the virtual directory as follows: 

1 In the Microsoft Management Console left pane, navigate to the 
virtual directory you created earlier. 

2 Right-click on the virtual directory and select Properties from the 
shortcut menu. 

3 In the Properties dialog box, click the Virtual Directory tab. 

Clear all of these boxes

Select Execute
(including script)

Check this option if other
applications are running

on the same server
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4 In the same Properties dialog box, click Configuration. In the 
Application Configuration dialog, click the App Mappings tab.

5 In the same Application Configuration dialog box, click the App 
Options tab.

Verify that Cache ISAPI
applications is selected.

Verify that .asa and .asp
are mapped to asp.dll
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6 Click OK to return to the Properties dialog box.

7 In the Properties dialog box, click the Documents tab.

8 In the same Properties dialog box, click the Directory Security 
tab. In the Anonymous Access and Authentication Control, click 
Edit to open the Authentication Methods dialog box.

Select Enable session
state and set the timeout.

Select Enable parent
paths.

If necessary, add the
Default.asp document to

the list of documents...

Click to add the 
Default.asp 
document to the 
list

then remove any other
documents and select

Default.asp as the
default
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9 Define the anonymous user account: 

Note ClearQuest Web does not work if Enable Automatic Password 
Synchronization is selected.

10 Click OK.

11 Type the password in the Confirm Password dialog box and click 
OK. 

12 Click OK again to close the Properties dialog.

Select Allow
Anonymous Access

Important: Verify that
Windows NT

Challenge/Response
is NOT selected.

If the box has a check
mark, be sure to clear it.

Then click Edit 
to define the 
anonymous user 
account

Clear Enable Automatic
Password

Synchronization
and type the password

Select the anonymous user
account created on
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Edit the Properties of the Cache Directory for IIS 4

Edit the properties of the cache subdirectory as follows: 

1 In the Microsoft Management Console left pane, navigate to the 
cache directory under the virtual directory name. 

2 Right-click the cache directory.

3 Click Properties from the shortcut menu. 

4 In the Properties dialog box, click the Directory tab. 

5 For Access Permissions, select only Read. Verify that no other 
options are selected.

6 For Permissions, select None. 

7 Click OK. 

Edit the Properties of the Images Directory for IIS 4

Edit the properties of the images subdirectory as follows:

1 In the Navigator window of the Microsoft Management Console, 
expand the directory tree of the Default Web Site until you locate 
the images directory under your alias name. 

2 Right-click the images directory. 

3 Click Properties from the shortcut menu. 

4 In the Properties dialog box, click the Directory tab.

5 For Access Permissions, select only Read. Verify that no other 
options are selected. 

6 For Permissions, select None. 

7 Click OK. 

Restart the Web Server for IIS 4

Close the Microsoft Management Console, saving your console 
settings, then restart the web server.

You have completed installing and configuring the ClearQuest 
web server for IIS 4.
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Setting Up ClearQuest Web for IIS 5
This section describes how to set up the ClearQuest Web server for 
Windows 2000 Server, which includes Microsoft Internet 
Information Server version 5 as an embedded component. If you 
are using Windows NT, see “Setting up ClearQuest Web for IIS 4” 
on page 174.

This section contains the following:

� “Setting up an Anonymous User Account for IIS 5” on page 186
� “Creating a Cache Directory for IIS 5” on page 190
� “Configuring IIS 5 to Serve ClearQuest Web Pages” on page 191

Setting up an Anonymous User Account for IIS 5

Create an anonymous user account for IIS to use when it serves 
the ClearQuest pages. If you are using an SQL Server database, 
the anonymous user account should be known in the domain that 
contains the ClearQuest database, and should have full access to 
that database.

Create the Anonymous User Account

Create the anonymous user account as follows:

1 Log on as a Windows 2000 administrator.

2 If the web server belongs to a Windows domain, ask your Windows 
system administrator to create a domain user and provide you 
with the user name and password. (If not, go to Step 4.)

3 For this domain user, click Start > Programs > Administrative 
Tools > Local Security Policy, select Local Policies > User Rights 
Assignment, and use the Add button to grant this user the 
following privileges on the Web server: 
� Access this computer from network
� Log on as a service
� Log on locally 
Also provide access to any other resources used by your hook 
scripts, such as mail accounts. (Go to Step 6.)
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4 If the web server operates in stand-alone mode (does not belong to 
a Windows NT domain), use the default anonymous account 
created by the IIS installation (IUSR_<machine_name>). Click Start 
> Programs > Administrative Tools > Local Security Policy, select 
Local Policies > User Rights Assignment, and use the Add button 
to grant this user the following privileges on the Web server: 
� Access this computer from network
� Log on as a service
� Log on locally 
Also provide access to any other resources used by your hook 
scripts, such as mail accounts. 

5 Verify that the anonymous user account has a specific, known 
password (you will need it later). Make sure there are no password 
policies in effect such as “User must change password at next 
login,” because these prevent the anonymous user account from 
functioning properly.

Set up Registry Key Access Privileges

Give the anonymous user account full access privileges to the 
HKEY_LOCAL_MACHINE\Software\Rational Software\ClearQuest 
registry key as follows.

1 Select Run  from the Start menu and type REGEDT32 to run the 
REGEDT32 program.

2 In the HKEY_LOCAL_MACHINE MDI window, select 
Software\Rational Software\ClearQuest.

3 On the Registry Editor menu bar, select Security > Permissions.

4 In the Registry Key Permissions dialog box, select the anonymous 
user. For the Permissions, select Full Control. 

5 Select Allow inheritable permissions.
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6 Close the REGEDT32 program.

Select Allow
inheritable
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Set up Read Access Permission

Give the anonymous user account read access permission to the 
directory tree containing the ClearQuest web files (this is the WWW 
directory in the ClearQuest installation area). 

1 Use the Windows Explorer to locate the directory in which you 
installed ClearQuest. Right-click the www directory and select 
Properties from the shortcut menu. 

2 On the Properties dialog box, click the Security tab and select 
Allow inheritable permissions. 

Note If you installed ClearQuest onto a FAT partition instead of an 
NTFS partition, you will not see a Security tab and can skip this 
step.

3 On the Security tab, click Add.

Select Allow
inheritable
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4 Select the anonymous user account.
� If you chose the default local anonymous username in Step 2, 

set Look in to the name of the local machine, then select the 
IUSR_machinename account from the Name list.

�  If you are using a domain account, select that domain in the 
Look in field, and select the domain account from the Name 
list. 

5 Click Add, then click OK.

6 On the Security tab, in the Permissions section, select the 
checkbox to allow Read, then click OK.

Creating a Cache Directory for IIS 5

Create a cache directory in the ClearQuest Web directory 
hierarchy:

1 At the top of the web directory tree, there should be a directory 
called cache. If a cache directory does not exist, create one your 
ClearQuest WWW directory. For example:

c:\Program Files\Rational\ClearQuest\WWW\cache

2 Right-click the cache directory to see its properties.

3 On the Properties dialog box, click the Security tab.

4 In the Permissions section, select the checkbox to allow Full 
Control.
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Configuring IIS 5 to Serve ClearQuest Web Pages

This section describes how to configure the IIS 5 web server to 
serve ClearQuest Web pages.

� “Create a Virtual Directory for IIS 5” on page 192
� “Edit the Properties of the Virtual Directory for IIS 5” on 

page 195
� “Editing the Properties of the Cache Directory for IIS 5” on 

page 200
� “Edit the Properties of the Images Directory for IIS 5” on 

page 200
� “Restart the Web Server for IIS 5” on page 201
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Create a Virtual Directory for IIS 5

Create a virtual directory for the web as follows. 

1 Start the Internet Services Manager. 

Start > Programs > Administrative Tools > Internet Services 
Manager

2 In the Navigator window, right-click Default Web Site.

3 On the shortcut menu, click New > Virtual Directory.

4 Click Next when the Virtual Directory Creation Wizard appears.

 In the Navigator
window, right-click
Default Web Site.
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5 Type an alias name, such as CqWeb. Do not use a “/” character in 
the alias name. Then click Next.

6 Type or browse to the name of the directory containing the 
ClearQuest Web files. These files are located in the WWW 
subdirectory of the ClearQuest installation directory. For 
example:

C:\Program Files\Rational\ClearQuest\WWW
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7 Clear Read, clear Run scripts, and select Execute. Then click 
Next.

8 Click Finish to complete the Wizard.

Type (or browse to)
the directory

containing the
ClearQuest Web file

Then click Next

Then click Next

Select Execute,
and verify that nothing

else is selected
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Edit the Properties of the Virtual Directory for IIS 5

Edit the properties of the virtual directory as follows: 

1 In the Internet Information Services left pane, navigate to the 
virtual directory you created earlier. 

2 Right-click on the virtual directory and select Properties from the 
shortcut menu.

3 In the Properties dialog box, click the Virtual Directory tab. 

Verify that Scripts and
Executables

is selected
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4 In the same Virtual Directory tab, click Configuration. In the 
Application Configuration dialog, click the App Mappings tab.

Verify that Cache ISAPI
applications is selected.

Verify that .asa and .asp
are mapped to asp.dll
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5 In the same Application Configuration dialog box, click the App 
Options tab.

Select Enable session
state and set the

timeout interval

Select Enable parent

Click OK
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6 In the Properties dialog box, click the Documents tab.

If necessary, add the
Default.asp document to

the list of documents...

Click to add the 
Default.asp 
document to the 
list

then remove any other
documents and select

Default.asp as the
default
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7 In the same Properties dialog box, click the Directory Security 
tab. In the Anonymous Access and Authentication Control, click 
Edit to open the Authentication Methods dialog box.

8 Define the anonymous user account: 

9 Click OK.

10 Type the password in the Confirm Password dialog box, then click 
OK. 

11 Click OK, then click OK again to close the Properties dialog.

Select Allow
Anonymous Access

Then click Edit 
to define the 
anonymous user 
account

Clear Allow IIS to
control password,

and type the password

Select the anonymous user
account created on
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Editing the Properties of the Cache Directory for IIS 5

Edit the properties of the cache subdirectory as follows: 

1 In the Internet Information Services left pane, navigate to the 
cache directory under the virtual directory name. 

2 Right-click the cache directory.

3 Click Properties from the shortcut menu. 

4 In the Properties dialog box, click the Directory tab. 

5 Select the Read check box. Verify that no other options are 
selected.

6 For Execute Permissions, select None. 

7 Click OK. 

Edit the Properties of the Images Directory for IIS 5

Edit the properties of the images subdirectory as follows:

1 In the Navigator window of Internet Information Services, expand 
the directory tree of the Default Web Site until you locate the 
images directory under your alias name. 

2 Right-click the images directory. 

3 Click Properties from the shortcut menu. 
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4 In the Properties dialog box, click the Directory tab.

5 Select the Read check box. Verify that no other options are 
selected.

6 For Execute Permissions, select None.

7 Click OK. 

Restart the Web Server for IIS 5

Close Internet Information Services, saving your console settings, 
then restart the web server.

You have completed installing and configuring the ClearQuest 
web server for IIS 5.

Select Read, and
verify that the others

are not selected

For Execute
Permissions,
select None
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Enabling E-mail Notification for Web Clients
ClearQuest clients use e-mail notification according to the 
business rules of your schema. To extend e-mail notification 
support to users of the web client, perform the following steps. 

1 Copy the code below into a text editor.

REGEDIT4

[HKEY_USERS\.DEFAULT\Software\Rational Software\ClearQue
st\<version_no>\SendMail]
"MailTransport"="Protocol"
"MAPIProfile"="MyMAPIProfile"
"SendActive"=dword:00000001
"SMTPHost"="MyMailHost"
"RealName"="Web Server On \\\\MyWebServerMachine"
"ReplyTo"="MyGenericReturnAddress@MyDomainName"

The <version_no> number is the current ClearQuest release 
number. If you have a service pack release (for example 1.1 
Service Pack 1), enter the release number portion only (in this 
example, just 1.1).

2 Edit the pertinent entries (MailTransport, MAPIProfile,

SMTPHost, RealName, and ReplyTo) of the text in step 1 so that 
� Protocol is either SMTP or MAPI
� MyMAPIProfile is the name of your MAPI profile (this value is 

ignored if MailTransport is set to anything other than MAPI)
� MyMailHost is the name of your mail host computer if you are 

using SMTP
� MyWebServerMachine is the name of your web server
� MyGenericReturnAddress@MyDomainName is the email address 

for receiving e-mail notification

3 Save the file.

4 Import the text file into the Registry Editor (select Registry > 
Import Registry File).
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Providing ClearQuest Web Information to Web Clients
To enable your users to access ClearQuest over the web, tell them 
to enter the URL:

http://<host>/<alias>

where <host> is the host name of the ClearQuest Web server 
machine, and <alias> is the directory containing the ClearQuest 
Web files.
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Rational Rose RealTime: Post - Install

This chapter describes how to test the environment of Rational 
Rose RealTime. 

Note If you just want to construct UML models and not execute them, 
you needn't read this chapter.

Testing Your Environment
You must have Microsoft Visual C++ 5.0 or 6.0 installed on your 
system and configured to be run from the DOS prompt to make 
use of the code generation and execution capabilities of Rational 
Rose RealTime.

The following instructions help you determine whether you have 
Visual C++ properly installed and configured on your system.

To perform testing on your environment:

1 Open a Windows NT command prompt. From the Windows Start 
menu, select Start > Programs > Command Prompt.

2 Type nmake, then press Enter.

3 Type cl, then press Enter.

If your environment is correctly configured, then these two 
applications should report errors similar to the ones below:

C:\>nmake
Microsoft (r) Program Maintenance Utility
Version 6.00.8168.0
Copyright (c) Microsoft Corp 1988-1998. All rights
reserved.
NMAKE = fatal error B1864: MAKEFILE not found and no
target specified
Stop.
C:\>cl
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Microsoft (r) 32-bit C/C++ Optimizing Compiler
Version 12.00.8168 for 80x86
Copyright (c) Microsoft Corp 1984-1998. All rights
reserved.
Usage = cl { option... } filename... { /link
linkoption... }

If your environment is NOT properly configured, then you will see 
an error similar to this one:

Command Prompt
C:\> nmake
The name specified is not recognized as an internal or
external command, operable program or batch file.

If you see this error message, your compiler environment setup is 
improperly installed. Please contact your System Administrator to 
verify. 
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Troubleshooting

If you have any problems running the Rational Software Setup 
program, try the following suggestions before you call Rational 
Customer Support for help:

� Stop all applications before you begin the installation.
� Turn off all virus protection software. These programs often run 

in the background and interfere with the installation and file 
decompression process.

� Turn off any user interface managers or desktop environments 
that run on top of Microsoft Windows.

� Change to a standard VGA video driver while Rational Setup is 
running, or disable video features such as virtual screens or 
screen switching.

� Change to a standard mouse driver, or disable special mouse 
features that perform tasks such as leaving pointer trails or 
changing pointer sizes.

� Make certain that your system meets the minimum system 
requirements listed in Table 9, Rational Suite Requirements, on 
page 52.
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Installation Messages
Installation error messages, including messages for silent 
installations, are displayed in the file 
<Install Path>\RSSetup\Error.log.

Support Information
Contact Rational Customer Support if you have questions 
regarding the installation, use, or maintenance of this Rational 
Software product.

“Contacting Rational Technical Support” on page 11 provides 
Rational Customer Support telephone and e-mail contact 
information.

Table 18: Silent Installation Messages

Message Description

Product “ProductName” specified in 
response file is not contained in the 
product list.

This error message appears when the 
response.ini file contains an 
invalid product name.

Unable to open response file. Typically, this error occurs when the 
installation procedure cannot locate the 
response.ini file. Either you have 
specified an incorrect path or the 
response.ini file is not in the 
default location. 

Information required to remove the 
specified product cannot be found. The 
product may not be removed 
automatically.

When trying to remove a product with 
the /uninstall switch, you either 
specified a product that is not installed 
on your system or you incorrectly typed 
the product name on the command line.
Confirm that you are specifying a 
product on your system. Confirm that 
you have typed the product name 
exactly as it appears in the Rational 
Software Setup program.
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Silent Installations

You can configure Rational Software Setup to perform silent 
installations of Rational software. Silent installations allow you to 
perform an installation of a Rational Software product, using the 
same parameters, repeatedly on a number of systems.

The following sections provide a brief summary of the silent 
installation features.

Note We recommend you read Rational’s Silent Installation White 
Paper before you attempt a silent installation. The white paper is 
available from the Rational Web site at http://www.rational.com/. 
Select the following links in order: Technical Support, 
Whitepapers, and Rational Suite.

Overview of Silent Installations

This section describes how to perform a silent install. The basic 
steps, explained below, are:

1 Record an installation session. 

2 Optionally, add a post-installation command to the recorded 
installation.

3 Execute the installation procedure.
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Recording a Software Installation

You can record a software installation session and then use the 
responses that you provide to replay the installation. At the end of 
the recorded installation procedure, you can exit without 
installing the product. 

1 Insert the Rational Solutions for Windows CD in a CD drive.

2 Open a command window on your system and run RSSetup 
with the -autocapture switch. For example: 

<Location>\setup\rssetup -autocapture

Where <Location> is the location of the Rational Solutions for 
Windows CD. 

3 When the Rational Software Setup program starts, proceed 
with the installation procedure, as described in “Installing 
Rational Suite with the Rational Software Setup Procedure” on 
page 57. Your responses will be recorded in the responses file 
<Install Path>\RSSetup\response.ini. 

Note The option to use a temporary license is not supported when using 
the -autocapture switch. The silent installation procedure will 
not support the capture of license certificate information into the 
response.ini file.

4 After you have answered all of the questions related to the 
installation, you will be prompted to continue with the 
installation of the product or to exit from the setup program. 
Click OK to proceed with the installation or Cancel to exit.

Note Even if you cancel at this point, your answers are still saved.

Example

The following example shows how to record an installation of 
Rational Rose. For more information, see “Silent Installations” on 
page 209.

<Install Location>\setup\rssetup -autocapture /product Rose98i
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Specifying a Post-Installation Command

You can specify a command to perform after the silent installation 
has completed.

After you have completed preparation for a silent installation, 
perform the following steps:

1 Use a text editor such as Notepad to edit the response file. 
Append a line similar to the following to the end of the file. The 
label [PostInstallCmd] is required.:
[PostInstallCmd]

Command=post-installation-commands.bat

where the post-installation-commands.bat is a batch file 
that contains the commands to execute. Such a file might 
contain the following commands:
licadmin -fserver.txt

net send administrator “Installation Complete”

In this example, the License Key Administrator, licadmin, 
starts and uses the information in server.txt to specify the 
name of the license server that the current system will use. 
(See License Key Administrator Syntax on page 216 for the 
proper license command syntax.) The batch file then sends a 
message to the administrator, indicating that the installation 
procedure is complete.

2 Save the response file to a unique name (to ensure that it is not 
overwritten by subsequent autocaptures). For example, save 
the response file with a name such as 
c:\responses\ent-w-post.ini

Performing a Silent Software Installation

After you have recorded your responses, use the response file to 
replay the installation, such as in the following example:

<Location>\setup\rssetup -silent -response:response-path

In the example, response-path is the path of the response file. 
The default path is 
c:\Program Files\Rational\RSSetup\response.ini.
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Note If a response file is in the default location, you do not have to 
specify the -response:response-path parameter. To override the 
default, include the -response:response-path parameter on the 
command line.

If you specify -autocapture on the RSSetup command line, your 
installation will initially select the product name identified in the 
previous response.ini file, but will allow you to select a new 
product for installation. A new response.ini file will be saved at 
the end of the installation procedure.

For additional information about the Rational Software Setup 
command-line syntax, see RSSetup Command Syntax on page 
213.

Preparing Multiple Response Files

You can save multiple response files to support attended 
installation of different products.

1 Identify a directory where you will store your response files. 
The following examples use a directory named C:\responses.

2 Record the response file for each product to install. 

3 Rename the response file with a unique file name. For 
example, save the Rose response file as 
C:\responses\Rose-responses.ini.

4 Perform the installation and specify the path to the response 
file as a parameter to the -response switch. For example: 
<Install Location>\setup\rssetup -silent

-response:c:\response\Rose-response.ini
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RSSetup Command Syntax
RSSetup [-silent [-response:response-path]]|

[-verbose [-response:response-path]] |
[-autocapture]
[/product <product>] [/install /uninstall /update]

Table 19: RSSetup Command Parameters

Parameter Description

-silent Performs a silent (unattended) 
installation. 

-verbose Replays a previously recorded 
installation, allowing you to override the 
recorded responses.
Note: if you override the responses, 
those changes are not written to the 
response file.

-response:response-path Specifies the path to the response file. 
response-path is the path for the 
response file. You must specify the 
response-path.
The default path is 
<Install Location>\Setup\
RSSetup\response.ini, where 
<Install Location> is the location of the 
installation files.

-autocapture Records your responses to a software 
installation, storing the responses in a 
file for later replay.

/product product-identifier Specifies the product you are installing. 
Do not use this parameter for silent 
installations. For a silent installation, 
you instead specify the product name in 
the response file.
See Table 20,  Product Identifiers, on 
page 214 for the list of identifiers you 
can use with this switch.
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Table 20,  Product Identifiers, lists the product identifiers to use 
with the /product switch.

/install Installs the product you specified with 
the /product switch. 
This switch cannot be combined with 
/uninstall or /update.
Do not use this parameter for silent 
installations. For a silent installation, 
you instead specify the product name in 
the response file.

/uninstall Removes the product you specified with 
the /product switch. 
This switch cannot be combined with 
/install or /update.

/update Updates the product you specified with 
the /product switch. 
This switch cannot be combined with 
/install or /uninstall. 
Do not use this parameter for silent 
installations. 

Table 20: Product Identifiers

Product Name Product Identifiers

Rational LoadTest atbuLoadTest

Rational Suite Performance Studio 
Agent

atbuPSAgent

Rational Suite Performance Studio atbuRSuitePerformanceStudio

Rational Test Enablers atbuSetupEnablers

Rational TeamTest atbuTeamTest

Rational TestAccelerator atbuTestAccelerator

Rational Robot atbuTSRobot

Table 19: RSSetup Command Parameters (Continued)

Parameter Description
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Rational ClearQuest ClearQuest-1.1

Rational ClearQuest TeamTest 
Edition 

ClearQuestTeamTestEdition-1.1

Rational PureCoverage coverageNT

Rational Suite DevelopmentStudio for 
UNIX 

dsbuRSDSU

Rational Developer Kit dsbuDeveloperKit

Rational Rose Inline EJB Addin Inline

Rational Purify purifyNT

Rational Quantify quantifyNT

Rational RequisitePro rmbuRequisitePro

Rational Rose Enterprise Edition Rose98i

Rational Rose Professional Ada 
Edition 

Rose98iAdaProfessional

Rational Rose Professional C++ 
Edition 

Rose98iC++Professional

Rational Rose Professional J Edition Rose98iJavaProfessional

Rational Rose Modeler Edition Rose98iModeler

Rational Rose Professional Visual 
Basic Edition 

Rose98iVBProfessional

Rational Rose Professional Data 
Modeler Edition 

RoseDataModelerProfessional

Rational Unified Process ruObjectory51

Rational SoDA for Word SoDA

Rational Suite AnalystStudio wsbuAnalystEdition

Rational Suite DevelopmentStudio wsbuDevelopmentStudio

Table 20: Product Identifiers (Continued)

Product Name Product Identifiers



216 Installing Rational Suite

License Key Administrator Command Line
Note This section is included because of its relevance to silent install.

You can run the Rational License Key Administrator from a 
command line or batch file to automate your license key 
installations and configuration.

License Key Administrator Syntax

licadmin -ffilename.ext

Rational Suite DevelopmentStudio - 
RealTime Edition

wsbuDevelopmentStudioRT

Rational Suite Enterprise wsbuEnterprise

Globetrotter FLEXlm License Server  wsbuFLEXlmServer

Sybase SQL Anywhere Database 
Server

wsbuSQLAnywhereServer

Rational Suite TestStudio wsbuTestStudio

Rational Suite Web Server 
Components

wsbuWebComponents

Table 21: Licadmin Command Parameters

Parameter Description

-ffilename.ext Specifies the path to the license parameter file. 
The license parameter file specifies the name 
of the license key server that you will use. For 
example:
Server:group-license-server
The keyword Server is case-sensitive.

Table 20: Product Identifiers (Continued)

Product Name Product Identifiers
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The results of running this command are written to the file  
filename.ext_STATUS, where filename.ext is the name of the 
license parameter file you used. The status file is created in the 
directory where you executed the licadmin command.

Example

1 Create a file that contains the following line:
Server:group-license-server

where group-license-server is the name of your FLEXlm 
License Server system.

2 Save the file as server-info.txt.

3 In a command window, run the following command:
licadmin -fserver-info.txt

Your system will be configured to use floating license keys 
from group-license-server.
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Database creation scripts 96, 98, 112
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Rational Test 23
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migrating from SQL Server 6.5 45
sample database 164
setting up Microsoft Access 32
setting up Microsoft SQL Server 

6.5 37
setting up Microsoft SQL Server 7 42
setting up Oracle 45
setting up SQL Anywhere 33
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defect report
customizing 68
using ClearQuest 68
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Discussions e-mail 29, 148
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insufficient 29, 51

E
e-mail

Rational E-mail Reader 172
submitting records 172

E-mail for discussions 29, 148
e-mail notification

customizing 202
enabling for clients 167

e-mail rules
upgrading 158

Errors
installation 207

Ethernet network 20
installing driver 77
switching to Token Ring 84

F
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searching multi-line with Oracle 49

G
GNU C preprocessor and VU 

language 75

H
hardware requirements

SQL Anywhere Server software 22
HKEY_LOCAL_MACHINE MDI 

window 176, 187

I
identifiers

product 214
IIS server 125
Installation

custom 13, 19
log file 61
Rational Suite 51
shared components 56
Typical 13, 19

installation
product identifiers 214

installation requirements 31
installation requirements, Rational Suite 

PerformanceStudio 52
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installing 161
ActiveX Test Control 89
Agent computers 79, 80, 81
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ClearQuest for admin 161
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client software 24
Crystal Reports 93, 172
Oracle client software 24
overview 31
PerformanceStudio 57
Rational ActiveX Test Control 89
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Rational Test Java Enabler 89
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Enabler 89
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RSPS network driver 77
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SAP client software 25
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TUXEDO client software 25
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integrations
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Unified Change Management 169
upgrading 158
Visual SourceSafe setup 168

L
License Key Administrator 28, 54, 123
License keys

obtaining 15
licensing for Rational Suite 

PerformanceStudio 58
locked, databases 158
login accounts

anonymous user 174, 186
long file names 67

M
Maintenance tool, for upgrading 157
master computer testing requirements, 

Rational Suite 
PerformanceStudio 21

Master computers
purpose 26

Microsoft Access
configuring for ClearQuest 32

Microsoft Access, when to use 23
Microsoft Management Console 

(MMC) 126, 150
Microsoft SQL Server 7 setup 42
multi-line fields

searching in Oracle 49

N
Netscape Navigator

for UNIX 136
network drivers

installing 77
uninstalling 84

network recording
installing network drivers for 77

network requirements for SQL Anywhere 
Server 22

networks, switching 84
notification

e-mail 202
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Oracle

archiving 110
client 107
client software 24
configuring 97
configuring for ClearQuest 45
configuring PCs 107
connecting projects 105
ConText option 49
creating a schema 98
data and index files 101
database scripts 98
database size 98, 102
installation requirements 98
multiple projects 104
networking drivers 48
Oracle 8 client installation 48
searching multi-line fields 49
temporary tablespace 102
user ID 104

overview
install process 31
upgrading 153

P
packages

applying 158
path, ClearQuest Web 180, 193
Performance Studio and floating 

licenses 58
PerformanceStudio, installing 57
Permanent license keys

obtaining 15
preVue-C/S

upgrading from 74
using VU scripts with Robot 74
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for installation 214

Product Identifiers 214
production databases 160

profile
creating for installation 164

Projects
catalog 147
connecting Oracle 105
creating in SQL Server 115
multiple in Oracle 104

Q
Quick Start Guide 14

R
Rational

RequisiteEnterprise 95
RequisiteWeb 121

Rational ActiveX Test Control
about 88
installing 89

Rational ClearQuest
using to run defect reports 68

Rational E-mail Reader 172
Rational repositories 86

converting script file names 69
data converted 69
initializing data from SQA Suite 

6.x 68
upgrading from existing 

repositories 67
upgrading from PerformanceStudio 

7.0 67
upgrading from SQA Suite 6.x 68
when to convert from SQA Suite 

6.x 68
Rational repository

troubleshooting conversion from SQA 
Suite 6.x 72

Rational Robot
tutorial 90

Rational Software Setup program 13
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Rational Suite
installation requirements 52
installing 51

Rational Suite PerformanceStudio
installing a UNIX Agent 81
installing network drivers 77
installing Windows Agents 80
terminology and SQA Suite 6.x 

terminology 66
Rational Suite PerformanceStudio agent 

computers 22
Rational Suite PerformanceStudio client 

software 24
Rational Suite PerformanceStudio 

licensing 58
Rational Suite PerformanceStudio net-

work driver, installing 77
Rational Suite PerformanceStudio testing 

requirements 21, 22
Rational Suite PerformanceStudio, before 

you install 20
Rational Suite PerformanceStudio, instal-

lation requirements 52
Rational Suite PerformanceStudio, install-

ing Agents 79
Rational Suite PerformanceStudio, start-

ing agents 80
Rational Test database, choosing type 

of 23
Rational Test Enablers

installing 89
Rational Test Java Enabler

about 88
installing 89

Rational Test Oracle Forms Enabler
about 88
installing 89

Rational Test Visual Basic Enabler
about 89
installing 89

records
submitting via e-mail 172

registry key, ClearQuest Web 176, 187
Removing software 62
report

customizing format 68
repositories 86

converting script file names 69
data converted 69
initializing data from SQA Suite 

6.x 68
upgrading from SQA Suite 6.x 68
when to convert from SQA Suite 

6.x 68
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troubleshooting conversion from SQA 
Suite 6.x 72

Requirements 52
RequisitePro 27
RequisiteWeb client 151
RequisiteWeb server 123

requirements to install 31
RequisiteEnterprise

installing 96
RequisitePro

installation requirements 27
installing 28
removing 151

RequisiteWeb
configuring IIS server 126
e-mail 148
installation requirements 123
installing on server 125
project catalog 147
removing 149
virtual Web directory 126

RequisiteWeb and Custom/Full option 59
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sample application

about 90
installing 91
using with Rational Robot tutorial 90

sample databases
creating 164

sample repository
about 90
installing 91
using with Rational Robot Try it! 

cards 90
using with Rational Robot tutorial 90

SAP client software 25
schema repository

connecting clients 165
creating 162
upgrading 157

scripting languages 67
scripts

converting file names 69
searching

multi-line fields in Oracle 49
server

Oracle 45
Shared components

installing 56
small sample applets

about 90
installing 91
using with Try it! cards 90

software
installing client 24
Oracle clients 24
SAP clients 25
SQL Server clients 25
Sybase clients 25
TUXEDO clients 25

software requirements
Crystal Reports 21

SQA Suite 6.x
accessing data from 85
long file names 67
scripting languages 67
terminology 66
upgrading repositories 68

SQL Anywhere set up 33
SQL Server

archiving 121
configuring 110
creating a database 112
creating a project 115
database scripts 112
database size 112
installation requirements 111

SQL Server 6.5
configuring for ClearQuest 37
migrating to SQL Server 7 45

SQL Server 7
configuring for ClearQuest 42

SQL Server client software 25
SQL*Net Easy Configuration 46
Starting

Rational programs 15
starting

UNIX Agents 83
Windows Agents 80

Sybase client software 25
Sybase SQL Anywhere

accessing data from SQA Suite 6.x 
repository 85

configuring database server 88
installing 87
when to use 23

Sybase SQL Anywhere setup 33



225

T
TeamTest 31
TeamTest Schema

upgrading from 72
TestAccelerator, Installing 90
testing development environments 90
testing requirements, Rational Suite 

PerformanceStudio 22
TestManager - Manual Script Execution, 

installing 92
Third-party components 56
Token Ring network 20

installing driver 77
switching to Ethernet 84

Troubleshooting
installation 207

troubleshooting conversion from SQA 
Suite 6.x 72

TUXEDO client software 25
Typical installation 13, 16, 19

U
Unified Change Management, integrating 

with 169
uninstalling

network drivers 84
previous releases 20

UNIX
browser 136

UNIX Agents
installing 81
starting 83

Upgrades 28, 51, 54
upgrading 153, 160

ClearQuest Web 161
clients 160
from ClearQuest 1.0 72
from preVue-C/S 74
from TeamTest schema 72
options 155
preparation 154

schema repository and user 
databases 157

steps 156
task overview 153

URL, ClearQuest Web 203
user account, anonymous 174, 186
user databases

upgrading 157

V
verification point IDs, converting 69
virtual directory, ClearQuest Web 178, 

192
virtual user Agents

installing on a UNIX computer 81
virtual Web directory 126
Visual SourceSafe

cqvss 170
integration setup 168

VU language
and C preprocessor 75

W
Web Server components, installing 92
Web, ClearQuest

and Microsoft Access 32
cookies 173
installation directory 180, 193
registry key 176, 187
upgrading 161
URL 203

web, ClearQuest
cache directory 177, 190
configuring IIS 177, 191
virtual directory 178, 192

Windows Agents
installing 80

WWW directory, ClearQuest Web 180, 
193

wwwroot directory 126
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